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Preface

1. Give us Feedback

If you find a typographical error, or know how this guide can be improved, we would love to hear
from you. Submit a report in JIRA against eXo Content. The following link will take you to bug report
for eXo Content http://jira.exoplatform.org [http://jira.exoplatform.org/secure/Dashboard.jspa].

Select the document name and version number relevant to the document you found the error in
from the available lists then complete the description with as much detail as you can provide.

Be sure to give us your name so that you can receive full credit for reporting the issue.



http://jira.exoplatform.org/secure/Dashboard.jspa
http://jira.exoplatform.org/secure/Dashboard.jspa
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Chapter 1.

Preamble

1.1. Overview

Beginning as an Open Source project in the year 2002, eXo is well-known as the industry's first
Java portlet container. With the aim of dominating the potential portal market through robust and
easy-to-use applications, eXo Project has succeeded in attracting consumers in the whole world.
eXo has actually opened the floodgates to various options in many markets, and customers have
been choosing eXo as the best method for their success.

The eXo Platform™ software is a powerful Open Source that corporates portal and content
management system. Users of the platform have a customized single point of access to the
company's information system and resources.

eXo Platform 3.0

eXo Extended Services

The foundation for eXo Platform 3.0 is eXo Core Services, a powerful set of REST-based
services for rapid website development, content management and gadget-based development.
eXo Extended Services are also a part of the eXo Platform 3.0, running on the top of eXo Core
Services to enable easy development of rich, user-centric web applications.

eXo Content is one of eXo Core services. It provides a set of services to extend portal-based
applications with Enterprise Content Management (ECM) capabilities. Document Management
System (DMS) features make it easy to catalog and organize enterprise content and with powerful
Web Content Management (WCM) services to quickly build dynamic, content-rich websites.

1.2. Why Use eXo Content

If you are looking for a powerful tool and strategies in managing website and contents, eXo Content
is what you need. eXo Content is designed to provide webmasters who manage websites the
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way to maintain, control, modify and reassemble the content of a web-page easily and effectively.
All components of your website can be organized, reconstructed easily, which helps you keep
your website under the control. eXo Content really brings interesting experience for all users and
changes their way of thinking about website. The followings are key features of eXo Content:

Website Creation

Fast Setup:
Set up a new site in just a few clicks with an intuitive user interface and template features.

Navigate, Preview and Publish Content:
Navigate through page content in either a single content viewer or the list content display,
quickly preview page content or work on new content in draft mode and publish at anytime.

Templates:
Create websites from existing templates and themes, or create new templates with a
consistent look-and-feel across a single site.

In-Site Edition
The integrated rich text editor enables non-technical users to edit the pages they are in charge
of in an intuitive way.

Web Content Organization

Web-Based Administration:
Use a web browser to manage sites remotely, no local administration software is required.

Manage Multiple Websites:
Manage and control every site in one place.

Media Library:
Upload media to the library, publish, reuse and update all available media content across
multiple websites.

Content Search:
Search content and documents using categorization and tag features.

Broken Link Detection:
Know how many broken links are present and how many are functional with ease.

Versioning and Rollback:
Easily rollback a website's content with automatic versioning.

SEO and Friendly URLs:
Search Engine Optimization (SEO) is simplified for editing meta tags and more. Content has
its own specific URL for easier bookmarking and improved SEO.
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Configuration for Deployment on Web Farms:
Advanced deployment rule for scalable, three-tier web application architecture with partitioned
replicated deployment.

Capture and Manage Documents

Kofax Plugin:
Collect paper documents, forms, invoices and other unstructured documents and convert into
accurate and retrievable information, stored in the eXo JCR.

Access Control List:
Access Control List: Validate the current session's permissions to add nodes, set properties,
remove or retrieve items. Define actions to launch the next step in a process, or to invoke
any "coded" action required.

Workflow:
Specify processes for document collaboration and validation.

Record Management:
Track the status of content completion and control document storage lifecycles.

Store and Access Documents

JCR:
eXo JCR allows applications to access or manage files independent of their location, and also
provides advanced features such as unified access control, versioning, indexing and more.

Automatic Backup:
Define and automate tasks to save documents as required.

Web Interface:
Access documents in an intuitive and user-friendly web interface.

Microsoft and OpenOffice Plug-ins:
Microsoft and OpenOffice plug-ins give users the freedom to work on documents in their
preferred document editing program.

And More... eXo Content also provides other powerful tools to manage an build content-rich
websites such as CSS, Java Script and RSS support, advanced document management tool,
collaboration tools, etc. All features is to meet your requirements for the purpose of easy site
management, cost reduction in managing multiple sites in only one place.

1.3. About This Document

The intended reader of this user guide are users using eXo Content. This guide will explain all the
basic and advanced features that eXo Content provides in managing websites and site content.
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It gives in-depth examples and easy explanations of the technology that allows the webmasters
to create and manage a very fast and powerful website.

With this guide you will:

« learn the basic terminologies used in eXo Content.
» know how to create, manage and publish Site content.
« know how to manage Web pages, set up a website, etc.

In this guide, we will use the following accounts (username/ password) throughout the guide:

» root/ gtn: This account is for users as Administrators who have the highest right on the platform.

e mary/ gtn: This account is for a publisher who can write contents but also can create new pages
or edit them in the current site.

1.4. References and Related Sources

Information

« eXo Home Page [http://www.exoplatform.com/]

« eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/]

Support

» Forums [http://forums.exoplatform.org/]

» FAQs [http://faq.exoplatform.org/index.html]

Downloads
« eXo Content [http://www.exoplatform.com/company/public/website/platform/exo-core-services/
exo-content]

e eXo Development Tools [http://www.exoplatform.com/company/public/website/platform/exo-
core-services/exo-development-tools]

» Gatein Portal Framework ]

* eXo Collaboration [http://www.exoplatform.com/company/public/website/platform/exo-
extended-services/exo-collaboration]

« eXo Knowledge [http://www.exoplatform.com/company/public/website/platform/exo-extended-
services/exo-knowledge]
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References and Related Sources

e eXo Social [http://www.exoplatform.com/company/public/website/platform/exo-extended-
services/exo-social]

Resource Center

« Video demos, tutorials, webinar archives, features and benefits tables and more [http:/
www.exoplatform.com/company/public/website/resource-center]
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Overall Introduction

2.1. eXo Content

eXo Content is the technologies used to Capture, Manage, Store, Preserve, and Deliver
content and documents. It especially concerns content imported into or generated from within an
organization in the course of its operation, and includes the control of access to this content from
outside the organization's processes.

The eXo Content users can manage both structured and unstructured content, so that an
organization, such as a business or a governmental agency, can more effectively meet business
goals (increasing the profits or improving the organizational process with efficient use of budgets),
serve its customers (as a competitive advantage, or to improve responsiveness), and protect
itself (against non-compliance, law-suits, uncoordinated departments or turnover within the
organization).

eXo Content improves your operational productivity and efficiency. It enables you to transform
unstructured content into structured content through the process of capturing, storing, managing,
preserving, publishing and backing up while securely distributing it. The eXo Content portlet gives
you a portal solution that can help you achieve these processes and leverage your business
content across all formats for competitive gain. It also provides an environment for employees to
share and collaborate on digital content and delivering a comprehensive unified solution with rich
functionalities. Every component of your website can be organized, reconstructed easily, which
helps you keep your website under control.

eXo Content consists of three parts:

Document Management System (DMS) - an extension of eXo Content is used to store, manage
and track electronic documents and electronic images and allows documents to be modified and
managed easily and conveniently by managing versions, properties, and more.

Workflow: is the way of looking at and controlling the processes presented in an organization
such as service provision or information processing, etc. It is an effective tool to use make certain
that the processes are effective with the purpose of better and more cost efficient organization.

Web Content Management (WCM): helps in maintaining, controlling, changing and reassembling
the content on a web-page. It also helps webmasters who handle all tasks needed to run a website,
including development, design, content publication and monitoring.

2.2. Site Content Structure

Creating a site is a quick process, but deciding what content to put in the site and how to organize
it will take a lot of time. Thus, to mange a site more easily and more effectively, a site always has
a specific structure as follows:
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Site Content

CSS Documents JS Links Media Web Contents
Audios Images Videos

The Site Content are stored in collaboration workspaces of Java Content Repository (JCR).

Details:

CSs
This file is used to define the presentation of your entire site, such as font, color, size and more.

Documents:
All documents, which are used in a site will be stored in this folder.

JS

A programming script used on the site. This file is used to make a web page more animate
and dynamic in terms of graphics and navigation.

Links:
This folder stores all links used in the site.

Media:
This folder includes three sub-folders:

Audios:
Store all sound files used in a site.

Images:
Store all images, pictures used in a site.

Videos:
Store all video files used in a site.

Web content:
This folder is used to store the documents which present main content (texts images,
hyperlinks, audios and videos) of the site.
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2.3. Web Content

2.3.1. Web Content

Web Content is the textual, visual or aural content that is encountered as part of the user
experience on a website. It may include other things such as texts, images, sounds, videos and
animations.

2.3.2. Web Content Structure

The Web content may include various elements. Thus, to create and manage the Web content
more effectively and dynamically, each Web Content also has a specific structure:

Main content:
It contains all key content such as: texts, images, links, tables, etc.

lllustration:
It contains an image that is used as an illustration for the content. Additionally, a summary
also can be added to come with this image.

default.css:
It contains CSS data which is used to present the web content such as: layout, font, color,
and more.

default.js:
It contains JS data which is used to make web content more animating and dynamic.

2.4. Terminologies

2.4.1. Repository

A repository is a place where contents are stored and maintained. The content repository is:

» A place where contents are stored.
« A place where digital data are stored.

« Accessible to the user without having to travel across a network.

2.4.2. Workspace

A content repository is composed of a number of workspaces. Workspace is a term used by
several software vendors for applications that allow users to exchange and organize files over the
Internet. In our case, the content repository consists of more than one workspace. The “repository”
repository contains multiple workspaces, including : system, backup and collaboration workspace.
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System workspace:
is used to reserve “system folders”.

Backup workspace:
The backup process depends on the published content timestamps, each published document
has a duration for which it can be published and when it exceeds the timestamps, it will be
automatically archived to the backup database. This workspace is mostly used when using
the Workflow based content publication lifecycle.

Collaboration workspace:
Allows users to validate and manage documents. This is the central place to store and edit
contents and media.

2.4.3. Drive

A drive can be understood as a shortcut in the content repository. It enables administrators to limit
visibility of each workspace for groups of users. It's also a simple way to hide the complexity of
the content storage by showing only the structure that makes sense for Business users.

More specifically, a drive consists of:

 a configured path where the user will start when browsing the drive.

a set of allowed views that, for example, will allow to limit the available actions (such as the
edition or creation of content while being in the drive).

 a set of permissions to limit the access (and view) of the drive to a limited number of people.

 a set of options to describe the behavior of the drive when users browse it.

2.4.4. Node

A node is an abstract basic unit used to build linked data structures, such as linked lists and trees,
and computer-based representation of graphs. Nodes contain data and/or links to other nodes.
Links between nodes are often implemented by pointers or references.

A node can be defined as a logical placeholder for data. It is a memory block which contains
some data units, and optionally a reference to some other data, which may be another node that
contains other data. By linking one node with other interlinked nodes, very large and complex data
structure can be formed.

2.4.5. Version

Versioning means that at any given time the node's state can be saved for possible future recovery
and the action of saving called ‘checking in'. A workspace may contain both versionable and non-
versionable nodes. A node is versionable if it has been assigned a mixin type mixin: versionable;
otherwise, it is a nonversionable node. A version exists as a part of a version history graph that
describes the predecessor/successor relations among versions of a particular versionable node.

10
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A Mode

Version 1

version 2
(Base Version)

Software versioning is the process of assigning either unique version names or unigue version
numbers to unique states of computer software. Within a given version number category (major,
minor), these numbers are generally assigned by increasing order and correspond to new
developments in the software. At a fine-grained level, revision control is often used for keeping
track of incrementally different versions of electronic information, whether or not this information
is actually computer software.

2.4.6. WebDAV

WebDAV stands for Web-based Distributed Authoring and Versioning. It is a set of extensions
to the Hypertext Transfer Protocol (HTTP) which allows users to collaboratively edit and manage
files on remote World Wide Web servers.

The protocol was to make the Web a readable and writable medium. It provides functionality to
create, change and move documents on a remote server (typically a web server or "web share").
This is useful for, among other things, authoring the documents which a web server serves, but
can also be used for general web-based file storage that can be accessed from anywhere.

2.4.7. Podcast

A podcast is an audio file that you can download and listen to on your computer or a portable
MP3 player such as an iPod. The word itself comes from the combination of two other words:
iPod and broadcast.

11
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2.4.8. File Plan

The file plan is the primary records management planning document. Although file plans can differ
across organizations, their typical functions are to:

» Describe the kinds of items the organization acknowledges to be records.

» Describe what broader category of records that the items belong to.

* Indicate where records are stored.

 Describe retention periods for records.

» Delineate who is responsible for managing the various types of records.

2.4.9. Symlink

Symlink is a special file containing a reference to document or folder. By using symlinks, you can
easily access specific nodes (target) that symlinks point to. In Content Explorer, a symlink has a
small chain symbol next to its icon:

B

Documents.Ink

12
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Get Started

3.1. Account

3.1.1. Register an account

To register a new account on the portal, do as follows:
Procedure 3.1.

1. Go to the portal by inputting the URL in the address bar (e.g: http://localhost:8080/portal/
public/classic).

The anonymous homepage will appear:

» T site /1) Group (1) Dashboard ] Site Editor 4L MaryKelly [published| <

eXo WCM

An eXo Content Service - Part of eXo Platform 3

» Download eXo WCM Documentation » Try eXo Platform 3

Community Members: Enterprise or Production Use?

New to eXo WCM?
Watch the Getting Started Guide, or start exploring some of the key features: e

Site & User Management Content Organization Contact Us Resource
= Role-based permissions: set different access for users » Manage categories and tags; search structured Center
and groups = and/or unstructured content
» Manage multiple sites in a single administration center = Create symbolic links te connect related conten
= Collaborative edition: grant rights to users to work on » Automatic versioning to allow rollback when
select content » needed
= Personalize content and design with user-defined » Media library: store and reuse any media type across
preferences multiple pages E
Content Repository Create & Publish Content E

2. Click the Register link on the top of the site, the Register form will be displayed:

13
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~ Account Setting | » User Profile

User Name:

*

"

Password:

"

Confirm Password:

w

First Name:

w

Last Name:

»

Email Address:

save

(*) required

The Account Setting information includes:

Table 3.1.

Field Information

User Name The user name that is used to login into the
system. It must be unique. The user name
must be started with a character.

Password The security characters are used to login. It
must have at least 6 characters.

Confirm Password The re-typed password above. The
password in Password field and this field
must be the same.

First Name Your first name

Last Name Your last name

Email Address Your email address. It must have a right
format: user nane@bc. com

3. Input values for the fields in this form.

4. Click the

"y
]

icon to search and check if the inputted user name is available or not.

5. Input values in the fields of User Profile tab, including: Profile information, Home information
and Business information.

14



Sign In

¥ Account Setting || + User Profile ]

Given Mame:

Profile
I@ Home Info I

Gender: | Male @
|'~0 Business Info ,-I

Employer: | |

|
Family Mame: |
|

Nick Mame:

Birthday: |

Department: | |

Job Title: | | o

Language | English LQJ o=

| Save ” Reset ]

6. Click Save to register a new account, or Reset to renew all inputted values. There is an
alert message, and you cannot add a new account successfully if at least one of these cases
occurs:

e User name is existing or invalid.

» Password has less than 6 characters.

» Password and Confirm Password are not the same.
« Email Address has invalid format.

« Required fields are empty.

After adding a new account, contact with the administrator to get the confirmation.

3.1.2. Sign In

This function enables you to go into eXo Content in the private mode.

15
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Procedure 3.2. Sign in

1. Gotothe eXo Contentin the public mode by inputting the URL in the address bar (e.qg: http://
localhost:8080//portal/public/classic/).

2. Click the Login link at the top of the home page. The Sign in form will appear:

Sign in

User name | & |

Password | G

[[] remember My Login

| Sign in | | Discard |

3. Input your registered User name and Password.

4. Click Sign in to accept, or Discard to exit from the Sign in form.

Table 3.2. Options

Option Information

User name To input the registered username.
Password To input the password of your username.
Forgot your User Name/Password To retrieve the forgotten user name or

password when you forget.

Sign in To sign into the eXo Portal with the inputted
user name and password.

Discard To close the Sign In form without any
changes.

If the User Name does not exist or the inputted User name/Password is invalid, there will be
an alert message that requires users to input right values. The page will be redirected to the
private security checking mode.

To login again, enter User Name and Password again.

After signing in, you will be redirected to the authenticated homepage like the illustration.

16
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Sign Out

)D 7| Site Group * ) Dashboard 5 Site Editor Root Root | published | 2 |

DOCUMENTS (5]

1= Where we are
Lorem ipsum dolor sit amet
consectetuer adipiscing elit

Il Conditions and Requirements
Lorem dolor sit ipsum amet
consectetuer adipiscing elit

How to join us
Consectetuer adipiscing elt 27082000
lorem ipsum dolor sit amet

LATEST NEWS B

‘ ~ ACME News 1

- Lorem ipsum dolor sit amet,
‘ consectetur adipisicing elit,
sed do eiusmod tempor incididunt ut
labore et dolore magna aliqua.

ACME News 4
e Lorem ipsum dolor sit amet,

COMPANY NEWS 'S consectetur adipisicing elit,
B sed do eiusmod tempor incididunt ut

labore et dolore magna aliqua.

3.1.3. Sign Out

The function lets you get back to the anonymous portal. It ends your current portal session.

To sign out, click the Logout link on the right access banner:

Welcome:

or click eXo > Sign Out from the menu:

=) T Site Group (7 Dashboard [ Site Editor Mary Kelly [ Published| & |
@ Change Language

§ Change Skin Welcome: root  Logout | Changelanguage | Register

Si
.

3.1.4. Retrieve user name/password

If you forget your account or password, you can recover them by doing as follows:

Procedure 3.3.

1. Click the link Forgot your User Name/Password? in the Sign in form.

This form offers two options:
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Chapter 3. Get Started

Why are you are not able to login ?

We apologize for any inconvenience you're experiencing by not being able to access this website,
To resolve this issue as quickly as possible, please follow the troubleshooting steps below.

1. Recover your password: enter your username then dick send.
2. Recover your username: enter your email address then dick send.

9 Forgot my password
Forgot my username

[ Mext ][ Back ]

Forgot my password:
If you forgot your password, you need to select this option.

Forgot my username:
If you forgot your username, you need to select this option.

2. Select one of these two options in this form. The selected option will be shown:

If the Forgot my password option is selected the form to recover the password appears:

Forgot User Name /Password

User name : =

[ Send ][ Back ]

If the Forgot my username option is selected, the form to recover the user name appears:

Forgot User Name/Password

Email *

[ Send ][ Back ]

3. Enter your username or email in the corresponding form.

4. Click Send to send the inputted values.
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Change Account Information

Once information has been sent, you will receive an email with your User name/ Password
in your email address that you registered.

« If you forget User Name: when a username is retrieved, your old username is restored and
can be reused and a new password is also sent to your email with the old username.

« If you forget old password: a new password will be set (as temporary, then you will be
directed to change the password for the next time you sign in).

3.1.5. Change Account Information

The function enables you change your account information, such as your profile and password.

Procedure 3.4.

*  The first thing to do is to directly click your own account name.
):) — site Group T Dashboard 7 Site Editor Mary Kelly '

Welcome: root  Logout | Change language | Registe

The Account Profiles tab will appear:

Account Profiles B Change Password

User Name : | ot .

First Name - | Root

Last Mame - |Fl|:u:|t

Email - |r00t@localhost | =

[ Save H Reset ]

Close

Procedure 3.5. To Change Account Profiles

1. Select the Account Profiles tab.
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Chapter 3. Get Started

This tab displays your current basic information.
2. Change your First Name, Last Name and Email. You cannot change your User Name.

3. Click Save to accept changes.

Procedure 3.6. To change your Password

1. Select the Change Password tab.

|4 AccountProfiles [=| Change Password

Current Password : =

Mew Password : =

Confirm New Password : ®
[ Save l [ Reset ]

Close

2. Input your current password to identify that you are the owner of this account.
3. Input your new password, it must have at least 6 characters.
4. Input your password again in the Confirm New Password field.

5. Click Save to accept changes.

3.2. Change The Display Language

The priority order of display language is shown to the following order:

1. User's language
2. Browser's language

3. Portal 's language.
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Change the skin of the current site

Thus, to display your preferred language, you should pay attention to this order to change the
language type appropriately.

Procedure 3.7.

1. Move the mouse on eXo > Change Language on the top left corner of the portal:

» T Site Group (7 Dashboard g7 Site Editor Mary Kelly [ published| <

@ Change Language |
R

£ Change Skin

E Sign out

The Interface Language Setting form appears:

Interface Language Setting

Arabic el _
Chinese - China 3 -
Chinese - Taiwan cpir - i
Dutch Nederlands
' English
French Frangais |
German Deutsch
Italian Italiano
Japanese Sk ] w
[ Apply l [ Cancel

2. Select the another language in the list. The currently selected language will be marked with
the

v

icon.

3. Click Apply to change the display language temporarily, and wait few seconds to take effect,
or click Cancel to quit without any changes.

3.3. Change the skin of the current site

The eXo skins are attractive user interface styles for displaying a portal. Each skin has its
own characteristics with different backgrounds, icons, and more. To use the portal easily and
effectively, you are allowed to change the skin of the current site.
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Chapter 3. Get Started

Procedure 3.8.

1. Move the cursor to eXo > Change Skin item in the drop-down menu:
(S ) T Site )1 Group (i) Dashboard [ Group Editor L Mary Keuy

O Change Language

. Sign out kslemars Form Builder Administration

The Skin Setting form appears.

Skin Setting

SIﬁnsList View and select a skin

I * Default Style Skin

|_apply || cancel

2. Select the skin you want by clicking its name.
3. Click Apply and wait a few seconds to take affect.

These actions can be done by users who have the right to use the administration bar with a
personal preferences menu.
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Chapter 4.

Basic Actions

These actions are for all registered users after they have logged in the accounts.

4.1. View a site

In eXo Content, we use the 'Website' term which is equivalent to the 'Portal' term. So, viewing a
portal means viewing a website. You can select the site that you want to view by selecting the site
name in the drop-down menu on the Administration bar:

The main screen of the site will appear like the illustration below:
}D = site Group

Dashboard = 5 Site Editor

[ Published| = |

DOCUMENTS E

1% where we are
Lorem ipswm dodor s amed
consecieer adipiscing =it

p
. ¥ conditions and Requirements.
i Lorem diodor sitipsum amet
consecieiuer adiprscang it

=

How 1o join us.
‘Consecietuer adapescang elit 27A0A2073
orem ipsum dolor sitamet

LATEST NEWS E
‘, — ACME News 1
Lorem ipsum dokor sitamet,

consecketur adiprsong e,
sed do ensmod empor incdidunt ut
labore etdodore magna aligua.

ACME News 4

COMPANY NEWS

ACME Mews 1
B 21, 2009 33511 A0 Ty rom

Lorem ipsum dodor sit amed, conseciet

ACME Mews 4
Aug 21, 3009 3:54:43 AM by roat

Lorem peum dodor sit amed, conseciety

ACME Mews 3
A 21, 2009 35G:17 AM Iy rom

Lorem ipsuim dodor 5 amed, consecies

ACME Mews 2
Aug 21, 200 =

Larem ipsuim dodor 5 amed, consecies

3584 AM Iy rom

r adipesicing eln, sed do efusmod empor

r adapesicing e, sed do esusmod fempor

r adipisicing e, sed do efusmod empor

r adipisicing e, sed do efusmod empor

Powered by eXo WM - Copym

ncadidunt ut labore 21 dolore magna alqua.

nodedunt ut labore et dolore magna abqua.

ncadidunt ut labore et dolore magna aliqua.

ncadidunt ut labore et dolore magna aliqua.

Ba

Lorem ipsum dolor stamet,
! conseciewr adipisicing =i,
sed do esmod \empor incdidunt ut
abore etdodore magna aliqua.

[l

- =

ACME New's 3
- Lorem ipsum dobor sitamet,
N = conseciewr adipisicing e,
sed do esusmod tempor ncdsdunt ut
labore etdodore magna aliqua.

\- o _ ACME News 2
“ Lorem ipsum dobor sn.amet,

consecieur adipisicing et
sed dioessmod lempor ncadedunt ut
labore etdodors magna aliqua.

£ Administration bar which contains administration functions related to portals (websites).

@ Banner which contains slogan, logo, icon used in the website.
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Chapter 4. Basic Actions

Navigation bar which helps users to visualize the structure of the website and provide quick
links to different pages.

Home page which is the main page of the website. This is the default page that is displayed
first when you visit the website.

Footer of the website. It can be texts, or image that is displayed at the bottom of the website.
It provides information about author/institutional sponsor, revision date, copyright and more.

4.2. Print content

Users can easily print any content in a site by following these steps:

Procedure 4.1.

3.

Click Read more to read all the content of a document or an article in a site.
COMPANY NEWS
ACME News 1

Aug 21, 2009 3:55:11 AM by root root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.

ACME News 2
Aug 21, 2009 3:55:44 AM by root root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aligua.

ACME News 3
Aug 21, 2009 3:56:17 AM by root root
Lerem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmed tempor incididunt ut labore et dolore magna aliqua.

Click the Print button, the Print Preview page will be displayed on another tab.

Overview MNews Events Newsletters ContactUs

ACME News 1

< | & Pt |

Lerem ipsum delor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolere magna aliqua. Ut enim ad minim veniam, quis nestrud exercitation ullamece laboris nisi
ut aliquip ex ea commeodo censequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum delore eu fugiat nulla pariatur. Excepteur sint eccaecat cupidatat non proident, sunt in culpa
«qui officia deserunt mollit anim id est laborum.

Click Print to print the content of this page or Close to close this tab without printing.

4.3. Manage a site

4.3.1. Create a new site
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Create a new site

E] Note

In eXo Content, only Administrators have right to create a new site.

This function enables you to create a site (portal) to meet your own needs.

Do the following:

1. Click Site on the administration bar. A list of existing portals is listed.

>:) I = Site ! Group () Dashboard [z Site Editor Root Rool  [puplished ¥
(o N — e e )
s Welcome: root | 1

A

Overview News Events Newsletters Contact Us

Fo—
Ead
|V acme [Z EdiLayout ©2 Edit Navigation “[% Edit Portal's Config © Dekete
T
VR classic [& Edit Layout ©2 Edit Navigation “ Edit Portal's Config
1 Add New Portal
existing sites W click

Powered by eXo WCM - Copyright @ 2000-2003. All rights Reserved, eXo Platform SAS

2. Click the Add New Portal button to open the form to add a new portal.

In the Portal Setting tab, set some properties for this site, including the portal name, locale
and skin.

~ Portal Setting [ » Properties " » Permission Setting ] Enter Portal Name

Portal Name : [e}(n ].
Locale : | English =]~
Skin - | Default =]

[ Save ][ Cancel

Table 4.1. Details:

Field Information

Portal name The name of the portal. This field is required
and must be unique. Only alphabet, numbers
and underscore characters are allowed. The
Portal name must be at least 3 characters.
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Chapter 4. Basic Actions

4.

Information

Locale The interface language of the portal. This
field is required.

Skin The skin of the portal.

Select the Properties tab to keep session alive.

The Keep session alive option means keeping the working session for a long time to avoid
the working time out. There are 3 options:

never:
The session never happens even if the application requests.

on demand:
The session starts to be used as soon as the application requests.

always:
The session is always enabled.

» Portal Setting lv Froperties l » Permission Setting C“Ck

Keep session alive : [Dn Demand

Always
Newver

Ve ] [ dTCET ]

Ziw

Select the Permission Setting tab to set access and edit permission for this portal.

The Permission Setting tab includes two subtabs: Access Permission Setting and Edit
Permission Setting.
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Create a new site

Ib Portal Setting ” + Properties “ ~ Permission Setting l

.@ Access Permission Setting \g Edit Permission Setting

Check this box

Make it public (everyone can access):

Group Id Membership Type Action
Empty data

i Add Permission Je—— Click

[ Save ” Cancel

Access Permission Setting tab
By default, the access permission list of the portal is empty:

[> Portal Setting " » Properties ” ~ Permission Setting l

»;,ﬂ Access Permission Setting ‘L}? Edit Permission Setting

Check this box

Make it public (everyone can access):
Group Id Membership Type Action
Empty data

4F Add Permission fe—— Click

[ Save H Cancel

Check the Make it public check box to assign the access permission to everyone, or
click the Add Permission button to assign the access permission to a specific group
which is selected from the Select Permissions form (By selecting a group on the left
and a corresponding membership on the right):

After selecting groups, the access permission list is displayed:
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Chapter 4. Basic Actions

[ » Portal Setting H » Properties ” ~ Permission Setting

@ Access Permission Setting \g Edit Permission Setting

Make it public (everyone can access): [

Group Id Membership Type Action
fcustomers manager |
@[ Remove
/partners member a group

L ) &5 Add Permission
Access Permission list

[ Save H Cancel

In which, the icon
is to remove its corresponding group from the Access Permission list.

Edit Permission Setting
By default, it is also empty and you have to assign the edit permission to a specific group.

_ _ — — select this tab
[» Portal Setting " » Properties ” » Permission Setting l/

@ Access Permission Setting | wZ’ Edit Permission Setting

Current Permission
Group Id :

Click

Membership :

I »: Select Permission I

[ Save H Cancel

You can assign the edit permission to a group with a specific membership by clicking the
Select Permission button in the Edit Permission Setting tab to open the Permission
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Create a new site

Selector form. Select a group on the left panel and a corresponding membership on the
right panel:

Permission Selector X
&
Browse and select a group Select a Membership
ﬁ?" b member =
-Iﬁ Customers ¥ editor
-Iﬁ- Organization ¥ manager .
.:.B?. Platform ¥ redactor
.:ﬁ. Partners b walidator
b=
¥ webhdesigner -

The (*) from the Select a Membership panel means that you assign the right for everyone
in the selected group from left panel.

After selecting a group, the Current Permission will be displayed with detailed information:

[» Portal Setting " » Properties ” » Permission Setting l

@ Access Permission Setting | &% Edit Permission Setting | Current Permission

(@ Current Permission

Group id : /platform

Membership : author

I Delete Permission I M Select Permission

Click to delete Click to accept creating a portal

current permission [Save ] (Ccancel |

The edit permission is assigned for only one group at one time. You can click the Delete
Permission button to remove the current edit permission of the selected group or re—
assign the edit permission to another group by clicking the Select Permission button again
and select another group.
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Chapter 4. Basic Actions

5. Click Save to create a new portal.

After creating a new site, a list of the existing sites will be displayed on the screen. This new site
will be added to the exiting site list in Site on the administration bar and to a drive list that includes
all its default files.

To see it in the drive list, click Group > Content Explorer on the administrator bar.

D T Site Group i Dashboard ) Site Editor

Content Manager's pages Wed ey |

Content Explorer
Mew
Newsletters

For example, after creating a portal named 'eXo’, there is a drive named 'eXo' in Content Explorer:

Content Explorer
(e © =1 -
Publication Collabaration System

] Add Foider 4, AddDocument | i, Upload

Sites Management HE B
: “" | » GENERAL DRIVES
. . 5= N
..b classic i [ =cme [ classic = collaboration - 9 DMS Administration
[=- shared ® " = - .
.| Events 3 exo . Sites Management L Shared Groups Space
2 ) ) ) o © ps Sp
(el @i Shared Site @i Shared Users Space @i Trash

4.3.2. Edit a Site

This function enables you to edit a site, inluding the configuration (setting, permission), the
navigation and the layout components of the site.

4.3.2.1. How to edit the current site

To edit the current site that you are browsing, do the following:

Procedure 4.2.

e« Show the form to edit the current site by clicking
Site Editor on the administration bar, then select

# Edit Layout
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Edit a Site

) — Ssite Group () Dashboard | [ Site Editor |
= Add New Page

= Edit Page

Contact Us ” ﬁ -
f Edit L ut

The form to edit the current site will appear.

Content Detail

Content Detail

Content Detail Content Detail Search Portlet]
Banner Portlet

Sign in Portlet

“ EditInline Composer B X
Containers L
Content Detail
Administration
Navigation Portlet Contents
sssa| Authoring Dashboard
Page Description
| Category Contents
B | Cetegory Navigation
Content Detail

Footer Portlet ]

{4 Site's Config | [ Switch View Mode

Details:

Table 4.2.

Indicator Meaning

‘i Site's Config Site‘ls cqnfig: allows editing the site's
configuration.

Switch View Mode: shows how the current

| Switch View Mode layout looks like with real content.

H' Finish: allows saving all changes and
escaping the Edit page

x Abort: allows canceling all changes that
have not been saved and quitting the Edit
page

After showing the form to edit the current site, you can edit the layout and the configuration of
current site here.
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Chapter 4. Basic Actions

Edit layout. Editing the layout means editing a banner, a navigation bar, a breadcrumb bar,

a homepage and a footer of a website. You can also add more portlets to the site by dragging
and dropping from the Applications tab of the Edit Inline Composer form to the main pane.
Moreover, you can move a portlet from a location to another location.

% EditInline Com

let ||

Applications E
Contents

______________________________________________________________________________________________________________________________________________________________________________________ £
Page Description Edit Inline
Composer

C

C

| 4op Site's Ci
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Edit a Site

Editing the banner portlet is similar to editing the Sign-in portlet and the footer portlet so in this
guide, we only show how to edit the banner of the current site as an example of editng the layout.

Procedure 4.3. Edit Banner
1. Show the form to edit a banner by clicking the icon
of the banner portlet in the Edit Portal form like the illustration below.
. @ Bamer() @
Content Detall
Edit Portlet
A form to edit the current banner will appear:
Web content form X
~ Main Content [F Tlustration " + Advanced l
M;n ¢ |=| Source [E] [ Sl (G, 2 Eemi = i
content E B I U ABG'E E E = &}
éStyle = | Format | Mormal (DIV) + | Font - | Size s |

Save Draft ][ Fast Publish ][ Preferences ][ Close ]

Select Edit Mode tab:

2.
Content Selection: Select the path of the content that you want to show by clicking +.

Display Settings:
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Chapter 4. Basic Actions

3.

« Show Title: Specify whether the title of the content is displayed or not.
« Show Date: Specify whether the date of the content publication is displayed or not.
* Show Option Bar:Show or hide the Option bar used to show the print link.

Print Setting:

« Show in page: Choose a page for the print review.
< with: Parameters contains the content path.

Advanced: The content should enable “dynamic navigation” that interprets the URL and
shows a content.

Select the Portlet Setting tab:

» Edit Mode | = Portiet Setting ][» Select Icon ][» Decoration Themes ][rmpemusm

Display Name: Content Detail
Portiet Title - (Banner l

'Wiclh:[ ]

Hene | ]

Show Info Bar . [}
Show Portiet Mode : [|#&— Show options
IShow Window State © []

Details:
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Edit a Site

Table 4.3.
Display name The display name of the portlet. You cannot
change it.
Portlet Title The title of the portlet. You can change it.
Width The width of the portlet.
Height The height of the portlet.
Show infor bar Tick the check box if you want to show the
infor bar of the portlet.
Show Portlet mode Tick the check box if you want to show the
portlet mode.
Show window state Tick the check box if you want to show the
window state.
Description Enter a description about the portlet.

Select Icon tab: Select an icon for the portlet by clicking it.
Select Decoration Theme tab: Select a decoration theme for the portlet.
Select Access Permission tab:

By default, all users can access the portlet:

[r Portal Setting " » Properties " » Permission Setting l

& Access Permission Setting | W% Edit Permission Setting

Check this box

Make it public (everyone can access):
Group Id Membership Type Action

Empty data

4B Add Permission e Click

[ Save ][ Cancel

However, you can edit the access permission by unticking the checkbox > click Add
Permission:
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Chapter 4. Basic Actions

» EditMode | » PortletSetting | » Selecticon | » Decoration Themes Hch&BsPanissml

Make it public (everyone can access)

Untick

Group Id |

Membership Type

Emply daia

| @ ndapemissin  |e= Click

The ListPermissionSelector form appears. Select a group on the left pane and a
membership on the right pane.

7. Click Save and Close to commit.

8. Click

to quit the form to edit the current site.

Edit Configuration. To edit
language, skin and permissions)

i Site’s Config |

the
of

to open the same form as the form to add a new portal.

Do the same steps as in Section 4.3.1, “Create a new site”.

configuration ( including
the current site, click

4.3.2.2. How to edit an existing site

You can edit any existing sites in the list of sites. Here, you can edit the layout, configuration and
navigation bar of the site. Click Site to open the list of existing sites.




Edit a Site

b9 Group (%) Dashboard 5 Site Editor . Root Root [ pyblished| v

~ adit Wielcome: root

“

Overview News Events Newsletiers ContactUs

T—
Y= acme [& Edit Layout “I¢ Edit Navigation “  Edit Portal's Config Delete
T
VS classic [ Edit Layout “IZ Edit Navigation “[ Edit Portal's Config delete site
T
Y= exo [  Edit Layout “IZ  Edit Navigation “I Edit Portal's Config Delete
Add New Portal

Edit Layout. Do the following to edit the layout of an existing site.

1. Click Site > Edit Layout to open a form to edit the site layout .
2. Do the same steps as the part Edit layoutof the current site.

Edit Navigation. Do the following to edit the navigation of a site.

1. Click Site > Edit Navigation to open the Navigation Management form.
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Chapter 4. Basic Actions

Navigation Management [x]
| eXo I-(— The Name of the Site

th
EL_ Home
---H Group Mavigation
---H Portal Navigation
--;_ Register
---_ MNews
---H Events

Add Node Save

o
Click

2. Click Add Node to open the ADD/EDIT PAGE NODE form. (For more details, refer to the
Section 5.3.1, Add a new node, Gateln User Guide 3.1.)

3. Inthe Page Node Setting tab, enter a name for the node. It is required.

ADDIEDIT PAGE NODE [>x]

| w Page Node Setting [b Page Selector " b lcon l

Uri:

Node Name: [ Contactus

Label: [Contact Us| ]

Visible:

Publication date & time: [

Save Back

Details:
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Edit a Site

Table 4.4.

Uri: The node's identification. The Uri is
automatically created once a new node has
been created.

Label: The node's display name on the screen. This
field may be changed and its length must be
between 3 and 60 characters.

Visible: This checkbox allows the page and its node
to be shown or hidden on the navigation bar,
the page navigation bar and the sitemap.
See above for more details.

Publication date & time: This option allows this node to be published
for a period of time. Two fields, including
'Start Publication Date' and 'End Publication
Date' only display when this option is
checked.

Start Publication Date: The start date and time to publish the node.

End Publication Date: The end date and time to publish the node.

4. Select the Page Selector tab:

|Bs| ADD/EDIT PAGE NODE

[b Page Node Setting ] + Page Selector ” » lcon ]

(@) Selected Page Info
Enter the page name
Page Id: 4.

Name: I u

Ti‘tIEZI |

I'(—- Enter the titlg of the page

I_gat:raatepage || & Search and Sekect Page |
e —

Create a new page Select an existing page
Save Back

Details:

Table 4.5.

Page Id: The identification string of the page. It is
created automatically when the page is
created.

Name: The selected page's name.
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Chapter 4. Basic Actions

Title: The selected page's title.

Clear Page: To remove the input page information in the
fields

Create Page: To create a new page with the input name
and the title.

Search and Select Page: To search and select an existing page.

< Enter a title for the page.

« Click Create Page to create a new page or Search and Select Page to select an existing
page for the node.

5. Select the Icon tab to choose an icon for the node. It is not required.

6. Click Save to create a node for the navigation.

@ Note
You can edit/delete a node, edit a node's page, copy/cut a node and more by right-
clicking the node in the form Navigation Management form.

Edit Configuration. The portal's configuration including language, skin and permissions can
be edited by doing the following:

1. Click Site > Edit Portal's Config to open the same form as the form to create a site.

2. Do the same steps as in Section 4.3.1, “Create a new site”.
4.3.3. Switch between sites

This function is used to change the current web site by another one.
Procedure 4.4.

e Just select a site in the site list that appears when you move the cursor to Sites on the
Administration bar:

) — Site Group Dashboard 3~ Site Editor
= classih
T dacme :
Over| -[I] =*@
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Delete a site

Your current site will be switched to the selected site, and you will see all the child pages that
displays on the Navigation bar of the selected site.

D ~ | Site Group ") Dashboard W | Site Editor
classic Welcom
T acme Dverview
. Owver 5
T B0 Mews
Events

MNewsletters

Contact Us

4.3.4. Delete a site

This function is used to delete a portal (site) from the portal list.

Do the following:
Procedure 4.5.

1. Show a portal list by clicking Site on the administration bar:

b9 Group () Dashboard [ Site Editor Root Reot | pyplished| v

4

News Events MNewsletters Contact Us

acme [ Edit Layout °E  Edit Navigation °E Edit Portal's Config © Dekte

e classic =] Edit Layout ©E Edit Navigation “% Edit Porial's Config

il exo [£] Edit Layout “L Edit Navigation “% Edit Portal's Config © Dekete
Add New Portal

2. Click

@ Delete

in the row of the portal that you want to delete.

3. Click OK in the confirmation message to accept deleting.

41



Chapter 4. Basic Actions

Note

You cannot delete the Classic site by default.

4.4. Contribute Content

4.4.1. Edit Mode

A site in eXo Content has two modes (Published mode and Edit mode) which are specific for
editing site and viewing site. You can easily switch between these modes by selecting in the drop-
down list at the top left corner.

Mary Kelly Published <

Welcome: root L Edit

« Edit mode: In this mode, you can edit all contents of the current site. When hovering the mouse
over contents, you can see edit icons which enable you to quickly edit these contents. You can
take advantage of this feature to submit contents to a page.

* Published mode: In this mode, you only can view the current site without editing the contents
of the site.

When you login to a site, by default, the page is in the published mode, you cannot see any quick
edit icon and cannot edit site contents at this time:
D ] Site Group ) Dashboard &7 Site Editor Mary Kelly

‘Welcome: root A,

w News Events New

DOCUMENTS E

o= Where we are

Laorem ipsum dalar sit amet 28/08/2009
consectetuer adipiscing elit

Welcome to Acme Corp

Welcome to our site

8 conditions and Requirements
Larem dolor sitipsum amet 2B/08/2009
consectetuer adipiscing elit

T How to join us
Consectetuer adipiscing elit 27082009
lorem ipsum dolor sit amet

o Lorem ipsum dolor sit amet, consectetur adipisicing : Lorem ipsum dolor sit amet, consectetur adipisicing
Fa Y
; elit, sed do eiusmod tempor incididunt ut labore et elit, sed do eiusmod tempor incididunt ut labore et
L dolore magna aliqua - dolore magna aliqua
\ ana e gnaals LATEST NEWS B
Read mor Read mor =
-;iif Lorem ipsum dolor sit amet, consectetur adipisicing ? Lorem ipsum dolor sit amet, consectetur adipisicing k ACME News 1
; it, sed d smod tempor incidic abor 4 it, sed d smod tempor incidic abor = : "
e elit, sed do eiusmod tempor incididunt ut labore et el ¢ elit, sed do elusmod tempor incididunt ut labore et \ & Loremipsum dolor sit amet
ﬁ dolore magna aliqua =& M- dolore magna aliqua consectetur adipisicing elit
Read mor " . Read more sed do eiusmod tempor incididunt ut

labore et dolore magna aliqua.

When a page is switched to the Edit mode, you can see quick edit icons on the site contents when
mousing over them.
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For Single Content Viewer (SCV), you can see the current state of the content, the Edit Content
icon and References icon.

D | Site Group *) Dashboard 37| Site Editor Mary Kelly

Single Content Viewer Welcame: root

L

DOCUMENTS E

' Conditions and Requirements
Lorem dolor sitipsum amet 28082009
consectetuer adipiscing elit

Welcome to Acme Corp

-~ How to join us
Welcome to our site o 1o

Consectetuer adipiscing elit  27/08/2000
larem ipsum dolar sitamet

= Where we are

Lorem ipsum dolor sitamet  zaoe/2009
consectetuer adipiscing elit

v . S Lorem ipsum dolar sit amet, consectetur adipisicing
> elit, s elit, sed do eiusmod tempor incididunt ut labore et
| dolore magna aliqua. T dolore magna aliqua. LATEST NEWS
- Read mor Read mor

For Content List Viewer (CLV), you can see the current state of the content, the Edit Content,
References icon, the Add Content icon and the Management Content icon.

B

Welcome to Acme Corp

Welcome to our site

- Edit conterft\
s E“-’- L ey

4.4.2. InContext Editing

InContext Editing enables you to edit content "in context" rather than having a WYSIWYG editor
pop-up over the top of the page. This feature makes page editing a much more user intuitive
process, with the new content automatically taking on the previous contents.

To use InContext Editing, turn on the Edit Mode.

4.4.2.1. Add Content

Adding a new content by InContext Editing is enabled for the Content List Viewer.

Do the following:
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Procedure 4.6. Add a new content

Turn on the Edit Mode > hover the mouse over the CLV that you want to add a new content in.

2. Click the Add Content icon on the CLV.

You will be redirected to the Content Explorer with a new document form for you to write

a document.

SelecTemplate (" i [}« Select a template

e J!
ruame[ ];.
LH'!BDE[E,., 3]
‘Summary
E === v & o s== @

Zsouce B F U

m
~| 8
A
(= WL
[y
"
o | =
i | &
‘I
b - ]
K
B gk
B e
i
)
o [ B
1

Lastmodified date : Auwg 21, 2009 355813 AM

Click to save —m[ r—
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3. Click
to open the template list and select one.

4. Fulfill all the fields in the form. See Section 4.7.4.2, “Add a document” to know how to add
types of document.

5. Click Save as Draft to save the document in a folder of the Collaboration drive.

@ Note
Saving a document in which folder of the Collaboration drive depends on the path
you choose in

4.4.2.2. Edit Content

You can edit any contents on the homepage for SCV and CLV with InContext Editing. For CLV,
you only can edit each content in it.

Do the following:
Procedure 4.7. Edit a content

1. Turn on the Edit Mode > Hover the mouse over the content you want to edit.

2. Click
:I}

i

at the right corner of the content you want to edit. You will be redirected to the Content
Explorer with the document form for you to edit.

Publication Collaboration
. Back to
I, Upload | 3 Manage Categories Edit panel of the current content the site ~TC7 .
collaboration H— 2 - -
r - Main Content || » llustrati v Advanced
o i web contents i I ntent ustration "anc

__, Events Title | ACME Introduce

i

&5 NewEvents Name | jntroduce

News *

P Main content (O

= ) site artifacts Q. El source F [ Weile)
Contact Form Confirm — = -
B I U == = = A @2 B3 =
--[EF] ACME Footer

Theglace af
the|@bntent
& medias

--[EF] ACME Logo
--[EF] ACME Navigation
- [E] Newsletter Header | =

ACME Searchbox
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3. Edit the content > Click Save as Draft to save the content.

Welcome to eXo |Acme| Corp

‘Welcor & to our site

Save

body div div div l

Save as Draft Close |

4. Click
o
to return to the site and in the Edit Mode, the content in the state "draft" with its modification
is visible.

Mews Ewents Mewsletters Contact Us

Welcome to eXo Acme Corp

Welcome to our site
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Section 4.4.3, “Publication

Process”

4.4.2.3. Manage Content

With InContext Editing, you can easily manage a Content List Viewer on the homepage. You can
add a new content in the CLV, edit, delete an existing content or copy/cut/paste to another CLV

and take more actions in the right-click menu.

Do the following to manage content in the CLV.

Procedure 4.8. Manage Content

1. Turn on the Edit Mode > the Manage Content icon of the Content List Viewer that you want

to manage on the homepage.

oLls

COMPANY NEWS Content list viewer >
Click
—ACME News 1

Aug 21, 2009 3:55:11 AM by root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.

Read mare
ACME News 4
Aug 21, 2009 3:56:43 AM by root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aligua.

Read mare
ACME News 3
Aug 21, 2009 3:56:17 AM by root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.

Read more
ACME News 2
Aug 21, 2009 3:55:44 AM by root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.

Read more

The browser will redirect to Content Explorer:
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Publication Collaboratioy_- Add a new content into the folder "News"
[fag] Add Foider || 3. AddDocument || 4, Upload Back to the site —d .
collaboration = ~ Document title Created date Author Last User Status
T - 95 [E ACMENews 1 B/21/09 3:55 AM  root
[ Events =1 [E ACMENews2 821009 3:55AM  root
NewEvents o [E acMENews 3 B/Z1/09 356 AM  root
— o
[E acME News 4 B/21/09 3:56 AM oot
T *

i=| ACME News

=] ACME News 2 The folder containing
=] ACME News 3 all the contents of CLV

[E=] ACME News 4

- site artifacts

-

2. Toadd anew document to the CLV, click Add Document on the action bar and do the same
steps as Section 4.4.2.1, “Add Content”.

To take other actions on a specific content in the CLV, right-click it to open a drop-down

menu. See more details how to takes the actions in Section 4.7.6, “Actions on Folders and
Documents”

4.4.2.4. Preferences

Preferences enable you to edit contents in the Single Content Viewer (SCV) and the Content List
Viewer (CLV), reset the display of the contents in SCV and CLV and publish contents.

Content Detail Preferences. Do the following to edit the Single Content Viewer:

Procedure 4.9. Edit Content Detail Viewer

1. Turn on the Edit Mode > Select the Preferences icon of a Single Content Viewer.

Welcome to Acme Corp

Welcome to our site

The Content Detail Preferences dialog appears:
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Content Detail Preferences  Select the path of the content

E3d
Content Selection *
)
Content Path | ACME Introduce @(—Click -
Show F‘ri"nt button
Display settings
_| Show Title _| Show Date _|  Show Option Bar 'r:if
Brint s Chooigfa page for the print review
how in page | | printviewer
Show Options lp ’D""Click
with |]ccntent-i1:| «— Parameter containing
the content path
Advanced
Dwnamic Mawigation
Contextual Content @ Enabled ' Disabled Enable and deﬁ'i’ie
oy [oontentia <*—the correct @
parameter
[ Save ] [ Cancel

Details:

Content Selection: Select the path of the content that you want to show by clicking

+

Display Settings: Allow configuring Title, Date and OptionBar visibility.

« Show Title: Specify whether the title of the content is displayed or not.
« Show Date: Specify whether the date of the content publication is displayed or not.
« Show Option Bar:Show or hide the Option bar used to show the print link.

Print Setting:

« Show in page: The content is shown in the page.

< with: Parameters contains the content path.

Advanced link: When clicking on this link, the Advanced pane will be shown. If Contextual
Content property is set as "Disable", the Advanced pane is closed by default .The content

should enable “dynamic navigation” that interprets the URL and shows a content.
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2. Click the plus icon next to the Content Path to re-select another content. The Select Content
dialog appears:

Sdanlm

1 ]

Fiter a The path to the chosen content

ﬂGmﬂd‘Mﬁ + Sites Management . acme . webcontents siea'ﬁfa:isl

T

- [E) Navigation [ Navigation 8/21/09 1:08 AM
= =] Footer 8/21/09 1:09 AM
|25 Searchbox 8/21/09 1.06 AM
# - |=| Searchbox
[z contact_form_confirmation B/26/09 10:37 PM
#-|=| contact_form|
|E5| newsletter_header B/25/00 8:44 PM
®~ |=| newsletter_he
[ Logo B/21/09 1:04 AM =
mE [E] Introduce 8/21/09 1:10 AM
8- |5 Introduce ) [ Signin 4)1/10 4:18 PM
*- =] Signin
®- =] 2010
#- = links
n|j§"| categories =
- =| ApplicationData
#-|=| events

%
¥

(4] i | [¥]

1]

3. Choose a folder on the left panel and a content in the folder on the right panel. The content
chosen will be displayed in the Content Path field.

4. Tick the checkboxes, including the Show Title box, the Show Date and the Show Option
bar box if you want to display the content title, the publication date and the print button like
the illustration below:
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|ECME Introduce*— The title of the content
: The publication-date of the content

Print button

Welcome to Acme Corp

Welcome to our site

5 1In the Print Setting part, click

to open the UlPageselector dialog, you will see Printviewer.

Click the Print button, the content is opened in the print viewer page.
D Site Group .y Dashboard 7| Site Editor Mary Kelly | Edit o

ACME Introduce Content on Preview page
¥

Welcome to Acme Corp

Welcome to our site

(=) Print (8 Close

URL: http://localhost:8080/ecmdemao/private/acme/printviewer?content-id=/repository/
collaboration/sites%20content/live/acme/web%20contents/site%20artifacts/
Introduce&isPrint=true

In which:

e printviewer?: the print viewer page of the content.
e content-id: the parameter containing the content path.
6. Click Save to save all the changes.

Content List Preferences. To edit the Single Content Viewer, do the following:

Procedure 4.10. Edit Content List Viewer

1. Turn on the Edit Mode > Select the Preferences icon of a Content List Viewer.
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ECARA MRS Content List Viewer
ACME News 1
Aug 21, 2009 3:55:11 AM by root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.
Read more
ACME News 4
Aug 21, 2009 3:56:43 AM by root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.
Read more
ACME News 3
Aug 21, 2009 3:56:17 AM by root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aligua.
Read more
ACME News 2
Aug 21, 2009 3:55:44 AM by root
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.
Read more
The Content List Preferences dialog appears:
Content List Preferences [x]
Contents selection
Path of the content folder e
Mode @ By Foider ) By Contents / &
_ %
Folder path IlEvem;s } + €— Click -
Order by |pypjication date ¥
) Descendant @ Ascendant
Display settings
Header | Automatic Detection yf P
Template | TwoColumnsCLVTemplate.gtmpl ¥ | «— Choose a template
Pagnalor |[UlPaginatorDefauit.gtmpl * | Show Options
ltems per page |5 . ¢
Show Title = Show Image ﬂ Show Summary o
Show Header = Show Date = Show Link =
Show Refresh = Show More Link o Show RSS Link o ':i.‘
Advanced
Dynamic Navigation
URL when opening a singe content s
Contextual Folder ) £ &) Dicabled P 9 g )
[
" [folder-id ) i
how in page - 1 . @
i [detai [Deciick
I " | content-id I‘ Parameter containing the @

path of a single content
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Details:

Table 4.6.

Mode

This mode is to select web content for list
viewer. There are two modes:

By Folder: This mode allows you to select a
content folder in the Folder path field.

By Content: This mode allows you to select
by the content in a specific folder in Folder
path field.

Folder path

Order by

Header

The path to a location of a folder that
contains the content.

The field is selected to sort content in the
list viewer. You can sort content by Title,
Date created or Date modified in ascending
or descending order.

The title of all contents that are listed in List
Viewer.

Viewer template

Paginator template

The template is used to view content list.

The template is used to view each content in
the list.

Iltems per page

The number of items will be displayed per
page.

Show image

Show summary

The option is to show or hide the illustration
of each published web content/document.

The option is to show or hide the summary
of each web content/document.

Show header

The option is whether to show a header or
not.

Show refresh button

Show title

Show date created

Show link

The option is whether to show the refresh
button at the left bottom of this page or not.

The option is to show or hide title of each
published web content and/or document.

The option is to show or hide the created
date of each published web content/
document.

The option is to show or hide the link of web
content and/or document.
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Read more The option is to show or hide the Read more
to read all the content of a web content and/
or document.

2. Browse the documents/ web content of an available site by clicking
AlE

next to the folder path field.

3. Ifyou select the By folder mode, select an available site on the left, then select a folder that
contains contents (documents and/or web content) on the right by clicking the folder.

If you select the By content mode, select an available folder from the left panel, all content
in this folder will be listed on the right panel. Click a content on the right that you want to add
to the content list. A message informs that you have successfully added it in the Content List.
The selected content is listed in the Content List.

4. Enter a header for the content list in the Header field if you want.
5. Select a template to display the content list in the template list.
6. Tick/untick some options that you want.

7. Click Save to save all the changes.

4.4.3. Publication Process

After a new content is created, it is saved as draft and you can easily to publish it on your site.
The publication process consists of four steps:

Request approval > Approval > Stage > Publish

If you do not have the right to approve or publish a content, so when you want to publish your
content, you need to send your approval request first.

If you have the right to approve or publish a content, you do not need to send a request approval.
You can yourself publish it with the Stage step immediately.

* Request approval: When a new content is created, it must be approved before publishing by
clicking Request Approval on the action bar of the Content Explorer or clicking Pending in
the Manage Publication form:
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Manage publication x

~ Revision (| » History
— Revision travel

Status:

Draft Pending Approved Staged Published

— Scheduled

from to

Revisions Date Author Status Action
Revision: travel Dec 6, 2010 4:26:46 PM root Draftfcurrent revision]

[ Save ] [ Close ]

« Approve: To approve a content, click Approve on the action bar of the Content Explorer or
click Approved in the Manage Publication.

« Stage: Stage enables you to publish a content in a period. After selecting the publication
schedule for the content, it will be automatically published as the schedule.

To publish content for a stage, click Stage > Click From/ To to open a mini calendar > Select
the date to publish.

To publish your content forever, you should not set time in the To field.
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Manage publication @
|~ Revision [ » History | Click
— Revision test
Status: Y _
U—u—u ¢
Draft Pending Approved Staged| Published
Start date of publication End Date of publication
— Scheduled v ¥

N —  —

H Author Status Action
= 1 4 December - 2010 ok - — —
F john Staged[current revision] 1
Bl 5 M T W T E 5
T T | save || ciose |
—] 5 &8 7 8 8 w 1 .
<— Mini Calendar

12 13 14 15 16 17 18

19 20 21 22 23 24 X5

26 2¥ 28 29 30 31

[ 17:21:37 )

« Publish: A content will be published when you have completed the Stage step.

Draft Contents Approval-waiting Contents Publication-waiting content
iy Draft Contents ‘Waiting For My Approval To Be Published Tomorrow
lecme  The number of contenEs GavreClick ||Lomem

4.5. Content Inside Categories

You can create new contents in any folders or directly in a CLV with Incontext Editing. However,
creating contents inside a category helps you easily and quickly manage and publish them.

4.5.1. What is a Category in eXo Content?
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Categories are used to sort and organize documents to ease searches when browsing documents
online. After creating a document, you should categorize it by adding it to a category. You should
directly create documents in a category, then the documents are automatically created links to
them in the category. When you browse the category, it will be possible to find the referenced

documents and display them as if they were children of the category node.

Categories are stored in the JCR itself .

45.2. Create a Content

This section will show you how to create a content in a category.

Do the following:

Procedure 4.11. Create a content

1. Goto Group > Content Explorer > select a category in a drive. For example, select Acme
drive as the following illustration.

Content Explorer

@ =/ .
3 e . e
= == B * Document title Created date Author Last User Status
; § | Business 12/10010 4:11 PM
i-§ | Business F [El acMENews1 12/10/10 4:11 PM
27| ACME News 1 — B acMENews2 12/10/10 4:11 PM
| ACME News 2 T B ACME News 3 12/10/10 4:11 PM
7| ACME News 3 ® | Bl ACME News 4 12/10/10 411 PM
5| ACME News 4 O, i spors 12/10/10 4:11 PM
§ | sports £ | Technology 12/10010 4:11 PM
§ | Technology £ word 12/10010 4:11 PM
4— Select category
-
Al ltems 0

+ Owned by me
» Favorites
+  Hidden

2. Click the Add Document button to create a new content. See Section 4.7.4.2, “Add a
document” to know how to add a new content. The new content is a symlink.

—_—

o Igraduation

‘ -y Add category

acme

[y Add Document

II:I % | Graduation

|=1

- [ Postgraduate
- [ ACME News 1

-5 | Spaorts
¢ | Technology

2

S

=

[ s — D]
P v

W Upload
~  Document title

Created date Author

=

Last User Status

2, Postgraduate

Category chosen
to add a content

12/9/10 3:22 PM mary

New Content

mary

draft

Click the symlink to view the content.
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4.6. Dynamic Navigation

Dynamic Navigation enables you to get a parameter to configure the portlet by URL. It means that
the URL containing the content path can be dynamically changed.

This section shows you how to use Dynamic Navigation in eXo Content.

Do the following to access Dynamic Navigation:

Procedure 4.12. Access Dynamic Navigation

1. Turnonthe Edit Mode > hover the mouse over SCV or CLV and select the Preferences icon.
If you select the Preferences icon of SCV, the Content Detail Preferences form displays.
If you select the Preferences icon of CLV, the Content List Preferences form displays.

2. Clickthe Advanced link in the Content Detail Preferences form/ the Content List Preferences
form.

The Dynamic Navigation will display.

Dynamic Navigation in SCV

Content Detail Preferences X
Content Selection
i
Content Path | ACME Introduce M+ The path of the conitent
Display settings
[] Show Titke [] Show Date /] Show Option Bar @
Print settings
Show in page | printviewer Q
with |content-id l Dynamic Navigation
Advanced J’

Drynamic Mawvigation
3
Parameter containing

by | content-id the content path®

Contextual Content  ® Enahled ' Disabled

[ Save H Cancel ]

Details:
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Table 4.7.

Contextual Content « Disable: It means a single content will be
opened by an URL containing the Content
Path.

e Enable: This portlet is configured with
the provided parameter (content-id by
default).

By This parameter is the key in the URL to let
SCV know which really is the path in the
current URL. It is editable when Contextual
Content is Enable.

For example, open a single content with the Content Path "ACME Introduce". The URL of
the content is the following:

URL: ... /ecmdemol/private/acme/printviewer?content-id=/repository/collaboration/sites
content/live/acme/web contents/site artifacts/Introduce&isPrint=true

Dynamic Navigation in CLV
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|= Content List Preferences

Contents selection
STiE ® By Folder O By Contents @
Fold h N ;
e1Pat | Events * le—— The Path of the Content Folder
Orderby | pyplication date | & |
) Descendant ® Ascendant
Display settings
Header [ l Automatic Detection ¢
[T [TwoCuI.umnsCLVTempI.ate.gtmpI. 2
AT [UIPaginatorDefauI.t.gtmpl. = l
ltems per page [5 lf
Show Title O Show Image Show Summary
Show Header O Show Date O Show Link O
Show Refresh O Show More Link Show RSS Link 3
T Dynamic Navigation
Crynamic Mavigation +
Contextual Folder () £y (@) pisabled @
" |folder-id <= Parameter containing the Folder path| -
Show in page detail 3 3
with [Content id P;rameter containing the Q3
single content path
Details:
Table 4.8.
Contextual Folder « Disable: It means a single content will be
opened by an URL containing the Folder
Path (for CLV)
< Enable: It means the path of content list
(Folder Path in the Content Selection path)
can be dynamically changed by URL.
By This parameter is the key in the URL to let

Show in page

CLV know which really is the path in the
current URL.

A single content in CLV will be shown in a
selected page. You can choose any page but
you should take one with a Content Detail
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Portlet. The Content Detail Portlet should
enable “dynamic navigation” that interprets
the URL and shows a single content.

With This parameter is the key in the URL to let
SCV know which really is the path in the
current URL.

4.7. Content Explorer

4.7.1. Access Content Explorer

This page is used to manage all documents in different drives. This is really the flexible way
because you can do through the Internet anytime and anywhere. By default, anyone can access
Content Explorer but performing actions on Content Explorer depending on the role of each user.

Procedure 4.13.

« Goto Group > Content Explorer on the administration bar:

i) 7| Site Group =y Dashboard ) Site Editor

Content Manager's pages Welcome: root |

Content Explorer
New
Newsletters

A list of all drives organized in groups: Personal drives, Group drives and General drives in
the Content Explorer displays:
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le o =1 -
Publication Collaboration System

(il Add Folder | | &, Add Document [ A, upload |

Sites Management &

i = » GENERAL DRIVES
- acme l %
= classic Show Drives 1 liz) acme iz classic liz) collaboration . ?é] DMS Administration
g =
= shared . , . , )
2 |1z Events ;) SitesManagement |1s) Shared Groups Space ;s Shared Site
(a1, lis) Shared Users Space |1z Trash

+ GROUP DRIVES

. "1, /organization / ", /platform / administrators -,/ platform / users - I'platform /

All ltems I management/  web-contributors

+ Owned by me executive-board

+ Favorites
+ Hidden
» PERSONAL DRVES
Filter By Type
+ Contents l“—_”) Private l;w;u Public

+ Documents

+ Images

» Music

+ Video

Personal drives:
Personal drive is the working space of a user. If you want to do in private, select the
Private drive, no one else can access or get your private resources. If you want to create
resources and share them with others, work in the Public drive.

¥ PERSOMNAL DRIVES

I Private | I Public

Group drives:
The drive of a group is the working space of users in that group.

In the following example, the user "root" joins in three groups : "executive-board",
"administrators" and "users" so he has the right to access these group's drive.
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b+ GROUP DRIVES

'+, [ organization f Y ¢, [/ platform / '+ [ platform / users . [ platform f
= management / e administrators et e web-contributors
executive-board

General drives:

This is the working space for everyone but your access right in different drives depends
on your role. If you access as administrator role, you can see all drives; otherwise, you
can see some drives only as a web contributor role.

4.7.2. Drives

4.7.2.1. Private drive

Private drive contains personal data of registered users. Hence, only these individuals can access
data in this drive type.

Content Explorer

|E| (o) Current node f

[ Add Folder °. AddDocument | U, Upload Add Sym Link
= & (i, up y

Private = & Name Date time
n_ Documents ﬁ
L-7.p Favorites n
15
| Folksonomy
™ Music ‘s
_ Pictures Q.
& -|. . Searches
® Videos
Folders

By default, there are some initialized folders to store private user's resources.

1= EEQEY

Admin Info Actions

| Add Folder ' Add Document Wl Upload Add Sym Link
- | g L=

By selecting the Actions tab, you can:
» Create a new folder

» Create a new document

Upload file from your computer

Add Symlinks
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» Overload Thumbnails

» By selecting the Collaboration tab, you can:

ME & (¥ =) /eXo documents/eXo news
Admin Info Actions

i:'f Watch/Unwatch this document : %: Tagging this document K Add/Edit localised contents

Watch/Unwatch a document.

» Add tags for a document.

Set multi-display languages for document.

Vote for a document.
« Comment for a document.
» By selecting the Search tab, you can:
» Do the simple search
» Do the advanced search with more constraints, add new query to search
» Do search by existing queries.
 In addition, you can:
» Set up your browsing preferences
» Cut/paste, Copy/paste, Delete a node
» Lock a node
* Rename a node
+ Use the view WebDAYV function to view document content.

» Download documents (folders) to your machine.

E5| Vote for document
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4.7.2.2. Public drive

| Content Explorer [EEVEEETE] Form Builder  Administration
Elllc© =/ . N

| Add Folder B Add Document ‘ it Upload Overload thumbnail | ] Add Sym Link |._ Actions
Public SiE

No initialized folders

ple a e

With the Public drive, there is no initialized folder but you can create by yourself.

In the Public drive, you also can take actions like in the Private drive.
4.7.2.3. Drive of a specific group

By default, there are two initialized folders but you also can add more and take actions like in
Private drives. Only users in a specific group can access its drive.

ComemExplorer Newsletters Form Builder  Administration
e = . o

| Add Folder [;i Add Document | A upload Cverload thumbnail g Add Sym Link |<———- Actions
1 platform { users E & — —_—
———ea =
[| sharedData
% Documents SharedData
I gt
Folders
a,
~

4.7.2.4. Shared Users Space drive

Comem [SGIETE  Newsletters  Form Buikder  Administration
@ (| Iroot Current node - a

[ Add Folder Add Document | i, Upload 753 Overload thumbnail Add Sym Link Actions (
] i, Upl 1

Shared Users Space e | & = ——
|| demo | @ @
'ﬁ james
Iy Private Public
B[ john
g mary %

Srke root Q‘

Private
| i pusiic <—Sub-folddrs
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By default, there will be a list of all existing users, each user has a folder named as his username,
that includes two sub-folders (private and public). You can see both your private and public folders
here but you only can see the public folder of other users.

* In this drive, you can:
» Perform all actions that you can do in your private drive.
» View nodes from public folder of others.

« In this drive, you cannot:
» Add a folder/document in a root node.

» Add a folder/document in a folder named as other users' username and to child nodes of
this folder.

« Add folders/documents in a folder named as your username (e.g, you cannot add a folder/
document in the folder "root"), but you can do in its child nodes "public" and "private".

» Rename a default folder.
» Lock folders named by a user.
» Delete a default folder.

4.7.2.5. Show/hide the sidebar in a drive

The sidebar is used to show nodes like a tree or show the related documents, tags, clipboard
and saved searches.

You can show/hide the sidebar in two ways:

1. Procedure 4.14. Method 1

1. Click

to open the Preferences:
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[ Preferences @
Sart by |Alphabetic | ¢ | [Ascending | ¢
Show Sidebar Enable Drag & Drop .
Nodes Per Page Tick/untick ]
Advanced
[ Save ] [ Cloze ]

2. Untick the Show sidebar checkbox > Save.

The drive will be displayed like the illustration below:

l_ Newsletters Form Builder Administration
@ =) froot - Q.
Add Folder B Add Document | it Upload Overload thumbnail Add Sym Link Open preferences
=
Private Puhlic

3. To show the sidebar, tick the Show sidebar checkbox in the 'Preferences'.

2. Procedure 4.15. Method 2

1. Simply click the Expand icon to hide the sidebar as the illustration below:

[ig] Add Foider | Ea_ Add Document

i, Upload | @mmmuntnai | mmusmmk |

©

Shared Users Space

[==

S demo
| Public
Eil"l-_ james
@l mary
B[ oot

All ltems

+ Owned by me
+ Favorites
+ Hidden

Filter By Type

+ Contents

+ Documents
» Images

+ Music

+ Video

o

i

o

P

Click

» GENERAL DRIVES
& oo
E Events

E Shared Users Space

+ GROUP DRIVES
' I organization /

j management /

executive-board

+ PERSONAL DRIVES

% Private

|o) casse |, cotaboration 3 DMS Administration

E Sites Management @ Shared Groups Space @ Shared Site

E Trash

.-‘O” | platform / administrators .-‘O” | platform / users . I platform /
web-contributors

[5“]71 Public
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2. Click the Collapse icon to show the sidebar back.

4.7.3. Views

There are many drives in the Content Explorer. Each drive has some views that enable you to
look at data in the drive in a particular way. Each view has some tabs and each tab contains some
functions (or called actions).

eXo Content supports you four ways to view nodes in a specific folder and show actions of
corresponding tab on the Actions bar.

Section 5.2.2.3,
“Manage Views”

4.7.3.1. Admin view

In this view, each item in the list includes following information: Name, Date Created, Date
Modified, Owner, Versionable and Auditing. These information will help you manage nodes easily.

CamemExplorer Newsletters ~ Form Builkder  Administration

(= e — T - S
Actions
Admin | Info Actions [«— Tabs 1
| @ Manage Versions ‘ ﬁ Manage Relations | K Manage Actions | 1"-‘_‘*-[ View Node Properties ‘ @ Export Node | @ Import Node: l IZ‘
— vz | o 7 [name  Versionable Owner | pate modifiea  Date Created |
: (& | ™ Dacuments false 12110110 4:10 PM 12110110 4:10 PM
[Tt
;& Dacuments = 4% Favorites false 12/10/10 4:10 PM 12110110 4:10 PM
‘il’ Favorites 2 & Foiksonamy false 12/10/10 4:10 PM 12/10/10 410 PM
[ Folksonomy & Music false 12/10/10 4:10 P 12/10/10 4:10 PM
M Music g Y Ppictures false 12110110 4:10 PM 12110110 4:10 PM
T Pictures O, B searces false 12110710 4:10 PM 12110110 4:10 PM
@[ Searches B viceos false 12110110 4:10 PM 12110110 4:10 PM
: u.,] Videos
You also can sort nodes basing on node information
by clicking the label of corresponding column. The
.

indicates that nodes are ordered in ascending order and on the contrary, the

-

icon means nodes are in descending order.

4.7.3.2. lcons View

In this view type, nodes in a specific folder will be viewed as icons. The name of each node will
be shown under its icon.
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EERIEEIO) o e -

[l Aq s L#' Add Document |, Upload [ Add sym Link 3
[a]
DMS Administration B B ) ) ) ) il
0 B E@n N Srs
= =] E == ==
_|;| Hawaii.jpg naturel.jpg Nature2 jpg Nature_Mountain...
¥

i | Hawaii jpg
; 1= naturel.jpg
> ~¥| Nature2.jpg
i

Nature_Mountains.jpg

4.7.3.3. Thumbnails View

With Thumbnails view, nodes in a specific folder are viewed as icons bounded by frames. Name
of each node is shown under its icon.

Content Explorer

H o BI=E .
Thumbnail view

E.‘; Add Folder || 2, Add Document | A, Upload 53] Overload thumbnail \_; Add Sym Link

Private HH— B EH—_ —, N —— |—'\'1—_ j
& coomers = I | | | | =
7.; Favories a

I Documents Favorites Folksonomy Music Pictures Searches Videos
~ Folksanomy
M Music *

_ Pictures (e]

| Searches

If nodes are image files, their thumbnails will be shown like the screenshot below:

« Oy /Pictures/Nature Pictures -
[z Add Folder . Add Document |, Upload | [{55] Overload thumbnait | [_] Add sym Link s
Private 28 B L = — .
E-|Z] Pictures
© Nature Pictures = — |
E exo:thumbnails _g exo:thumbnails Hawaii.jpg naturel.jpg Mature.jpg Nature_Mountain...
Hawaii jpg Fa:
naturel.jpg
Nature2.jpg

Nature_Mountains.
_| Searches

_’_ Videos

Especially, in this view, you can overload a thumbnail image for a node. For example, if you want
to add a thumbnail image for the Digital Assetsfolder, do the following:

Procedure 4.16.

1. Select afolder (on the left or right panel) that you want to add a thumbnail image.
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2. Click
@ Cverload thumbnail
to open the Add thumbnail image form.
3. Select an image from your machince to use as a display icon for the selected folder.

4. Complete adding a thumbnail image by clicking Save. This node will be stored in a
exo:thumbnails folder.

5. Back to the parent folder (folder Pictures in this example) that contains the selected folder
to see a icon used to display.

4.7.3.4. Cover Flow View

This view is defined as a dynamical one with the side-scrolling view to nodes in a folder. In this
view, when a node is selected, its name is set with bold effect to more outstanding than others.

& ECPY -
—Cover Flow View

(g Add Folder L;x, Add Document ‘ it Upload [ Add symLink

I Private e | &

i ) Documents

L

:ﬁ Favorites
i--[2| Folksonomy
2 Music s

- | Pictures (a1

! | Searches

: Videos

-

" Documents Favorites Folksonomy Music Pictures
All ltems

+ Owned by me
+ Favorites
+ Hidden

If nodes are pictures, they are shown like:

Hawaii. jpg ]]ﬂtllI‘El.jpg Naturel.jpg Nature Mountains.jpg

If nodes are documents or folders, they are displayed like the illustration below :
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Documents eXo DMS exo:ecm Pictures

To move from one node to another one, you can do one of these ways:

» Use the mousewheel.
» Hold and move the yellow circle button to the left or the right.

« Click the folder/document name that you want to select.
4.7.3.5. Slide Show View

In this view type, pictures in folders are viewed in the slide show.

To view pictures in the slide show, click the

Q) =

.E
@Aﬂdmdau}ndth

HEE ] = E]

If nodes are pictures, they are displayed like the following illustration:
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The Slide Show view automatically show all picture nodes. Users can control this slide show by
clicking the below buttons:

Table 4.9.

Button Function

Go to the first picture node.

View the previous picture node.

Pause the slide show.

View the next picture node.

View the last picture node.

Continue viewing pictures node.
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4.7.3.6. Timeline View

This view enables users to view all nodes created and uploaded by time. Just click the

icon.

All the nodes that were created and uploaded will be displayed like below:

<0 =

' Add Folder

You can click directly on the node name to view its content in details.

imeline view

" Name Date time
Today
L] Faorest.jpg 2/26/10 10:29 AM
i Green Sea Turtle.jpa 2/26/10 10:28 AM
i) Waterfall.jog 2/26/10 10:28 AM
m Faorest Flowers.jpg 2{26/10 10:27 AM
Yesterday
Look More Beautiful With Longer Eyelashes 2/25/10 5:36 FM
Communication Skills 2(25/10 5:55 PM
You can also click the
to mark your item as favorite or the

w

icon corresponding to nodes in order to remove it from favorites.

4.7.4. Actions

Actions are added in tabs in Content Explorer by administrators. Depending on each tab and each

drive you are browsing and your role, you can see which action.

eXo Content consists of many actions. This section shows you how to take all the actions in

Content Explorer.

4.7.4.1. Add Category

This function enables you to add a category to a node.
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Do the following to add a category:

Procedure 4.17.

1. Choose a node to which you want to add a category.

2. Select

~ oy Add category
on the action bar and the Add Category form appears:

= Add category x

Category Mame

[ Save ][ Cancel ]

3. Enter a name for the category in the Category Name field.

4. Click Save to accept creating a new category or Cancel to quit from this form without adding
a category.

4.7.4.2. Add a document

There are several types of document in eXo Content, including File, Article, Podcast, Sample
node, File Plan, Kofax.

The table below shows nodes types to which different document types can be added. The rows
indicate what the node in the left column can be added to. The columns indicate what the node
at the top can contain.

Table 4.10.
Article  Podcast Sample File Kofax Content Docume
node Plan documen folder folder
e @ 9 O © ¢ 9 9
Article @ @ @ @
e @ © © 9O 9 9 9 o
Sample
e @ <@ e ©
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File

Article  Podcast Sample File
node

Plan

Kofax

Content Docume

documen folder folder

File Plan ﬁ

<

@

9

@

<

Kofax ﬁ
Uploaded ﬁ

@

@
v

@
v

@

<

@ @
p © @ @
e @ @9 @ @ @9
et @ @ @ @ 9 ¢

Do the following to add a new document:

Procedure 4.18. Add a new document:

1. Select a folder from the left panel where you want to add a new document.

2. Click

B,Addﬂnﬂ.mmt

on the Actions bar.

Blo| «

Admin

@ =/
Info

Actions

[l Add Folder | D,A.dd[hunﬂt | i | Upload | [ Add Sym Link
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3. Select the document type (template) that you want to create from the drop-down list (Article
is selected by default).

Each document (except Article) must be added to categories when being created.
Procedure 4.19. Attach files to a document

1. Select a document that you want to attach files to and click

.i, Upload

on the Actions bar.

The Upload file form will appear.

= [ %

Delete the form to upload
Sehmjﬁaﬁln User Guide en.pdf m(— Delete the

List Taxono T uploaded file

A uploaded file
Open the form to uploa

ME.IT!E[ ] L] +
Browse
Select a file i
Browse... "‘:_a file
List T
ist Taxonomy +*=Add a category

l Save H Cancel ]

2. Enter a name into the Name field, otherwise, the Name field is automatically added with the
name of the file.

3. Click Browse to select the attachment file. You can click

gt
to add multiple files.

4. Click Save to attach the files or Cancel to to quit.

Procedure 4.20. Create a new File document

1. Follow the steps in Add a new document: to open the Add New Document form, then select
File from the drop-down list for the field Select Template.
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The Add New Document form will be displayed.

Input a name for the file document in the Name field. Some special characters cannot be
used inthe Namefield: @ # % &* () “"':;[]1{}/!

Click the

to see the Mime Type list and select one. There are two types of File document for you to
choose:

 text/html: when creating a text/html File document, you can input value in the Content field
like source code (HyperText Markup Language HTML). After being created, it will generate
the content you want, then you can see both the inputted source code and the generated
content in that document.

e text/plain: after being created, it will display exactly what you inputted in the Content
field.html.

Input a value in the Content field:

e text/html: If you want to create a File document
with a source code and generated content, click
Source
in the editor bar. In this mode, only Save, New Page,

Preview icons in editor bar are visible for using. Click  the

LG,

to preview the generated content.

« text/plain: If you select text/plain type, the content field will be displayed like the following
illustration:
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Select Template | il <
Name [ ]“
Categories X
Mime Type | text/plain ¢
Language | gp 2
Content
Title | [==
Description [ ] A
Creator [ ] =+
Source [ l.l.

l Save as Draft Jl Close J

5. Fill values in all the fields, including Title, Description, Creator and Source.
Click the plus icon to open more fields.
6. Click Save as Draft to accept creating a new file document.

After being created successfully, a file document with type text/html will be displayed like the
illustration below:

~ ViewasHTML | » View as Plain text |

Hard Work and Success - One Follows the Other

The common sense point here is simple -- and sobering for those who are looking for
career success shoricuts. Be willing to go the extra mile. Create custom resumes for every
job for which you apply. Once you get a job, worlk harder than others. Vohmteer for
unpopular jobs -- and then do a great job. Yes, if vou want to become an outstanding
performer, it's important to be a lifelong learner, set and achieve high goals, and get
organized. But it's also important to do something a lot simpler -- and totally in vour
control; be willing to work hard Hard work will help build your brand and put you at the -

m
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b View as HTML I  \iew as Plain text

Hard Work and Success - One Follows the Other%o20

<p>The common sense point here is simple —— and sckering for those who are
looking for career success shortcuts. Be willing to go the extra mile.
Create custom resumes for ewvery job for which vyou apply. Onece you get a job,
work harder than others. Volunteer for unpopular jobs —- and then do a great
Jobk. Yes, if you want to become an outstanding performer, it&$39;3 important
to be a lifelong learner, 3et and achiewve high goals, and get ocrganized. But
it&#3%;3 also important to do something a lot simpler —— and totally in your
control; be willing to work hard. Hard work will help build your brand and
put you at the top of the promotion list, and bottom of the layoff list._</p>

Procedure 4.21. Create a new Article

4.

Follow the steps in Add a new document: to open the Add New Document form then select
Article from the drop-down list for the field Select Template. (Actually, Article is selected
by default).

The Add New Document form will be displayed.

Input the name and the title of the Article in the Name and Title field, some special characters
can not be used inthe Namefield (@ #% &*()“"':; [1{}/)).

Input value for the Summary field, and the Content field.

Click Save as Draft to accept the inputted values, or Cancel to quit.

After being created, the new added Article document will be like the illustration below:
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eXo news Qb:
l.--"".

Summary :

eXo at the “Solutions Intranet” Event in Paris - May 5th &
6th

Content :

eXo will attend the "Solutions Intranet et Travail Collaboratif™
event on May 5th and 6th in Paris. Come toc meet us to talk
about Intranets and Collaborative Soluticns eXo is offering. It
also will be a nice opportunity to share about industry trends and
new eXo developments.

. _.__'I'FU\VAII. COLEEIVHEN |

& Links :

£ Attachments :

Avg. Rating: 0.0 Votes: 0
The Links is used to list all its related documents. After adding relations for a document, Article
will be displayed. You can click these links to view the content of the related documents.

The Attachments is wused to list all its uploaded files/documents that is
attached with the Article. You can remove the attachments by clicking the

ﬁgﬁ? Attachments :

(&7 Contact list

Remove this attachment file

For more details about how to add an attachment, see Attach files to a document.
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@ Existing Names
Document name can be the same as the existing one. When a new document is
created with the same name as other existing document, its name will be added

an index (e.qg: test [2]).

Procedure 4.22. Create a New Podcast

1. Follow the steps in Add a new document: to open the Add New Document form and select
Podcast from the drop-down list for the field Select Template.

The Add New Podcast form will be displayed.

Table 4.11.

Field Details

Name

The name of a document. This field is
required. Some special characters (@ # % &
*()“':5[1{/)) are not allowed to input in
the Name field.

Title

The title of a document.

Categories

Link

Categories of a document.

The link to the source path of the uploaded
media file. This field is required.

Author

Explicit

The author of the uploaded media file.

It is used to indicate whether or not your
podcast contains an explicit material.

There are two options:
¢ Yes: an "explicit" parental advisory graphic
will appear next to your podcast artwork

* No: you see no indicator — bank is default
advisory type

Category

Keyword

The category of the uploaded media file,
example: music, film, short clip, etc.

Keyword allows you to search your podcast
files more quickly. You can use commas to
separate between keywords.

Publish date

The date when an episode was released.
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Field Details

Description Information about the uploaded media file.
Mime type The type of the uploaded media file.
Length The length of the uploaded media file.

2. Inputvalues for fields. To upload a media file, click the Browse... button and select the media
file from your machine.

3. Click Save as Draft to finish, or Cancel to quit without saving changes.

@ Exisiting Names
Document name can be the same as the existing one. When a new document is
created with the same name as other existing document, its name will be added

an index (e.g: test [2])

Once created, a Podcast will appear as so:

Podcast: Sad Angel
Title: Sad Angel

Link: youtube

Author: Igor Krutoi
Explicit: no

Category: Piano
Keywords: Instrumentals
Publish date: April 16 2010
MimeType: audio/mp3
Length:

Description:

An amazing pianc meledy

Avg. Rating: 0.0 Votes: 0

Podcasts can be listened to immediately, or transferred to another device.

Procedure 4.23. Create a new Sample node

1. Follow the instructions in Add a new document: to open the Add New Document window
and select Sample node from the drop-down list for the field Select Template.
The Add New Sample Node form will appear.

2. Complete the appropriate fields.

3. To upload an image, click the Browse... button and select an image from your computer.
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4. Click Save as Draft to accept or Cancel to quit without saving changes.

After being created, a new sample node will be displayed like the illustration below:

Node name sample-node

Title Sample node

Date May 19 2010

Date time May 21 2010 09:31:39

Description Image
One of the best coffeshop in Hanoi

Summary Content
A funky new cafe that can be a challenge for some to find. Tucked away in an alley off the busy Old Quarter street of Ma
May.This place has great and reaxing athmosphere to enjoy
coffee with friends.
Relations Attachments
- Best spots in Hanoi .odt - Hanoi tourguide.png
Avg. Rating: 0.0 Votes: 0

The Relations area is used to list all its related documents. See Section 4.7.4.15.3, “View
Relations”.

You can click the links to view content of the related document.

The Attachments area is used to list all its uploaded files. See Attach files to a document.

Procedure 4.24. Create a new File Plan

1. Follow the instructions in Add a new document: to open the Add New Document window
and select File plan from the drop-down lis for the field Select Template.

The Add File plan form will appear.
2. Fulffill in the appropriate fields of the tabs in the Add File plan form.

3. Click Save as Draft to accept creating a file plan.
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Tabs in the Add File plan form

The Name tab

Select Template [ File Plan

- Name [_r Record properties |[_> Process properties

Name [ ]-
Categories T
Language [ en 2 ]
File plan note
saveasDrant || ciose |
Table 4.12.

Field Details

Name The name of the file plan.

Categories The categories of your file plan.
Select the categories for your file
plan by clicking the
-+
button.

File Plan note

Note for presenting any other information
for users.
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The Record properties tab

» Name | - Record properties » Process properties

Record category identifier I

Disposition authority I

Permanent record |[True
indicator

Diisposition instructions

Contains records folder [True

Default media type | Electronic

Default marking list [pgne

Drefault originating
organization

Vital record indicator |[Trpe

Vital record review period [Qne Minute

Table 4.13.

Field Details

Record category identifier

The alphanumeric or numeric identifier
indicating a unique record category. This
must be a unique ID and if left blank will be
created automatically by the system.

Disposition authority

Permanent record indicator

A reference number to the regulations that
govern the disposition.

A type of record indicators which should
never be deleted.

Disposition instructions

Contains records folder

A readable guidelines on how the records
associated with the file plan will be
handled.

The confirmation is about whether the
records folder is contained or not.

Default media type

The choice for preset media types which
are made available to simplify the data
entry for the record. The frequently-chosen
value is "electronic" or paper.
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Field Details

Default marking list Handling and classification information
that are printed at the bottom of the
record, such as UNCLASSIFIED or
NOCONTRACT.

Default originating organization This option is to enter the original
arrangement as default which is made
available to simplify the data entry for
the record and to assume that originating
organizations are the same for the
information in the file plan.

Vital record indicator This flag is to allow whether tracking or
reminding you of the record as essential or
not.

Vital record review period The choice for the interval of time between

vital record reviews.

The Process Properties tab:

[b Mame " » Record properties l ~ Process properties

Process cutoffs  True - =
Event trigger =
Cutoff period  One Minute hd
Cutoff on obsolete  True -
Cutoff on superseded  True -
Process hold  Trie - =
Hold period  One Minute -
Discretionary Hold — True -
Process transfer  True - *

Default transfer location
Transfer blodk size

Process accession  True - |*

Accession location
Accession blodk size

Process destruction  True - *

Table 4.14.

Details

Process cutoffs The boolean datatype is used to break a
process. If the process cutoff flag is set in
the file plan, the record is cutoff after the
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Field Details

Event trigger

Cutoff period

Cutoff on obsolete

Cutoff on superseded

expiration, or after it has been obsolete or
superseded, depending on the information
in the file plan.

The text datatype is an automatic
executing code which is used to tell the
event to perform some actions.

The duration for the record -cutoff
performance.

The record is cutoff when it is obsolete.

The record is cutoff when it is removed or
replaced.

Process hold

Hold period

Discretionary Hold

This boolean datatype is used when a
record process may be held before the
further disposition is handled.

The duration when a record may be held
after cutoff which is normally measured in
Years.

The boolean datatype is used when a
hold may be discretionary, such as after
a command change. So, the discretionary
hold flag allows the records management
module to track these manual checks.

Process transfer

Default transfer location

The boolean datatype is used to determine
how a record process will be transferred.

The text datatype is used to determine
where a record is transferred by default.

Transfer block size

The float datatype is used to determine
in what size blocks for organizational
purposes that is normally measured in
Years.

Process accession

Accession location

Accession block size

The boolean datatype is flagged when a
record which is held permanently must
be ultimately transferred to the national
records authority.

The text datatype is flagged to specify an
area for the accession transfer.

The text datatype is flagged to determine
the blocks size for organizational purposes
which is normally measured in Years.
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Field Details

Process destruction

The boolean datatype is flagged if there is
any record to be destroyed. After that, the
record is marked in the Alfresco system
to be permanently destroyed so that all
information, metadata and physical traces
are removed and cannot be recovered.

After being created, the new File Plan will be displayed:

#5 File Plan Content: rew File Plan
Record Category Identifier
Disposition Authority

Disposition Insktructions

Permanent Pecord Indicator krue
Contains Records Folder krue
Default Media Type Electronic
Default Marking Lisk HOME

Default Qriginating Crganization

Mumber of Records 0
+ Records [ ¥ Obsolete Records " ¥ Superseded Records " ¥ Mitals Records .

Record Id Record name Crriginator

Procedure 4.25. Create a new Kofax

Date Received Qriginating Organization

1. Follow the instructions in Add a new document: to open the Add New Kofax form and select
Add New Kofax from the drop-down list for the field Select Template.

The Add New Kofax form will appear:

Select Template | Kofax document

Name [

Categories

Language | gn

[ Save as Draft J[ Close J
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2. Input a name for a Kofax document in the Name field. This field is required. Some special
characters can not be used in the Name field( @ # % &* () “':;[1{}/ ).

3. Select categories for a Kofax document by clicking the

4+
icon.
4. Click Save as Draft to accept creating a document or Cancel to quit the form.

After being created, a kofax document will be displayed like this illustration:

¥ File wigws | - Document wigw

Kofax document name nevs kofax document

awg, Rating: 0.0 Wotes: 0

The File View tab is used to display all added nodes in that kofax. Besides, all added files in kofax
are also displayed in the Document View tab:

¥ File view || » Document wigw

kofax document nanne niew kofax document
Downloadable File #1 syskemn guide . pdf
Downloadable file 22 B config.gif

Avg, Rating: 0.0 Wotes: O

Procedure 4.26. Create new Event

1. Follow the instructions in Add a new document: to open the Add New Event form and select
Event from the drop-down list for the field Select Template.

The Add New Event window will appear:
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Select Template

Title
Name

Language

Location

Google Maps ?
Start dateftime

End date/time
URL

Summary

Content

Event v
*
*
en v
*
05/21/2010
05/21/2010
A

Save Cancel

2. Enter atitle for the event.

3. Input the location where the event will take place in Location field. Check the Google Maps
checkbox if you want the location of the event shown on Google Maps.

4. Enter the Start and End Date/time of the event.

5. Fill the Summary and Content fields.

6. Click Save to commit the event, or Cancel to quit without saving changes.

After being created, the event will be displayed like the illustration bellow:

Paris

eXo-Big Event

5 | > | 6
2010 2010

eXo wil attend the “Solutions Intranet et Travail Collaboratif™ event on May 5th and 6th in Paris.

eXo wil attend the “Solutions Intranet et Travail Collaboratif™ event on May 5th and 6th in Paris. Come to meet us to talk about Intranets and
Collaborative Solutions eXo is offering. It also will be a nice opportunity to share about industry trends and new eXo developments.

The event will be displayed in a website as:
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Al
Events g

eXo-Big Event

eXo will atiend the “Solusions Intranet et Traval Collaborast™ eventon May 5t and G in Paris.

e o
eXo-Big Event m

X will atiend fhe “Solusons Inwranetei Traval Collaborast™ eventon May 54 and 6% m Pars.

X will atiend fhe “Solusons Inranet el Traval Collaborast™ eventon May 54 and 6% m Pars. Come jo meetus io talk about Inranets and Collaboratve Solusons
aXo s ofiering. K also will be a nice opporunity io share aboutmdusiry rends and naw eXo developmenis.

i Fr s e
. q_Map Tar
Colombes (Na15) _mlqgm ?,
“m-Colomibes  Asnieres-sur-Seine Aubervillers 1
G Cicny -~ SanlCuen’s [EIy Sovgny B0 Bonay
={oevor Lovatois-Peme. | 7 4] P pry
e Puleiux Peusly-sur-Seine 4l Nm,-la-sacm
Aalmaison . Las Lilks Rosny-Sous.Bois
Suresnes & llon oo Bagraiet pry [ETH
g ) "“"’T 3 5 Maontreud
Ml Clowd Eﬂ A Vincennes
b =) 3 '\ Sant-Manca .
| Boulogne-Billancaun R Tk
-le:-.Mmlmeaux [T “a o = i
ay-les. antrouge -
Fatern 6T Gentily m\mchaMMw:sur-m
s Mslsis luru-mi - Saina L
o T o Masans-Alfa

“Wiew Langer Map

& Attachments :

Bk

Avg. Rximg: 0.0 Yooz 0

4.7.4.3. Add Folder

You can create a document immediately in a specific drive; however, adding a document into a
specific folder enables you to manage documents better.

There are two types of folder:

« Content folder.

* Document folder.
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| DoCcuments
] eXo DMS

EEE NN NN NN NEEEEEEEEEEEEEEEEE

eXo Documents

e i

==l exoaelm

QSUEEEEEEE

- Videos

In default skin, the icon for a content folder node is displayed in blue and the icon for a document
folder node is displayed in yellow.

File and folder types in a folder

Content folder
* You can add a Content Folder folder into a Content Folder one.
* You can add a Document Folder folder into a Content Folder one.
* You can add documents into a Content Folder.

* You can upload files (images, MS word documents, OpenOffice documents, .pdf files, .txt
files, .xml file, etc) into a Content Folder.

» You can import sub node(s) that was exported into a Content Folder.
Document folder

* You can add a new Document Folder into a Document Folder.
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* You can add File, Podcast, File Plan documents into a Document Folder.

» You can upload files (images, MS word documents, OpenOffice documents, .pdf files, .txt
files, .xml file, etc ) into a Document Folder.

* You cannot add a Content Folder into a Document Folder
« You cannot import an exported a Content Folder into a Document Folder.

« You cannot import an exported Article, Sample node, Kofax into a Document Folder.

Procedure 4.27. Create a folder

1. Select the path to create a folder.

2. Click
[ Add Folder
on the action bar. The Add a Folder form is displayed:
Add a Folder x|
T¥Pe | Content Folder [c}eclick
Mame [ ]t
3. Click

1
e

T
a

to see the type list and select a folder type.

4. Inputvalue for the Name field. This field is required. You can notinput some special characters
inthe Namefield(@#% &*()"":;[1{}/")

5. Click Save to accept creating a new folder.
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4.7.4.4. Add translations to a document

This function enables users to add multiple languages for a document. This action is similar to
adding a language.

By default, the Add translation button is not displayed on the action bar.

Enable this function by navigating to Administration > Content Presentation >Manage Views.
See Section 5.2.2.3, “Manage Views” to know how to add the Add translation button to the tabs
on the action bar in Content Explorer.

Procedure 4.28.

1. Select a document you want to add the translation for. For example; select an Article which
is in English:
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Private =
EI;_, Content Folder

i“? Favorites

RN AN EEE NN NN EEEEEEE NS EEEEEEEEEEEEEEEEEEEEEER

EnEsmEmEmEEn

o v Folksonomy

[ .
- | Music

= Pictures
-

mEEEEEmEmEEn

mEEEEEEmEEEm

2. Click

éﬁj; Add Translation

on the Action bar. The Symlink Manager will appear:
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EI Sym Link Manager »
Path Node o
[ Save ] [ Cancel
3. Click
=

, then browse to the target document that has different language with the first document. For
example, the Article version in French.

EI Choose Target Node x
Users » root » Private » Documents » Content Folder
Workspace | cglaboration ¥

S Name Action
din @

| ofr i
article-en

B | article-en @

Article fr = Article fr

4. After you have selected the document, click Save on the Symlink Manager form:

EI Sym Link Manager »

Path Node collaboration:/Users/root/Private/Documents/Cor -

[ Save H Cancel

5. Select the document which you have added the translation to, then click the Relation button
on the sidebar.

You will see the available language for the selected document. Click the language on this
panel to view the document in the corresponding language version.
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Languages List

- en (Article fr)
- en (Article fr)

Relations List

Mo related document

References List

Mo related document

4.7.4.5. Add symlink

You also easily add a symlink for a document for the purpose of fast accessing the document
that you are looking for:

Do the following to add a symlink:
Procedure 4.29.

1. Select a document that you want to add a symlink.

2. Click the

on the action bar. The Sym Link Manager pop-up will appear:
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Sym Link Manager |z|
Path Mode (]
Sym Link Mame ®
[ Save ] [ Cancel
Table 4.15.
Details
Path Node The path of a link
Symlink name The name of the link.
3. Click the

icon to open the Choose Target Node form.

4. Choose the workspace which contains the node that you want to add a symlink:

dms-system W |

collaboration
backup
portal-system ‘ !
portal-work
WC m-syrs_te_ m

5. Click the

@

in the row of the node that you want to add, the path that the node will appear in the Path
Node field and the name of the node is set by the name of the selected node. You can also
edit this name.
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Sym Link Manager x
Path Node | gms_system:/Documents +
Sym Link Name | pyocpyments. Ink |*

| save || cancel |

6. Click Save to add symlink.

=i =z [m| « Q) = Documents .
Admin Info Actions

5] Acd Folder ”; Add Document i, Upload [ Add Sym Link b'e
DMS Administration oo = * Name Versionable QOwner Date Modifed Date Created

LN Y
; * L Documepts.nk false root 4/16/10 11:30 AM 4/16/10 11:30 AM
5 B exote B false root 4/16/10 10:59 AM 4/16/10 10:59 AM
..., Documents.ink Documents.Ink

2 eXo template &

X0 DMS .

4.7.4.6. Comment

This function is used to comment on a document (Note: you cannot comment for a File Plan
document).

Procedure 4.30.

1. Select a document that you want to add a comment to.
2. Click
! ' Comment this docurment
on the action bar.

The Add Comment form appears:
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Write Comment

Comment |- Hlsource | B 7 U se|iS i siEi=E == =iw|@AOR
_|E Strle ~ | Format ~ | Font - | Size
5

3. Add your comment in the Comment field.

4. Click Save.

Comments are shown at the bottom of the document:
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Skills

Languages English

Summary :

Comrunication skills play an important part in our success,

Content :

Being able to communicate effectively is therefore essential if vou want to build a
successful career, To do this, you must understand what your message is, what audience
vou are sending it to, and how it will be perceived. You must also weigh-in the
circurstances surrounding your communications, such as situational and cultural context,

@ Links :

£ Attachments :

fAwva, Rating: 4.0 Vaotes; 1

Laat comment posted by oot at 8357 AM. Wed, sun 24, 2009

1 Comments Shom comments

To view your comment click the Show Comments link:

L gat cormment postect iy gto:38 A Thu, Jun 18, 2009
Z2 Comments Hide comments
Commentad by - Email: marry@localhost - 5238 A Thu, Jun 18, Z004

This article is wery useful for people who want ko improve their communication skills,

You can edit your comment by clicking the
=
icon or delete it by clicking
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4.7.4.7. Edit documents

There are two ways to edit a document.
Procedure 4.31. Method One

1. Select a document you want to edit in the left panel.
2. Click

Edit Document

|

on the Action bar.

Or:
Procedure 4.32. Method Two

1. Select afolder that contains the document you want to edit.
2. Right-click the document you want to edit and select Edit from the menu.

The Edit Document form will appear. All information of the selected document will be
displayed in this form and ready for you to change except the Name field.

3. Click Save to commit the changes.

4.7.4.8. Export nodes

Nodes can be exported into either .xml or .zip file types.
Procedure 4.33.

1. Select a node that you want to export.

2. Click

f’i,:} Export Node
on the Action bar to show the Export Node form:

|| Export Mode x

Path to Export: fnt

Format: @ pocument view
System view
Zip: |:|
[ Export H Cancel
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Table 4.16.

Path to Export The path of the node being exported. This
field will be prepopulated.

Format The format of the original node.

Document View Each node is a tag and properties of that
node are considered to be elements of that
tag.

System View Each node and each property of that node is
included in a different tag.

Zip If this field is checked, the node will be
exported as a .zip file.

3. Click Export and choose a location to save the exported file.

4.7.4.9. Import Nodes

Nodes that are in the .xml file format can be imported in to the JCR Explorer system.

Procedure 4.34.

1. Select the location that you want to import the new node to.

on the action bar . The Import Node form appears.
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=] Import Node

Upload File: Browse

Version history:

JUID Behaviour:  Create new -

Browse_

Format: @ pocument view

System view

Import H Cancel

3. Click Browse next to the Upload File field and navigate to the file you want to import.

4. Select the UUID from the drop down menu:

Create new
A new UUID will be created for the new node.

Remove existing
The new node will be created in the selected path with the UUID it was exported with.

Replace existing
The imported node will replace the existing node and UUID.

Throw Exception
This option will display an alert informing you if you can not import the file.

5. Click Browse next to the Version history to select a version to import.
6. Select a format.

7. Click Import to import the chosen version of the selected file.

4.7.4.10. Manage Actions

4.7.4.10.1. Add an action

Procedure 4.35.

1. Select the node you want to add an action to.
2. Click

) ;

4, Manage Actions

on the action bar.
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The Manage Actions form will appear.

3. Select the Add Actions tab to open the form to add an action to the folder.

Mﬂ'memﬁu's

Create an Action of Type | oy 5. 3ddMetadataAction I = Il(—- Click

Add/Edit an Action

Id
MName
Lifecycle |User Action
schedule
node_added
node_removed [
property_added |~
Metadata | metadata:siteMetadata = Click
Is deep
ModeTypes [ ].-i-. Q
Description
Aftected NodeTypes [ ]..i.. Q
[ Save H Back l

4. Click

Ea
Rt
a

and select the type of action from the drop-down menu.
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exo:addMetadataAction

exo:autoVersioning Click
exo:createR55FeedAction
exo:enableVersioning
exo:getMailAction

exo:sendMailAction
exo:taxonomyAction
exo:transformBinaryToTextAction

Table 4.17.
exo:action This action is not supported.
exo:AddMetadataAction This action adds metadata
exo:autoVersioning This action automatically adds a version.
exo:createRSSFeedAction This action creates an RSS file.
exo:enableVersioning This action enables versioning.
exo:getMailAction This action fetches mail
exo:sendMailAction This action sends mail.
exo:taxonomy/Action This action creates categories
exo:transformBinaryTo TextAction This action converts .pdf or .doc file types to

plain text.

5. Complete the required fields in the form for the selected action.

Table 4.18.
ID The Id of action. This field is created
automatically and can not be modified.
Name The name of this action. This name is internal
to the JCR explorer.
Lifecycle Select the lifecycle for this action. The action
will be executed depending on the lifecycle:
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6. Click Save to commit the action.

'Add": The action will be executed to a new
document, but not to a subfolder when the
document or the subfolder is created in the
folder in which an action has been added
to. It's also applied to a new document in
the subfolder of the folder.

'Modify": the action will be executed when
a folder /node is modified.

‘User action': The action is executed
when right-clicking on the folder and then
selecting the action.

'Remove": The action will be executed to
a document, but not to a subfolder in the
folder when the document or the subfolder
is moved.

'Schedule': the action is done at specific
time. There are 2 schedule lifecyle
types: period and cron. (See more about
Schedule lifecycle).

If you need the same action to be executed
in several lifecycles, you have to create
several actions.

All actions of a node are listed in the Available Actions tab.

Once an action is added to a node it is automatically added to any child nodes of the selected node.

If an action added with the lifecycle 'user action’, it will be applied for the current node. And an
action added with other lifecyles, it will be applied for the child nodes.

[

Actions in menus

Not all actions are listed in a nodes right-click menu. Some will be performed
immediately when that action is added.
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4.7.4.10.2. View Actions

Procedure 4.36.

1. Open the Manage Actions form and select the Available Actions tab.

2. Click

s

that corresponds to the action you want to view.

The details will be displayed in the Action info tab:

B=| Manage Actions

[b Available Actions " ¥ Add Action l w Action info

Action name GetMail

Is deep true

nodeTypeMame

Lifecyde read

Affected ModeTypes

Protocol pop3

Host

Port

Folder Inbox

User name supporti@exoplatform. com
Description

store-path Users root /Private Mail

Cancel

4.7.4.10.3. Edit an action

Procedure 4.37.

1. Open the Manage Actions form and select the Available Actions tab.
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Manage Actions

lv PETE A ctions " » Add Action " * Action info

MName Description Instance Of Action Type
GetMail [exo:getMail Action]
SendMail [exo:sendMailAction]

Cloze

2. Click the

4

that corresponds to the action you want to modify.

3. Edit the properties in the Actions form:

Edit action

Action form

Id GetMai

Mame  GetMail =

Lifecyde

schedule |
node_added

node_remaoved

property_added =

Protocol ipop3 v

Host
Port

Folder  |nbox

User Name g jpport @exoplatform.com

Password

Is deep
ModeTypes P Q

o e

4. Click Save to commit the changes.

4.7.4.10.4. Delete an action

Procedure 4.38.

1. Openthe Manage Actions form and select the Available Actions tab.

x|
Action
7
7
icon
(x|

m
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=] Manage Actions

lv Available et " » Add Action " » Action info

MName Description Instance Of Action Type
GetMail [exo:getMail Action]
SendMail [exo:sendMailAction]

Cloze

2. Click the

that corresponds to the action you want to modify.

o1

Action

s W

3. Click OK on the confirmation dialog box to delete the action or Cancel to quit.

4.7.4.11. Manage Auditing

This function logs property changes in nodes.
Procedure 4.39.

1. Select a node.
2. Click
"i“g:a. Manage Auditing
on the action bar. The Activate Auditing message appears.

bm| Activate Auditing

Auditing has not been activated for this node

Do you want to activate?

Activate || Cancel

3. Click Activate to activate auditing on the selected node.

icon
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4.

Click
"@13} Manage Auditing

again to view audit information for the selected node.
The Auditing Information list appears.
| Auditing Information X

Operation User name Date Version
Property changed root 03/01/2010 17:11:50 Mo version
Property changed root 03012010 17:12:43 Mo wersion

Version

If the node has no audit information the form will appear like this:
Date

|Bl| Auditing Information
User name

Operation

4.7.4.12. Manage Categories
4.7.4.12.1. Add a category for a node

You can add categories to document type nodes only:

Procedure 4.40. Add a category

Select the node that you want to add a category to

1.
Click

© £2f Manage Categories

on the action bar.

2.

The Add category form appears.
Select the Select category tab to show the available categories

3.
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Add Category @
TRefaEnadcategmies_H - Select category
E
Taxonomy Tree |acme v |
Name Action

by £ wora G
-] world

¢ | Business (/]
@ﬂ Business

-] Technology ¢ | Technology @
®-§ | sports ¢ | sports (/]

4. Click

to add the corresponding category to the node.

Categories that have been added to a node are listed in the Referenced categories tab of the
Add categories form.

All nodes belonging to a category can be viewed by doing the following:

Procedure 4.41. View a category

1. Go to the drive that contains the category you have added. There will be a list of categories
available.

2. Select a category you want. The documents in that category will be listed.
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B @
2 8
1

%
G @ & [ (8

NOCEREERD
:
;

8
:
J

ACME News 4
-.[E] ACME News 4 Sporis
~-§ | Sports Technology
: ElTE[:hmlugy World

4.7.4.12.2. Delete a Category

Procedure 4.42. Delete a category

1. Select a categorized node.
2. Click the

@ Manage Caktegories

icon.
3. Select the Referenced categories tab.

4. Click the

m

that corresponds to the category you want to delete.

4.7.4.13. Show/Hide Content

Nodes can be hidden or revealed as desired.
Procedure 4.43. Hide a Node

1. Select the node you want to hide.
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2. Click
D<}:';>:’ HideShow content

on the Action bar to hide the node.
A message box will appear with a confirmation that the node has been hidden.
3. Show a Node

To reveal a hidden node,
D@:’ Hide'Show content

again.
4.7.4.14. Manage Publications

This function is used to manage node publication.

Procedure 4.44. Manage Publications

1. Select a node (on the left or right panel) which you want to manage the publication.

2. Click

' Manage Publications

on the actions bar.

The Manage Publications form appears:

click
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Manage publication [x] I

« Revision » History

— Revision article-en

- 9 —o0—o0—o—ag

Pending Approved Staged Published

— Scheduled

from to l

Revisions Date Author Status Action
Revision: article-en Dec 7, 2010 4.07:53 PM root Draftfcurrent revision]

The Revision tab displays some basic information and the current state of the selected node.

3. Click

to view the content of the node or click

&,

to restore a version (refer to Section 4.7.4.16, “Manage Versions” for information about
versioning).

4. Select the History tab to view the publication history of the node.

5. Click Save to commit any changes made.

Important

See Section 4.4.3, “Publication Process” to understand more Manage
Publication

4.7.4.15. Manage Relations

You can use this function to create relationships between nodes
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4.7.4.15.1. Add arelation

Procedure 4.45. Add arelation

1. Select the node you want to add a relations to.

2. Click the

Manage Relations

on the action bar.
The Add relation form appears.
3. Select the Select relation tab to see a list of other documents.

4. Click the

@

that corresponds to the document(s) that relate to the document selected in the Step 1.

Documents linked to the original via a relation will be listed in the Relation List tab.

4.7.4.15.2. Delete arelation

Procedure 4.46. Delete a relation

1. Select a node that has links to related documents.

2. Click

Manage Relations

on the action bar.
3. Select the Relation List to view the relations for the selected node.

4. Click

m

corresponding to the relation you want to remove.
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5.

Click OK on the confirmation message to delete the relation.

The related document will be removed from the list.

4.7.4.15.3. View Relations

Procedure 4.47. View Relations

1.

2.

Select a node that has links to related documents.

Click the relation button on the side panel:

Actions

Collaboration

|z Add Folder ‘ |_’4‘ Add Document

Private

=l LELELE RN IS NRE

L TF-
B, document

L

|1:|- |:' exo:thumbnails

@y Favorites
& | Folksonomy
M Music
Pictures
|1| Searches

—.f

}] I

.

All nodes related to the selected node will be displayed in the left pane:
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‘ Languages List \

- &n (Nola Cafe)

- &n (Nola cafe)

- de [New)

- ar (Nola)

- en (Nola - Hanoi)

Relations List

- Best spots in Hanoi .odt

‘ References List \

Mo related document

3. Click the name of the related node to view the document.
4.7.4.16. Manage Versions

4.7.4.16.1. Add versions for nodes

Procedure 4.48. Add version

1. Select a node to add a version to.

2. Click
ﬁ Manage Versions

on the action bar.

The following message box will appear:
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3.

4.

Activate Version x

Versioning has not been activated for this node

Do you want to activate it ?

Activate || Cancel

Click Activate to activate a version for the node.

Right-click the selected node and select ChecklIn from the right menu:
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Private

L [Th
-~ Documents s

-
B0

All Itemd
b Owny

b Fai.q

@ Manage VYersions

5. Click

2

[

| & Add to favorite

R

& | Rename
s Add Sym Link

Download And Allow Edition

| Copy URL to dlipboard

again to open the Version Info window.
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Version Info [x]
[ ~] eXo documents
i Version: 1 (Base Version) | [

The node selected in step one has been added as the Base version.

6. Right-click the node again and select Check out to obtain a version of this node.

4.7.4.16.2. Add and Remove labels for Versions

Procedure 4.49. Add a label

1. Select a versioned node.
2. Click
Manage Yersions
on the action bar.

3. Click the

]

on the Version Info window to show the Add label field under the version list.

Version Info E]
|| eXo documents
i Version: 1 (Base Version) @@
Add Label
Label [ ®
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4. Enter a value into the Label field.
The label must be unique and can not use special characters such as @, #, $.

5. Click Save to submit the new label.
Procedure 4.50. Remove a label

1. Select a versioned node that has at least one label.
2. Click
E_J Manage VYersions
on the action bar.
3. Click the
o |
on the Version Info window to show the Remove label field under the version list.

El Version Info x

| eXo documents

& Version: 1 [Important] [Interesting] [Document] (Base Version) ) @@

Remove Label

Select Label |[important | ™

| Remove || cancel |

4. Select the label you want to remove from the drop down menu:
Remove Label

Select Label Important Bl

Important
Interesting

5. Click the Remove button to remove the selected label.

4.7.4.16.3. View versions

Procedure 4.51.

1. Select a versioned node.
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2. Click
Manage Yersions
3. Click

L®i

to see the current versions of the selected node.

Version Info E3
7] eXo news B

(£ Version: 1 [important] [eXo] [news] [article] v o & O m

&l version: 2 v & O

ﬁ Version: 3 E Es s m

i} Version: 4 (Base Version) w| [0

Lo

-J eXo news
Languages English

= Summary :

Document Management Systems (DMS) Overview

Content :

Document Management Systems (DMS) is the use of a computer system and
software to store, manage and track electronic documents and electronic images of
paper-based information captured through the use of a document scanner. The term
document is defined as "recorded information or an object which can be treated as a
unit". Document Management Systems allow documents to be modified and managed but
typically lack the records retention and disposition functionality for managing records.

4.7.4.16.4. Restore versions

Procedure 4.52.

1. Select a node that has at least two versions stored.
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2. Click

e
E]?J Manage Versions

Version Info
" eXo news
i version: 1 [important] [eXo] [news] [article] vl o & O
@Versinn:l ‘;‘ ED @
@Versiun:?. E‘ ED @
@ Version: 4 (Base Version) -,? @
Close
3. Select the version that you wish to restore as the base version.
4. Click
&,
to restore the selected version
4.7.4.16.5. Delete versions
Procedure 4.53.
1. Select a node with at least two versions:
Version Info
" eXo news
i version: 1 [important] [eXo] [news] [article] vl o & O
@Versinn:l E‘ ED @
@Versiunﬂ Q‘ Ea @
@ Version: 4 (Base Version) -,,? @
Close
2. Click

e
E]?J Manage Yersions
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3. Click the

icon that corresponding to the version you want to delete.
A confirmation message will appear.

4. Click OK to delete the version or Cancel to quit.

@ Base Versions

You cannot delete a base version.

4.7.4.17. Multi Languages

This function is used to support users to add multiple languages for a document. Each document
can be displayed in many languages.

Procedure 4.54.

1. Select a document that you want to add language(s).

2. Click
. #dd/Edit localised contents

on the Action bar.

The Multi-language form will appear.

| Multi language X

» View language + Add language |

Language | engjish(default) Click

[ View ][ Set default H Cancel l

The View language tab contains a list of all languages. The default language for the
document will be automatically populated.

3. Select the Add language tab. This tab will be displayed differently, depending on what file
you selected. However, the area where you can add languages for document is the same.
The below illustration shows the Add language tab for a Sample node file:
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4.

~et defauh

» View language | - Add language

Language |[____

Set default |

Title |sample node

Name |sa.mple-nocle

Description | gne of the best coffeshop in
Hanoi

Date [55/18/2010

Date time [55/21/2010 09:31:39

Upload image

Mime Type [imagelipen

Summary |a funky new cafe that can be a
challenge for some to find.

Content | Tycked away in an alley off the
busy Old Quarter street of Ma
May .This place has great and
reaxing athmosphere te enjoy
coffee with friends.

this area is shown differently,
depends on the filetype.

Select a language you want to add from the Language drop-down list.

If the selected language has not been added for current document, the content field will be

blank.

Lﬂngu&ge|

L
Tt

Tick to

set default

Click

Select the Set default checkbox if you want to set your selected language as default

language.

Click Save, you will be returned to the View languagetab. Your selected language is now

added to the Language field:

You can view this document in the new added language by selecting the language from the

language drop-down list then click the View button.
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To view the languages list of a document, do the following:

Procedure 4.55. View the language list

1. Select a document that you want to view the language list, then click the Relation button
on side panel:

Actions Collaboration

o

gl Add Foider | | 2, Add Document

Private 1 2

O gy W-utiiRag L

@ ., document 4 - @ -
[T o

F_El E ex0:thumbnails i

-y Favorites 3

& | Folksonomy Q

ol Music

T Pictures

-  Searches -]

-

2. The list of language (and all related documents) will be displayed on the left panel:
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18

1

83
& &l @) B

- Best spots in Hanoi .odt

©

References List

Mo related document

You can view the document in the new language by clicking the corresponding link in
Languages List.

For more details about Relations, refer to Section 4.7.4.15.3, “View Relations”.

4.7.4.18. Overload Thumbnails

You can ‘overload' a thumbnail image for a folder. Overloading allows a folder to be represented
by a thumbnail image, rather than a folder icon.

To overload a thumbnail, do the following
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Procedure 4.56. Overload thumbnails

1. Select the folder you wish to overload with a thumbnail image.
2. Click

E Cverload thumbnail

on the Action Bar.

The Add thumbnail image form appears:

| Add thumbnail image b4

Thumbnail image Browse

[ Save H Cancel l

3. Click Browse... button to select the image to use as the display icon for the selected folder.

4. Click Save to commit the change. The node will be stored in an exo:thuumbnails folder.
EO fPictures -

[l Add Folder i Add Document A, Upload [54] Overload thumbnail _@; Add Sym Link A\

[*]

Private a8 2 . ~ -~ -
=8 Pictures
A i . e .
[ 3DArs
| Abstract ] 3D Arts Abstract Avatars City Scene exp:thumbnails

.. Avatars

. City Scene

exo:thumbnails

(. Nature
-- Searches

Videos

>

4.7.4.19. Request Approval

When a content is created, if you want to publish it but you do not have the right to publish the
content, you must send an approval request for your content.

Do the following:

Procedure 4.57. Request Approval

1. Select a content that you want to send an approval request to publish.

2. Click the Request Approval button on the action bar.
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The content is displayed at the bottom of the Content Explorer of the people who have the
right to approve contents.

4.7.4.20. Approve Content

When a content is created by users, it maybe need approved to publish if there is a approval
request. To approve a content, do the following:

Procedure 4.58. Approve a content

1. Select a content that needs approving.

2. Click the Approve Content button on the action bar and the content is ready to be published.

Section 5.2.2.3, “Manage Views”

4.7.4.21. Publish Content

After the content is approved, it can be published by the people who have the permission to publish
contents.

Do the following:

Procedure 4.59. Publish a content

1. Select a content that you want to publish.

2. Click the Publish Content button on the action bar. The content will be published as the
schedule that you set up.
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Section 5.2.2.3, “Manage Views”

4.7.4.22. Show Drives

This function enables you to show or hide all the drives in Content Explorer.

To show drives,

on the action bar.

To hide drives,

on the action bar again.

4.7.4.23. Show JCR Structure

This function allows you to view nodes in documents in a tree structure.

1. Show the JCR structure
Select a document.
2. Select the Info tab.

3. Click

% Show/Hide Like: ICR. Structure

4. Click
iz
icon to save the view.

The following information message will appear:

click

click

the
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||=] Messages x

m
=]

-
]

rror 1% Warning &) Information

'Z'EZ' All changes have been saved

5. Hide the JCR structure
Select a document that is showing the JCR structure.

6. Click

. showHide Like JCR Structure

again.
4.7.4.24. Tag Documents

A tag is a (relevant) keyword or term associated with or assigned to a piece of information (a
picture, a geographic map, a blog entry, a video clip etc.), thus describing the item and enabling
keyword-based classification and search of information.

Procedure 4.60. Add a new tag for a document

1. Select a document that you want to add tags.
2. Click

% Tagging this document

on the Action bar. The Tag Manager will be displayed:
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Tag Manager

Enter tags

¥

Tag names ||

(Use "” separator to add multiple tag)

Tag Scopes | Private

[} click

Linked tags
Click to
add tag

Table 4.19.

Add Tags

| Close |

Fields Details

Tag names

The tag names that users want to add tags
for documents.

Tag Scopes

To classify tags. There are four tag types:
private, public, group, site. Currently, the two
first types are activated(Private: a user who
create tags can view and edit tags; public: all
users can view and edit tags).

Linked tags

To list all tags of a document after you click
the Add Tags button.

3. Input a value for the Tag names field. A document can be added several tags at a time. To

wn

do that, input all tag names in the Tag names field and separate by “,”.

4. Select a value for the Tag Scopes field.

5. Click Add Tags to accept, or Close to quit. Only you can see this tag in this document.

6. Click

to delete tags.

the

Procedure 4.61. Remove tags from a document

1. Select a document with tags that you want to delete the tags.

2. Click

% Tagging this document

on the action bar to open the Tag Manager form.

133



Chapter 4. Basic Actions

corresponding to the tags you want to deletes.

4. Click OK on the confirmation message to delete the tags.

4.7.4.25. Upload files into folders

This function supports you to upload a file from your machine. All file types can be uploaded. The
uploaded file's name must not include some special characters ! @ $ % & +[])

Procedure 4.62. Do the following to upload file into folder:

1. Select the folder that you want to upload a file into from the left/right panel
2. Select the Actions tab to show some actions on the Action bar.
3. Click

4
W | Upload
on the Action bar to open the Upload a file form:

(o= | X

Delete the form to upload
Sehmjﬁaﬁln User Guide en.pdf Delete the

List Taxono T uploaded file

A uploaded file

Open the form to uploa

ME.ITIE[ ] L] +
Browse
Select a file i
Browse... "‘:_a file
List T
ist Taxonomy +*=Add a category

l Save H Cancel

4. Browse and select a file on your computer by clicking the Browse... button. The selected
filename will be displayed in the Select a file field.

If you want to upload multi files at the same time, click

4+

to open more forms to upload more files:
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=] Upload a file X
Mame
Select a file
List Taxonomy +
Mame
Select a file
List Taxonomy +
Mame +
Select a file
List Taxonomy +
[ Save ] [ Cancel ]

The

enables users to delete the upload file form.

You can change the uploaded file by clicking the
icon and select Browse... again to select another one.

By default, the name of the uploaded file will be kept as original but if you want to change,
you can type the new name in the Name field, this field is not required. The new name must
not contain special characters: ! @ $ % & + [ ].

You can click the

.

icon next to the List Taxonomy field to add categories for this file:
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=l
Taxonomy Tree System -
2 MName Action
B oms | calendar L]
-4 | calendar
8. Select categories by clicking the
icon. Click '+ ' to open child nodes of categories.
=] calendar
Taxonomy Tree  System -
Y Mame Action
E Birthday Q
= ] Breakfast ]
EBE Breakfast £ ca @
Fica £] unch ©
# Elunch £ Mo ©
& Bl &l ot ©
& Lrerona £ | professional V]
#-§ | professional — -

9. Complete uploading file by clicking Save.

Section 4.7.4.12, “Manage Categories”
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10. After being saved, the main information of the uploaded file will be displayed:

E| Upload a file x

+ Informaticn
Uploaded file .

. - . Manage
File name Node name File size Mime Type
Metadata
[ eXotemplateodt eXotemplate.odt 1.72 MB application/vnd... P4
Close
11. Click the

w

o

icon to see more details of its external metadata information. The List external metadata
tab will be enable and you can input value in this tab.

E| Upload a file x

¢ Information lv List external metadatas

[ External metadatas

Metadata name Action
@@ deelementSet p

Add metadata || Close |

12. Click Save to accept changes or Cancel to quit without any changes.

13. Data can be added for the uploaded file. Check the checkbox, then click Add, or Cancel to
quit without adding anything.
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El Add External Metadata x

_metadata:siteMetadata

_dc:elementSet

| Add || cancel

14. New metadata is displayed in the External Metadatas list and you also can edit it by clicking
:,}

i

15. Click Close to quit the Uploaded information form.

16. After being uploaded, the tree is displayed in the left panel:
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DMS Administration oo

4.7.4.26. View Metadata

This function allows you to view the metadata attached to File nodes, Podcast nodes, File Plan
child nodes and uploaded file nodes (nt:file nodes)

Procedure 4.63.

1. Select an appropriate (nt:file) node.
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2. Click

ﬂ?‘> Wiew Metadatas

. The View Metadata form appears:

= View Metadata x
» dcielementSet I
DC:ELEMENTSET

M

MfA M/fA

N/fA N/

NfA N/A

N/fA NfA &
NfA N/A

3. Click the Add/Edit button at the bottom of the View Metadata form to add metadata.

4. Complete the desired fields in the Add/Edit Properties form. Click
4

to add further metadata.
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=] Add/Edit Properties

Title

Creator
Subject
Source
Contributor
Resource type

Date

Publisher
Description
Rights
Relation

Farmat

Click Save to commit the new metadata values.

030172010 17:04-44

4.7.4.27. View Node Types

To view detailed information about a node:

Procedure 4.64.

1.

2.

Select a node that you want to view its detailed information.

Click

w > Migw Node Types

to view detailed information about the selected node.

m
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NodeType Infomation

» exo:artice [P exo:modify " b exo:datetime " v exo:owneable " ¥ mix:votable " ¥ mix:commentable

Mame Primary Item MName Parent types Mixin Node Type
o exo:artide MNfA Emix:reﬁarenceable X false
|—_ exoirss-enable
@nt:base

| Node Property Definition

Mame Type Man Pr AC Mul DV
(U0 jeruuid String v true v ttue | v true | X fale
[T exo: text String X false X falke X false X fale
M) exo:summary String X false X falke X false X fale
[T exo:title String v true X falke X false X fale
-H_?“'lja':mixinTypes MName X false v true X false | v true
[FT)jer:primaryType  Name v true ¥ true v true | X fake

Name OPv MAN PR AC

|__ = COPY X fale | X fale X fake

Orderable Children
X false

cv

DNT

. | exo:artice

Close

3. Click the tabs at the top of the form to view categorized information.

4.7.4.28. View Permissions

This function enables an administrator to manage the permissions for nodes.

Procedure 4.65. View Permissions

1. Select a node.

2. Click

™ Yieww Permissions

. The Permissions Management form appears.

142




Actions

EI Permission Management X
User Or Group Read Add Node Set Property Remave Action
root true true true true &
* Jplatform true true true true y 4
[administrators
* Jplatformfusers true true true true y 4
any true falze false falze y 4

Add a permission to that node

User Or Group = |
Read Right

Add Mode Right
Set Property Right

o000

Remaove Right

[ Save H Reset ][ Close l

With the Permissions Management form open you can perform the following actions:
Procedure 4.66. Add Permissions

1. To add permission for specific users
Click the
et
button next to the User Or Group field.

Click the

v
beside the users you want to grant permissions to.

2. To select users from a specific group

Enter a group name in the Group field at the top of the form (for example; /platform/users).
All users in the nominated group will be displayed.

Click the
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icon beside the Group field to open a form that lists groups and their sub-groups. Select a
sub-group to add all users in that sub-group.

| Select Group x
4 platform
Select Group Select Child Group
-~
ﬁ?' ¥ fplatform/users
"B_"' Customers ¥ fplatform/guests
& Organization 3 v jplatform/administrators

E':I.R]. Platform

3. To search for a user

Select an information parameter (User Name, First Name, Last Name,
Email) from the drop down menu in the other field at the top
of the page and enter the information into the text box. Click

]

to search for users that match that information.
4. To add permissions based on memberships

Click the

"
=

icon next to the User Or Group field.

The Select membership form that appears allows you to select users by membership. Select
a group on the left pane and then select membership types on the right.

5. To add all users/groups with read access

Click the

Y
.

icon next to the User Or Group field.

6. Select the permission you want to grant the chosen users or groups by ticking the
corresponding check boxes beside the rights you want to add.
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7. Click Save to commit the changes. The new permissions will appear in the permissions table
above.

Procedure 4.67. Edit Permissions

1. Select the permission of a user or a group in the table of list permissions.

2. Click the
#

icon.
3. Change the permissions as desired.

4. Click Save to commit the changed permissions.
Procedure 4.68. Delete Permissions

1. Select the permission of a user or a group in the table of list permissions.

2. Click the
icon.

3. Click OK in the confirmation message to remove the permission or Cancel to quit.

4.7.4.29. View Properties

This function allows users to review all the properties and values of a node. It can also be used
to add values to a node.

Procedure 4.69.

1. Select the node that you want to review or add values to.

2. Click the
u" Yiew Mode Properties
button to show the Properties Management form:

This form has two tabs:

Properties
This tab displays all properties and values for the selected node.
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i Properties Management x
[~ Properties || » Add New Property | =
Name Multi Value Value Action
[FT) | jcr:primaryType X false nt:unstructured
| [M&l | jer:mixinTypes ¥ true exo:owneable; exo:modify;
exo:datetime; mix:versicnable
[un) | jerruuid X false 0633faeb7f000101003c10d6999a27c5
D exo:dateCreated X false 2000-04-16T17:39:49.459+07:00
L] exo:dateModified ¥ false  2010-04-16T17:39:49.501+07:00
L] exolastModifiedDate ¥ false | 2010-04-16T17:39:49.495+07:00
[ exo:lastModifier ¥ false  root
exp:owner X false root
[E4 | jcr:baseVersion X false 1472ccfa7fo00101006a2649fad36fce
[28) | jerrisCheckedOut % false | true
[P2) | jer:predecessors ¥ true 1472ccfa7f000101006a264%fad36fce
[#Hl | jcr:versionHistory ¥ false 14705087 7f00010101e8302c5831dd06 E|
Select this tab to review the properties for the selected node without making any changes.
Add New Property
This tab contains fields to add new properties to the selected node.
Properties Management X

+ Properties [v Add New Property ‘
Namespace "oy [t} click

Name | New Property |+

T¥Pe | string Click
Mutiple [ ¢ryje Click

S| |*|iif je— Delete value

[ |* @[+ )& Add more values

| save || Reset || cancel |

Select this node if you want to make changes to the properties of the selected node.
3. To add new properties:

Select the namespace for the property.
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8.

Enter a name for the new property in the Name field.

Select a Type for the property from the drop-down menu for the field Type.

Enter a value for the property in the Value.

To add multiple new values,
2l

and repeat the above steps.

To remove a value,

Click Save to commit the new values or Reset to clear any modified fields.

click

click

After you commit new properties, you will be returned to the Properties tab. The newly added
values will be displayed.

=)

Properties Management

« Properties » Add New Property

In

Name Multi Value Value
FT) jerprimaryType X false nt:unstructured
bz jormixinTypes N frue exo:owneable; exo:medify;
exo:datetime; mix:versionable
U] jerzuuid X false 0633faeb7f000101003c10465999a27c5
=7 | Mew Property v true root
E_ exo:dateCreated X false 2010-04-16T17:39:49.499+07:00
E_ exo:dateModified X false 2010-04-16T17:39:49.501+07:00
E_ exo:lastModifiedDate X false 2010-04-19T15:19:24.106+07:00
[C1 | exo:lastModifier % false | root
EX0I0WNEr X false root
Bl jcr:baseVersion X false 1472ccfa7f000101006a26d9Tad36fce
29 | jer:isCheckedOut ¥ false  true
Fc) jcr:predecessors " true 1472ccfa7f000101006a2649%Tad36fce
this form you can edit a property

delete it by

Action

=]

clicking

clicking
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4.7.4.30. View Relations

This function shows documents related to a selected node.

1. To View Relations

Select a node > Click
ﬁ ShowHide Relations

. Documents related to the selected node will be shown in the sidebar.

Relation list
Relation Documents

- Assessment. odt
- Mew Sample Mode

If the node does not have any related documents the message No related document will
appear instead.

Relation list
Relation Documents

Mo related document:

2. To Hide Relations
Click
g;ﬂ Show/Hide Relations

again to hide relations.
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4.7.4.31. Vote

This function is used to vote for a document (Note: you cannot vote for a File Plan document).
Procedure 4.70.

1. Open the document you want to vote for.
2. Click
| Woke for docurment

on the action bar.

The Vote Document form will appear:

H=| Vote Document X

Cancel

3. Rate the document by clicking on the appropriate star level for your vote:

g Vote Document X

>

' Cancel | Best/Click to vote
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After a vote has been added, the rating will appear at the bottom of the document:

Avg. Rating: 4.0 Votes: 1

4.7.4.32. Watch Documents

By using this function, whenever a change is made on the document, there will be a notification
message sent to your email address. To receive that email, you must configure in your mail server.

Procedure 4.71.

1. Select the document you want to watch.

2. The Watching Document form will appear. Click the Watch button to finish.

E| Watching Document x

Motification Type [ Email

Click—>]L_waten | [_cancel |

L]

To stop watching a document, select the document and click

Ko

A message will appear for you to confirm the action.

4.7.5. Manage Content In Content Explorer
A web content is a key resource to make a site. Other resources make a site more dynamic and

animated by using layout, color, font, and more.This section focuses on how to manage a web
content in a specific site.

@ Note

Only users who have the right to access Sites Management drive can do it.

4.7.5.1. Create a new web content

This function is used to add a new web content into a specific site.
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Do the following:

Procedure 4.72. Add new content

1. Go to Sites Management drive > select a site that you want to add a web content.

2. Select the web content folder on the left:

[« o] = sacme Je«—The current site -1 |
Publication Collaboration System
G rwrom | o, e @
e | e Comtne ot S
E'ﬁ Drive [ categories 1020010 10:43 AM
B ess B B2 o 1020110 10:43 AM
&) documents B documents ® 10/20/10 10:43 AM
@Q EELE * ] events 10/20010 10:44 AM
Fg o, @7 5 1020110 10:43 AM
g ks o links 10/20110 10:43 AM
@ (24 medias & medias 10/20110 10:43 AM
12 web contents 10020010 10:43 AM
o ot Setect this folder

3. Open the Add New Document form by clicking

n.hddﬂmmmt

on the Action bar.

4. Select a template in the Select Template field to present web content:
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Select Template [ Free layout webcontent 2
- Main Content H » lllustration H » Advanced
Title [ ln
Name [ ln
Language l en z ]

Main content :Q

El source B M o5 B @ HHEOE

B I U= ===

I
i
"
S
U
&
e
1

Format . Font

The Select Template field has two options:

e Picture on head layout web content:The site's content is presented in two spaces. One
for inserting an image and one for editing the site's content. In which, the image is put at
the head of a site.

« Free layout web content:This template is a free layout.
5. Enter values in fields of the Add New Document form.
6. Click Save as Draft to save the content or Cancel to quit the Add New Document form.
7. Tabs in the Add New Document form

The Main ContentTab includes:

Table 4.20.

Name The name of a web content that you want to
add new

Title The title of a web content

Main content The main content that you want to display
when publishing this web content

Save button To accept saving the inputted values

Cancel button To exit the current form
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The lllustration Tab: enables you to upload an illustration that makes the site's content more
attractive

[p Main Content l. llustration I) Advanced l

& In this panel, you can specify an image that will be shown when your web content is displayed in lists. In addition,
you can specify some summary text to come with this image.

Iustration |  mrraues |
e | Browse... le— Upload an image
SUITHTIERY
E source B I U E EE=E= » & 5}
Size =
Saie
[ Save as Draft [ Close l
Table 4.21.

Field Option

lllustration Image The path to an image that you want to upload
into a site. This image will be used like an
illustration of that site.

Image Type The image format that you want to upload
to the site. It can be: image/qgif; image/png;
image/jpg; image/jpeg.

Summary You can give a short description about the
web content because it will be displayed with
the illustration image when the web content
is listed. The main content will be shown
when it is selected to be viewed.

Do the following to upload an image:
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Procedure 4.73. Upload an image

1. Browse an image list on your local computer by clicking the Browse... button and then
select a specific location.

2. Select an image in the list to upload.
The Advanced tab:

This tab includes two parts: CSS data and JS data:

Select Template IFrEE layout webcontent + ]

+ Main Content H ¢ lllustration l - Advanced

CSS data
& In this panel, you can specify
the main stylesheet for your
web content. This style will
override the one defined at the
site level and at the shared
level.
!
J5 data
& In this panel, you can specify
some Java Script code that can
be executed before your web
content is rendered.
Save as Draft l [ Close l
Table 4.22.
Field Information
CSS data Contains CSS definition to present data in a
web content. You can optionally enter CSS
data into this field to specify the style.
JS data Contains JS content to make the web

content more dynamic when after publishing.
You can optionally enter JS content in this
field.
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4.7.5.2. Edit a web content

This function is used to edit a web content in a specific drive of an existing site.

Do the following:

Procedure 4.74. Edit a web content

Go into the folder of a site which contains the web content that you want to edit.

Select the web content by double-clicking it on the left tree or on the right panel. The detailed
information of web content will be viewed on the right panel.

Click

Edit Document

Lo

on the action bar to show the edit form of the selected web content as the Add New Document
form.

Change the current values in the fields of this edit form.

Complete editing the selected web content by clicking Save.

@ Auto-lock

When you click Edit Document, the web-content will be auto-locked for your
editing. After finishing, the content is back to unlock status. You can manage Locks
in the Administration portlet.

4.7.5.3. Delete a web content

This function is used to remove a web content from the web content folder in a specific site's drive.

To delete a web-content, do the following:

Procedure 4.75. Delete a web content

Right-click the name of the web content that you want to delete and then select Delete in
the drop-down menu:
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EI'_|_ exo Pla—

r_ cec | [ Edit
-fi] defa (] Copy
" dom] 4 Cut

: '_|_ js Delete

I_|_ med ) Lock

I— 2o Fla CheckIn
'_|_ site ark

'_|_ shared

-:ﬂ F.ename

L Add Svm Link

) Download And Allow Edition

2. There will be a confirmation message. Click OK to accept the deletion, or Cancel to quit
without deleting.

4.7.5.4. Publish a web content

This function helps you publish a web content that you have added to web content folder in Content
Explorer.

See Section 4.4.3, “Publication Process” to know how to publish a web content.

After the content is published, all users who have the right to access that position can view the
published web content as a page on the Navigation bar.

4.7.6. Actions on Folders and Documents

In this section, we will present the actions on folders and document in the right-click menu (Add
to favorites, copy, cut, paste, add Symlink, lock/unlock, view document, rename, download and
allow edition and copy URL to clipboard) and other actions (drag and drop folders or documents).
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Depend on the actions on folders or documents, the right-click menu (drop-down menu) is
different.

The actions in the right-click menu for documents:

=" | Documents -
I H ﬁ

Dcﬂﬂ%’}ﬁ i Add to favorite

ﬁ Favori| _J' Copy
i Foksg E Edit

| Y Music 4 cut

Delete

actions

Checkin

b Owned byl =3 add Sym Link

Ifl View Document

F  Favorites
+ Hidden

(L5 Download And Allow Edition
Filter By Type

'] Copy URL to clipboard
» Contents

The actions in the right-click menu for folders:
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uments

EEID exo:th o Mﬂh’nr'ﬁﬂ

i_? Favar 1 opy FG |d er

Folksg
- 4, Cut

- % Music

Picturg
o ™ Lock
[F]-- SEarc

| Rename
o B idens =] RE

| za Add Sym Link
(L5 Download And Allow Edition

Al ltems

F Owned by

r Favorites |E_ Copy URL to clipboard

4.7.6.1. Add to favorites

This function helps users easily add nodes (documents, folders or files) as favorite.

Procedure 4.76.

1. Right-click a node you want to add as a favorite

2. Click
L4 Add to favorite

in the drop-down menu.

A symlink of your favorite nodes (folders, documents, files) will be created in the Favorite folder.

4.7.6.2. Copy/Paste

This function is used to make a copy of a node (including sub-nodes) to other places.

There are two ways to cut/copy/paste the node:

Procedure 4.77. Method One

1. Right-click the node > select Copy from the drop-down menu (or called "the right-click menu").
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2. Select a destination node that you want to be the parent node of the cut/copied node.

3. Right-click the destination node > select Paste in the drop-down menu. Note that the Paste
function is enabled in the menu only after selecting the Copy action.

4. The copied folder (and its sub-folders) will be pasted to the new selected path.
Procedure 4.78. Method Two

1. Right-click the node and select the Copy from the drop-down menu.
2. Select the destination node that you want to be the parent node of the copied node.

3. Select the Clipboard icon on the sidebar:

Frivate == El

™ Documents Ifl

bﬁ Fawvorites

nEEEEs

| Folksonomy

. : :
21 Music bt

EEsmsEEEEEEEE
»

.| MNew Folder .

"

Pictures

EEEmEEsEEEEEEE
n

Searches

- [® Videos

4. Click the Clipboard window will appear:
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Clipboard @Em
Path Cm Act i
=]

fDocuments

i

fexXo-News A

& Clear All

5. Click the

W

in the clipboard window to paste the copied node into the selected destination node in step 3.

6. You can click the

m

to delete a specific waiting statement.

7. You can also click the Clear All link to delete all waiting statements in the list.

After the action has been taken, a confirmation message will appear with detailed information
about the destination path.
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4.7.6.3. Edit documents

To edit a document, refer to this part Section 4.7.5.2, “Edit a web content”.
4.7.6.4. Cut/Paste

This function is used to move a node (include sub nodes) to other places. There are two ways
to cut/paste documents:

Procedure 4.79. Method One

=

Right-click a node > Select Cut from the drop-down menu.
2. Select the destination node that you want to be the parent node of the cut node.

3. Right-click the destination node > select Paste in the drop-down menu. Note that the Paste
function is enabled in the menu only after selecting the Cut action.

4. The cut node (and its sub-nodes) will be pasted to the new selected path.

Procedure 4.80. Method Two

1. Right-click a node > Select Cut from the drop-down menu.
2. Select the destination node that you want to be the parent node of the cut node.

3. Select the Clipboard icon:
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Private oo

ﬂa Favorites
= ety
[ Music

| New Folder

4. Click the Clipboard window will appear:

0 fﬂ@l D
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Clipboard 2

|

£

& Clear All

5. Click the

W

in the clipboard window to paste the copied node into the selected destination node in step 3.

6. You can click the

m

to delete a specific waiting statement.

7. You can also click the Clear All link to delete all waiting statements in the list.

After the action has been taken, a confirmation message will appear with detailed information
about the destination path.
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4.7.6.5. Delete folders and documents

This function helps you remove folders/documents from theirs location easily. Do the same steps
as Section 4.7.5.3, “Delete a web content”

™

4.7.6.6. Drag and drop folders and documents

This function allows you to move folders/documents from a current location to another one by
using the drag and drop feature.

Procedure 4.81.

1. Move the cursor on a folder/document or folders/documents on the right panel (hold the
Ctrl or Shift key to select multiple folders/documents at once) until the cursor changes to

O
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Sites Explorer Newsletter Manager Form Generator Sites Administration

@] « @ 1 /Documents

ﬁmﬂmder E_Mdm:m it upload gmus;mum

Private a8

g"
¥ o
¥ o

L
if| Hawaii.jpg o e Mountainsjog
e

2. Pressthe left mouse button and then drag the selected folder(s)/document(s) to another folder
on either the right or left panes.

Newsletter Manager Form Generator Sites Administration

= |||-||[I]]|,§;a|IZI|(T_-,‘l[ « |© =) /Documents
@Aﬂdmua B,Addnmnm (it | upload (o) Add sym Link
Private EH ﬁqm _
— 2 @
Hawail.jpg ! Hawaii jpg ins.jpg My Pictures
m | Mountains.jpg
- [ MyPictures 2
i? Favorites 0
IF_'II Pictures
E'J“;' Pictures re Y —,
'JEI Vi |
Hawaii.jpg Mountains.jpg My Pictures

3. Drop them into the selected folder (by releasing the left mouse button). All 'dragged' folders/
documents will be relocated to the destination folder.

4.7.6.7. Lock/Unlock folders and Documents

This function enables you to avoid changes to specific folders/documents, actioned by others,
during a specific time.

Lock folders/documents. Just right-click a folder/document (on either the right or left window
pane) and select Lock from the menu. The selected folder/document will be locked.
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™

Unlock folders/documents. To unlock a folder/document, right-click a locked folder/document
and select the Unlock item on the menu. The folder/document will then be unlocked and other
users can take actions on it.

4.7.6.8. Rename folders and Documents

This function is used to change the name of a folder/documents.

Procedure 4.82.

1. Right-click a folder/document that you want to rename then select Rename from the menu:
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Private oo

I o

5"z Fa g Add to favorite

All Items

+ Owned
v Favoril |5 | Copy URL to clipboard

The rename form will appear:

Download And Allow Edition
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EI Rename x

Name Documents *

Title Documents *

[ Save ][ Cancel

2. Input a new name in the Name field. You can also change the title of this folder by entering
a new one in the Title field.

3. Click Save to commit the new details.

4.7.6.9. Add a symlink

For the purpose of fast accessing the node that you want to look for in other nodes, adding a
symlink for a node is an effective way to meet this need.

Procedure 4.83.

1. Select a document that you want to add a symlink.
2. Right-click that document and select Add SymLink from the menu.

3. The selected document will be added a symlink immediately. You now can click the symlink
to view its content.

4.7.6.10. View WebDAV

WebDAYV enables people to access files, folders and read and write documents over the web.
Due to its benefits of easy, quick and flexible manipulations and time saving, WebDAV is used
to view nodes.

Procedure 4.84.

1. Selectthe path of node you want to view webDAV or open that folder from the left/right panel.
2. Right-click the node and select the Download and Allow Edition item in the menu.

3. With each type of node, form to view in WebDAV will be different:

» Folder: The sub-nodes list of the current folder will be displayed in WebDAV.

« nt:file: The content of the document will be shown.
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« Article: This node type does not, by default, list any folders. However, if the Article includes

actions, added language or other data, all folders will be listed and named; exo:actions,
exo:language and so on.

« Podcast: Viewed in WebDAV, this node type will be attached a form that users have to
complete to download this document.

« Sample node: This node lists folder names as exo:images. Like Article, if the Sample node
contains actions or added languages, folders will be named exo:actions, exo:language and

SO on.

< File Plan: This node behaves the same way as Article and Sample node.

Kofax: This node behaves the same way as Article and Sample node

4.7.6.11. View Document

The View Document item is visible in the drop-menu when you right-click a document. This

function enables you to view the document on another tab with the link containing the document
path.

Do the following to view a document.
Procedure 4.85. View a document

* Right-click a document that you want to view > Select View Document in the drop menu.

The document is opened in another browser:
ZO *) IUser guide -
Admin Info Actions Collaboration

<03 Manage Versions &+ Manage Publications i1 é: Manage Categories Manage Relations P4 Manage Actions /{} Export Node
i A

Private

)

|| exo:thumbnails

A =
It =
= . 4 -
@y Favorites User guide . ?
= —,
- (| Folksonomy = —

| Y Music * Summary :
Pictures o,
(a1,

== Searches summary

e User guide

Content :
B Videos
..l workspacelist.ong E] content
v
All tems " . )
@ Links : workspacelist png

+  Owned by me

+ Favorites (& Attachments :

b e & workspaces.png

Filter By Type
+ Contents .
Avg. Rating: 0.0 Votes: 0

¢ Documents

» Images

+ Music

» Video
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The URL of the document is like the following:

URL: ...ecmdemol/private/acme/siteExplorer/repository/Private/User guide

4.7.6.12. Copy URL to Clipboard

The Copy URL to Clipboard enables you to copy the Webdav URL of a selected folder or a

document and then you can view it by WebDAW view on a browser.

Do the following:

Procedure 4.86. Copy URL to Clipboard

1. Right-click a folder/document > Select Copy URL to Clipboard.

Private Right—clic‘g: = + Name

E| ™ | document

b |

[—] . document

D exo thumbnails

- '?':_? Favorites

- il Folksonomy

; Music
_ Pictures

-~ Searches

Liser guide

Bl s

All ltems

r Owned by me

2. Paste the URL on another browser.

- Remowve from favorite

"] Copy

.:ﬂ Rename
[aa) Add Sym Link=l1CK
=] Dmunlu&dﬁ.nd*uw Edition

=] Copy URL to clipboard I

e v (& iy [@[http:/’/localhost:SOBO/e(mdemo/rest—e(mdemo/j(r}repository,f(ollaboration/Users/root/Private/FavoritesI

~

|MGmail-Docreview-bonk... x| Overview

Z]q— Up to the root node
[E Documents]«— current node

b | Content Explorer

WebDAV URL of the node

2 | [Z] WEBDAV Browser

You can view the folders of the node you copied its URL or download documents to your
computer. You also view other nodes by clicking ... above the current folder to go up the root

node . See the below illustration:
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o vy & @ © [@|http://localhost:SOBO/ecmdemofrest—ecmdemo/jcr_frepository,’collaboratioMUsers/rootjPrivate |
X
 Overview 3¢ I(" Content Explorer *‘ | [#] WEBDAV Browser 3 | +
[£ J— PRoot node
-/ Documents WebDAV URL of the node

L Favorites
I Folksonomy
) Music le— Folders
I Pictures
I Searches
“ I Videos

4.7.6.13. Manage Tags

Tags are easily managed by editing or deleting them with the Tag Manager.
Procedure 4.87. Edit a tag

1. Click the

£

icon at the upper-right corner of the tags panel.

Private tags

Click £t

user guide dms wcm

Public tags | O

cooking user guide
TEQ Cloud

All tems ¥ ':k'

The Edit tag form will appear:
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| Edit tag form |Z| |
i MName Action |
eXo s m
hot s m
trend s W
2. Click the
that corresponds to the tag you want to edit.
3. Edit the tag as desired.
Tag form B3
Tag name  good =
[ Save ] [ Cancel
4. Click Save button to commit the change or Cancel to quit without changes.
Procedure 4.88. Delete a tag
1. Perform Step 1 from the procedure above.
2. Click the

m

A confirmation box will appear:

The page at http://localhost:B080 says:

e Are you sure want to delete?

‘@Eancel| l o OK J

Click OK button to delete the tag or Cancel to quit.
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Procedure 4.89. Use Created tags

1. Select the Tag cloud

*

2

you will see all existing tags. All existing tags are listed and classified by private or public tags.

Private tags .
% Click it

user guide dms wcm —

Public tags - 4

cooking user guide

T:_ar._:; Cloud
Q

All kems )

Depending on the popularity of tag, the displaying of each tag will be different from others by:
font-size, font-weight, color, font-family, text-decoration. For example, when a tag is added
for over 10 documents, it will be displayed in red color, size:20px, bold. This is also can be
configured in the Administration portlet.

2. Eachtagisalso like alink used list all documents that it is added. Click a tag name, documents
list will be displayed in the right panel.

4.8. Manage Content with WebDAV

4.8.1. What is WebDAV?

WebDAYV is an abbreviation of Web-based Distributed Authoring and Versioning. It is used to
publish and manage files and directories on a remote server. It also enables users to perform
these functions on a website.

WebDAYV provides the following features:
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Locking
This feature prevents two or more collaborators from overwriting shared files.

Site Manipulation
WebDAV supports copy and move actions and the creation of collections (file system
directories)

Name space management
This function enables copying and moving web pages within a server's namespace.

4.8.2. Why use WebDAV?

With WebDAYV, you can manage content efficiently with the following actions:

» Copy/paste content on your device and have those changes reflected in a host-based website.

« Easily, quickly and flexibly manipulate actions on a website without having to access it directly
with web-browsers. Files can be accessed from anywhere and are stored as in local directories.

« Easily and quickly upload content to a website simply by copying it into the appropriate directory.

4.8.3. How to Use WebDAV With eXo Content

To use WebDAV with eXo Content, you first need to have the Internet or Intranet connected. Next,
you can follow one of the two following ways:

Procedure 4.90. Method One:

With this method, you will need to connect to the WebDAYV server. For example, for Windows XP,
do the following steps:

1. Navigate to the My Network Places on your local computer. You will see all shared files
and folders:

T My Network Places

\_/n Eack J l} /":]Sear:h [1_ Folders v

Address g My Network Places v| Go

Network Tasks
» eXo on eXoServer server

‘,_2 Add a network place
(Samba, Ubuntu) (Exoserver)

ﬂH View network
connections

Q Setup a home or small
office network

‘;’f, Setup a wireless
network for a home ar
small office

g View workgroup

computers

Chang trai vuon nho on Mga exo-tomcat on Tandung

'.\/'

Ly

maven-proxy on eXoServer

server (Samba, Ubuntu) (... music on Nga

Film on Nga

Musics on Duytu Public on Duytu Share on Hoanghm

B ‘
B

LRCLY

@ Show icons for
networked UPnP The Internet
devices

€Xo on exoServer server

Other Places (5amba, Ubuntu) {192....

@ Desktop

a My Computer

ﬂ My Documents =
[ Shared Documents

C2y Printers and Faxes

e

Unspecified

192,168, 1. 10eXo on eXoServer
server (Samba, Ubuntu) (132...

Tools  Help a.

<
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2. Click the Add a network place link on the left to open the Add Network Place Wizard:

Add Network Place Wizard

Welcome to the Add Network Place
Wizard

pictures using only a8 'Web browser and Internet connechon.

You can also use this wzard fo create a shortout to a \Web ste, an FTF site,
ar other network locaton.

To continue, chick Mexd.

L___[__J_EH |[ Cance

3. Click Next to choose a network location:
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Add Network Place Wizard

Wwhere do you want to create this network place?

Select a senace prowader. If you do not have a membership with the provider you s=lect, the wzard will help
you create an account. To just create a shordcut, chck "Choose another network location.”

Sarvnce providers:

v MSH Communities
Share your fles with others & them f

hm;»& another network bc-.atqn

the address of a Web site, network location, or FTF site

< Back |uext: ]l Cancel

Select Choose another network location to create a shortcut.

Enter an address into the Internet or network address field; for example, the address of
the demonstration site Acme is http://localhost:8080/portal/rest/private/jcr/repository/
collaboration/sites/content/live/acme

Click Next. After a few moments, a folder named acme on localhost appears in the My
Network Places directory.
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;- My Network Places

File Edit WView Favorites Tools

l} pSearch H-_i‘ Folders v

@ Back - -\;:)

Help

9(=1E3
[

Address ‘a My Metwork Places

Network Tasks

@ Addanetwork place

e_; View network connections

Q Setup a home or small
office network

;;J, Setup a wireless network
for a home or small office

Q‘f’ View workgroup computers

@ Hide icons for netwarked
UPnP devices

Other Places

@ Desktop

W My Computer

E:j My Documents
[3) Shared Documents
3 Printers and Faxes

Details

10 ohjects

v|Go

Local Network

t

“
-

acme on localhost

== i
"

B 4 ﬁ*‘
e

Chang trai vuon nho on Nga

t

~
)

test on localhost

3

classic on localhost

~
i
)

WRTS4G

" it

The Internet

X0 on eXoServer server
{Samba, Ubuntu) {192....

&

7

.". acme on localhost (2)

B

Musics on duytu

Tinh yeu ngot ngao on Nga

e,

live on local
htip: flocalhost: 8080 fportal frest/private fjor frepe

3

Each site managed by WebDAV appears as a folder in this location.

7. Take actions on the content in this folder to administrate the site content remotely.

Procedure 4.91. Method Two:

This method can be done through Sites Management:

1. Navigate to http://localhost:8080/portal in your web browser.

2. Click Group > Content Explorer in the administration bar.

3. Click the Drives button > select Sites Management.
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[LUACHISTVEYE  Newsletters  Form Builder  Administration
=|im[m| & @ 3 /Documents

Admin Info

Actions

@ Manage Versions I E Manage Relations I X Manage Actions [ @V\ew Node Properties [ @ Export Node I @ Import Node [

[-]

Private

™| Documents
il? Favorites

| ﬁ Folksanamy
: & Music
L) Pictures
M':J Searches

: ul] Videos

All ltems
» Owned by me
+ Favorites
+ Hidden

Filter By Type
Contents
Documents
Images

-

-

*

-

Music
Video

*

IR

» GENERAL DRIVES

3
E" acme

IEj; Evenis

IE,'j; Shared Users Space

» GROUP DRIVES
@ lorganization /

management /
executive-board

* PERSONAL DRIVES

% Private

g :
l@ classic

lEjJ Sites Management

@ Trash

@ 1 platfarm / administrators

éﬂ Public

You will see all sites listed in the left sidebar:

@ collaboration

@ Shared Groups Space

@ I platform / users

3 DMS Administration

@J‘ Shared Site

@ I platform /

web-contributors
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Sites Management

% ——

&
¥
;
;

T
; 3

P & & [ g

4. Right-click the site you want to view with WebDAV and select the Download and Allow
Edition item in the menu.
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Newsletter Manager  Form Generator  Sites Administration

Sites Explorer

[E@J | Jacmejweb contents

Publication Collaboration  System

i, Upload

* Document title
= site artifacts
Success Defines As S-U-C-CE-5-5

[E]

[ web contents
--5 site artifacts

: Success Defines AH

@ da =

@ ex

2 & Bl

& Add to favourite
@ Copy
ah Cut
m Delete
b Owned 5 Lock
» Favorit] Rename
¥ Hidden
[ Add Sym Link
Download And Allow Edition

B Copy URL to dipboard

All Ttems

By Type

» Music

Docum
Contents
Images
Video

- v v ¥

The selected site will be shown in WebDAV:

[T WEBDAV Browser - Mozila

- Q,
}f::
Created date Author Status
3/3/10 3:50 PM
3f8/10 10:21 AM root draft

File Edit View History Bookmarks Tools Help

Vi N \
th_" c X Q l:u http:fflocaIhost:8080!ecmdemofrest-ecmdemo,ﬂcrfrepositoryfcolIaboratiom‘sitesconﬁ " |Y!' Yahoo P|

£ Most Visited || Getting Started = Latest Headlines ) Login *§ Résultats Google Rech...

| ¥ System Dashbo.. x | 1] Gmail - Inbox (.. x | *f Google Translate x | ¥ Fashion - Wom... x | | | Sites Explorer

% | || WEBDAVEro... x | = |-

e |

) ApplicationData
| categories
css

' documents
s

L links

= medias

= web contents

I Done

In this view, you can access documents in the directories that are linked to the web server.

4.8.4. Actions

You see all default folders of a site when accessing it via WebDAV. Manipulating content through
WebDAV is the same as working on it in local folders.

This means you can copy/paste files, list folders, rename, and more in system directories.
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4.8.4.1. Add new content to a specific site

This function enables you to copy web content (such as an .html file) from your local computer
to a web content folder of a site.

Procedure 4.92.

1. Access a site via WebDAV (refer to Section 4.8.3, “How to Use WebDAV With eXo Content”),
then go to a web content folder of the site.

2. Copy the web content on your local system into this folder.

The copied file will be converted to web content that is viewable by WebDAV automatically.
The content is converted to a directory containing CSS, documents, js and media.

After a new content is added, it can be viewed as a folder in WebDAV or as a page content using
a web browser.

4.8.4.2. Delete a web content

This function enables site administrators to delete web content files seperately or in batches.

Procedure 4.93.

1. Navigate to the folder that contains the content you want to remove.

2. Right-click the content files or directories (hold the Ctrl key to select multiple files at once)
and select Delete from the context menu.
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bai-Unbreak-my-heart. himl

laura-pausini-it-5-
1 site artifacts
_1Word-to-000, hirr

Explore

Send To

Cut
Copy

Create Shortout

= =

Properties

The selected file(s) will be removed from the site.

4.9. Search in Content Explorer

There are three ways to search an existing node:

1. Section 4.9.1, “Simple Search”.
2. Section 4.9.2, “Advanced Search”.

3. Section 4.9.3, “Quick Search”

4.9.1. Simple Search

With the simple search, you can directly type a search term in the search field. All documents,
whose keywords are matched with the search term, are retrieved and listed in the Search results
form.

Procedure 4.94.

1. Enter a search string into the search text box.
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2. Click the
|
icon to perform the search.
Search results will be displayed in the right pane.
. i Enter search term
Content Explorer
Clo) =/ - Jexo ©
Publication Collaboration System SeaTrch
[l AcdForter | | 2 Add Document | A, upload | Seard]" [EEUTE
Sites Management e & Type Name Score Action 7l
@5 acme = = defautthtmi 315 T
== classic 7 Path: jsites contentlive/acmeiweb contents/site artifacts/Footer/default.html
&/ T = Date created: 8/21/09 1:09 AM
e = defaulthtml 318 q
Path: /sites contentlive/classiciveb contents/site artifacts/CommunityMembers
O\ Idefault.html 3
Date created: 10/12/10 2:51 PM
= defaulthtml 441 q
Path: fsites contentlive/classiciveb contents/site artifacts/introduce/default.html
v Date created: 8/20/09 1:34 DI
The search results are empty if no document contains the search string.
Tvpe Marme Score Ackion
N rasut found!
3. Click the
to view the content containing the search string.
Or click the
icon to go to the node that contains the search result.
4.9.2. Advanced Search
To perform an advanced search:
Procedure 4.95.
1. Click the

Q

Saved Search icon.
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Saved Searches Ly
All Articles

Created Documents
CreatedDocumentDay Before
allArticles

- v v v

All tems
+ Owned by me

=

b Favortes g ayed Searches

» Hidden

2. Then click the Advanced Search
Y
-4,

to open the Advanced Search form.

icon

Saved Searches © 5 [ ——— Adva’nced Search form [x]
» All Articles
. CreateancumentzC"ck ﬁ ~ Search by Name [b Advanced Search " b New Query " » Saved Query ” » Search Results
» CreatedDocumentDayBefore % Search on this location: /sites content/live
+ allArticles
Content
— Fe. ontent name [ ]‘
All ltems 104
e
+  Owned by me
» Favorites
+  Hidden

The Advanced Search form will open:
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Advanced Search X

« Search by Name l ¥ Advanced Search " ¥ MNew Query " b Saved Query " b Search Results

Search on this location: Usersfroot

Content name ®

Search H Cancel

The tabs in this form offer different search functions:

Section 4.9.2.1, “Search by Name”

Section 4.9.2.2, “Search with constraints”

Section 4.9.2.3, “Search by creating a new query”

Section 4.9.2.4, “Search by existing queries”

4.9.2.1. Search by Name

Use the Search by Name tab to search nodes by name:
Procedure 4.96.

1. Enter the exact name you wish to search in the Content name field.
2. Click Search.

Results will return with the message “No result found” if there is no node with the entered
name.

Results will be returned in the Search Results tab if the requested name is found.
4.9.2.2. Search with constraints

This search enables you to search with more constraints to limit the returned results.

Extra search constraints are entered in the Advanced Search tab of the Advanced Search form.

» Search by Name Iv Advanced Search " » New Query " r Saved Query " » Search Results ]

Current location J/sites contentiive

A word or ph i
word or phrase in | |le— Enter Key words
Operator [ 5ng Click
More constraints Se*a rch
[ Show/hide constraint form “ Search I[ Save H Cancel ]
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The Current location field is not editable. It shows the path selected to search.

Procedure 4.97.

1. Enter search terms in the A word of phrase in content field.
2. Select the Operator.
« Select AND operator to only return results that meet both the search terms and the entered
constraints (see Step 3).

« Select OR operator to return results that meet either the search terms or the entered
constraints (see Step 3).

3. Click Show/hide constraints form to add more constraints.

A further constraint options window will appear:

Operator : and -+ 1

[C]Property: Cumﬁin Exactly : 2
[“|Property : Cnniﬁin : 3
[C]Property : Nut Contain: 4

[[] CREATED - From To 5
DDDEumentTypE : ' 6
. i Fi
[| category : L
[ Add ] [ Canicel
Table 4.23.
1 You can add more than one constrainwith

either of two operators (AND and OR).

2 These fields allow you to add a constraint to
search by a property with specific values.

3 These fields allow you to add a constraint to
search by a property that contains one of the
word in the specific string.
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Iltem Details

4 These fields allow you to add a constraint to
search by a property that does not contain
the specific string.

5 These fields allow you to add a constraint
to search by a duration of date (created,
modified).

6 This field allows you to add a constraint to

search by a document type, including File,
Article, Podcast, Sample node, File Plan,
Kofax).

7 This field allows you to add a constraint to
search by categories.

Add a document type.

i

i Eﬂﬂ Add a category.
=

Select the constraint operator(AND/OR).

Add the required constraints using one of the following methods:

1. Add a constraint for exact values

2. Add a constraint including or excluding values
3. Add a constraint by date

4. Add a constraint by document type

5. Add a constraint by category
Procedure 4.98. Add a constraint for exact values

1. Check the box that corresponds to the constraint you want.

2. Enter the property you want to locate or click the Add property icon
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COperator : and -

[T Property:

[ Property :

[ Property :

[7] CREATED = From
[ Document Type :

|:| Category :

nn13in Exactly :
Coniﬁin :
Not Contain:

A list of possible properties appears:

Select property

Metadata Type

@ deidate

) dcoreator
! dcicoverage
I dcisubject
I dcrpublisher
! dciidentifier
I dcerights
I dcrsource
! dr:description
! dcirelation
' doiformat
! dotitle
! dcilanguage

! doiresourceType

! deoycontributaor

Ta
19
[ Add ][ Cancel
dc:element Set

[ Add H Cancel
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Select a property from the list and click Add. The selected property will populate Property
field.

Define the property value to search for by entering a value
into the Contain exactly field or click the Find exactly icon:

Operator : and -

[#]Property: dc:subject Comain Exactly :
|:|F‘m|:n.='_rt5-I : Comain :

|:| Property : Not Contain:

&

[[] CREATED = From To
[ Document Type - @
[ category : '-_14-
| add || cancel

The Filter form will appear:

Filter form

Filter |

Results | system guide document
uploaded image

Select H Zancel

All pre-existing values for the property you selected will appear.
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« If the value you require is in the list, select it and click Select.

 If the value you require is not in the list, enter it in the Filter: field and click

®

icon. The value will populate the Contain exactly field of the constraints form.

Operator : | and |+

Property @ |de:title
D Property :
D Property .

]| CREATED v

D Document Type :

D Category

Procedure 4.99. Add a constraint including or excluding values

From

”fv> Contain Exactly : |uploaded image

#f;;-> Contain :

«{L-> Mot Contain:

197

To

[ Add ][ Cancel

®

1. Check the box corresponding to the Contain or Not Contain constraint, as appropriate.

®

(refer to Step 2 in Add a constraint for exact values for more information).

Procedure 4.100. Add a constraint by date

Enter the required values in the Contain or Not Contain fields.

Enter the required property in the Property field or click the Add Property icon

1. Click the check box beside the field with the drop-down menu (below the Property

entries).

3. Click in the From field.

Define the search condition from the drop-down list (CREATED/MODIFIED).
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A small calendar will appear;

Operator : and -

[]Property: dersubject -’_’;"‘>Contain Exactly : ’ﬁ)>
|:|F‘r|:||:|erty : -’:“3)>Contain :
|:| Property : -’:“3)>Not Contain:

[[] CREATED = Fr

4 - 2010 2
|:| Document Type : 5 M T W T E g
3 4 5 5]

DCategu:ury:
7 8 9 10 11 12 13

14 15 16 17 18 19 20 C]
21 22 23 24 25 26 27
28 29 30 31

Select the date you want to use as a contraint.

4. Repeat the above steps for the To field.

The selected dates will populate the From and To fields in the Add constraint form.

Procedure 4.101. Add a constraint by document type

1. Click the checkbox beside the Document Type field.
2. Enter the document type you want to search for or click the

-

icon to open a list of document types:
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@ Select node type

nt:file

exo:article

exo:podcast

exo:sampie

rma: filePlan

kfx:document

exo:htmiFile

exo:cssFile

exo:jsFile

exo:siteSearchBox
exo:picture0nHeadVWebcontent
exo:webContent
exoisiteMavigationVVebContent
exo:siteBreadcrumb

exolink

B 0 R B O R e . . O R T B T

3. Click the checkbox of the document type you want and click Save.

The selected document type will populate the Document Type field.
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Operator : and -

[¥]Property: dc:title {?V>Contain Exactly : uploadedimage "’fv>
[ Property : &> Contain :

D Property : <?’>Nu:ut Contain:

[[] CREATED ~ From 03/01/2010 To 03/15/2010

[V Document Type : ntfile,exoarticle, exopoc @

[ category : il =H

[ Add ][ Cancel

Procedure 4.102. Add a constraint by category

1. Click the checkbox beside the Category field.
2. Enter the category you want to search for or click the
icon for a list of categories:

B=| Add category to search

I » UIOneTaxonomySelector

Taxonomy Tree  System -

P MName Action
0 §_I Cms @
@4 | Cms ;

i g_l Calendar @‘

§_| Calendar

Close

3. Click the
that corresponds to the category you want.

The selected category will populate the Category field.
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Operator : and -

[¥] Property: dc:title ’_fv>Cuntain Exactly : uploadedimage ’fv>
[T Property : ’.’“3)>Contain :

D Property : /_:‘)>Nu:ut Contain:

[l CREATED - From (3/01/2010 To 03/15/2010

[V Document Type : ntfile,exoarticle, exopoc @

[ category : il =H

[ Add ][ Cancel

6. Click Add to add any/all activated constraints.

The constraints will be converted to an SQL query and displayed in the search form:

Current location  fDocuments)Live

f word or phrase in | pegy

conkent
Qperatar | gnd w
et garials {@dc:title = 'uploaded image' )

and {{documents created from '03)11/2003" and {documents
created bo '03726/2008% )

and {@ijcr:primaryType = 'nk:file’ or @jcr: primaryType =
‘exorarkicle’ or @jcr:primary Type = ‘exo:podcast’ )

[ Showefhide constraint form ][ Search ][ Save ][ Cancel ]
Remove unnecessary constraints with the
icon.

7. Click Search to launch the search. Results will be displayed in the Search Results tab.

8. Click Save and put a name for this search configuration if you want to save it to use at another
time.

4.9.2.3. Search by creating a new query

You need a knowledge of the structure of query statements in order to configure a search using
the parameters on the New Query tab
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Procedure 4.103.

1. Enter a unique name for this query in the Name field.

2. Choose a query type from the drop-down menu; SQL or xPath.

3. Enter a query statement.

4. Click Search to perform the search and display the results in the Search Results tab.

Or click Save to save the search query to the Saved Query tab.

Or click Cancel to quit.

4.9.2.4. Search by existing queries

This tab lists all saved search queries (that you have access rights to use).

5| Advanced Search

¥ Search by Mame [+ Advanced search | » mew Query |

MName

All Articles wpath

Created Documents xpath

CreatedDocumentDayE  xpath

allartides wpath

 Click

L2

to perform the search and see the results in the Search Results tab.

 Click
:",‘a

Type

- Saved Query
Statement Permissions
...de) order by * [platformfusers
@exo:dateCreated
descending

.8 = 'exoartide’ or
@jcr:primaryType =
‘nt:file’) and
@exo:owner ="S{Userl
order by
@exo:dateCrested

descending

...de)
[@exo:dateCreated <«
ws:dateTime(${Date} s’
order by
@exo:dateCreated

descending

[felement(®,

exo:artice)

= fplatformfusers

* [platformfusers

root

v Search Results |

Actions

i

m

i

iy
El
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to edit the query statement. The query form will appear like when creating a query (see
Section 4.9.2.3, “Search by creating a new query”); however, you cannot edit the name of the

saved search.

* Click
to delete a query (provided you have the access rights to that query).

4.9.3. Quick Search

Do the following to perform a quick search:
Procedure 4.104.

1. Click

ol

icon to see the list of existing queries.

Saved Searches L)

+ Al Articles

» Created Documents

¢  CreatedDocumentDayBefore
¥ allArticles

All tems

¥ Owned by me

the

b Favortes  gaved Searches

» Hidden
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A query list will appear. It contains the sections, including All Articles, Created Documents,
CreatedDocumentDayBefore and allArticles.

Publication Collaboration System

| Add Folder 2 Add Document W' Upload

Saved Searches Q 8 — N —" acton [~]
b All Atticles = ; User guide 283 a
p Craated Dooyments Path: iUsers/root/Private/User guide
» CreatedDocumentDayBefore | | [, Date created: 12/8/10 9:18 AM
»  alArticles
= 25 uer guide 283 |j
All tems s Path: /Trashfuer guide L
» Owned by me /@ Date created: 12/8/10 9:07 AM
b Rtz Saved Searches E test 283 a
» Hidden Path: /Users/root/Private/Documentitest
Filter By Type Date created: 12/8/10 9:02 AM
+ Contents 4 ; article-1 283 a
b DrEnrErs Path: /sites i ficke 1 m
D CrzTes Date created: 12/3/10 9:58 AM
» Music
b Video E XSEXXA 283 @
Path: isites 0 Xa

Date created: 12/3/10 9:56 AM

2. Launch, modify or delete the queries as required (see Section 4.9.2.3, “Search by creating
a new query” for more information).

3. Filter results with the entries in the All Items and/or By Type panes on the left of the tab.
Items matching the selections will appear in the right pane.

4. Click the required document or folder name to view or download them.

4.10. Preferences

This function is used to set up your browsing preferences.

Procedure 4.105.

1. Click

L

on the right side of the Content Explorer portlet.

The Preference Setting window will appear:

197



Chapter 4. Basic Actions

Preferences x
Sort by | Alphabetic ¢ | |Ascending ¢ |
Show Sidebar ] Enable Drag & Drop ]
MNodes Per Page | 20! 2 |
— Advanced
Show “non document™ nodes ] Show referenced documents O
Show hidden nodes O Enable DMS Structure O
Query Type | SOL o |
| save || Ciose |
Table 4.24.
Setting Details
Sort by To sort nodes in the nodes list by Alphabetic,
Type, Created Date, or Modified Date
Show sidebar To display/hide the sidebar.
Enable drag and drop To enable/disable the “drag and drop” action.
Nodes per page This number of nodes that will be displayed
per page.
Show non document nodes To display/hide nodes that are non-—
documents.
Show referenced documents To display/hide referenced documents.
Show hidden nodes To display/hide hidden nodes.
Query Type This query type.
Enable DMS structure. To display/hide nodes in a document in tree
structure.

2. Configure the preferences as required and click Save to set them.

Or click Back to quit without submitting changes.

4.11. Newsletters

eXo Content provides a newsletter service aiming at helping users quickly get the updated
newsletters from a website.
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4.11.1. Newsletter Viewer

With Newsletters, you can instantly get newsletters from your email to update the last information
about categories and subscriptions.

Do the following to subscribe to newsletters from eXo Service:

1. Goto Newsletters on the navigation bar. The Newsletters page will appear:

Ovenview News Events @ Contact Us

NEWSLETTERS

/

Your Email [

1| marketing You want 1o know where we are, where we go ?

Subscription Check to subscribe

The market D

What's on the market ioday ?

da O
General General informasion about us
Subscription Check to subscribe
Results D

Monihly newsletier shout our restiis and fovecasts
Check-List |

Wieekly newsletier with general Iopics

2. Enter your email address in the Your Email field.

3. Select the checkbox corresponding to the subscription that you want to get newsletters.
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=] Messages

&) Information

o
O
T |

IZIEZ' You are now subscribed to the selected newletters.

Click Subscribe. A message informing that you have just subscribed to the selected
newsletter will appear.

Click OK in the confirmation message. You can reselect the subscription that you want or
do not want to receive newsletters by re-selecting the checkbox in the Check to subscribe
column.

200



Manage Newsletters

Oweniew News Evenis @ ContactUs

e

Your Emal  hoavuexoplatform.com [ Forget this email ]
| | Marketing Youwant o knowwihere we are, where we go 7
The market

What's on the market ioday ?

da

| |  Generl General information about us

Results

check-List
Weekly newsletier with geneval Iopics

Subscription

Subscription

I Change your suboripsions ]

6. Click Change your subscriptions to update your changes.

7. Click Forget this email if you want to unsubscribe from newsletters.

4.11.2. Manage Newsletters

Check to subscribe

O

Check to subscribe

O

O

eXo Content facilitates administrators to easily and quickly manage newsletters. Go to Group >
Newsletters on the administration bar to access Newsletters.

Newsletters

eXo Newsletter

ﬁ New Letter ||_# New Subscription |E|§ New Category |,£§, Manage Users ||

5| Marketing You want to know where we are, where we go ?
Subseription
The market
7| General General information about us
Subscription
Results
Check-List

4.11.2.1. Category Management

This section details category management.

Number of User

]

Number of User

Awaiting Letter

]

Awaiting Letter
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4.11.2.1.1. Add a new category

Procedure 4.106. Add a new category

1. Click New Category on the action bar of the Newsletters page. The Category form will appear.

Category form

Mame 3
Tite x
Description
Moderator + 2 ;

[ Save ][ Cancel

Table 4.25. Category Form Field Details

Field Description

Name The name of a category. This field is
required.

Title The title of a category. This field is required.

Description A brief description of the category.

Moderator Select users/groups who have rights to

manage this category.

Save Accepts the addition of a new category.
Cancel Quits the category form without adding a
category.

2. Input values for fields
a. Select a moderator for a category by clicking
b

next to the Moderator field to select a user. The User selector form will appear > Click
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&

corresponding to a user in the list that you want to select..

|| User selector

Group :
User Mame First Mame
root Root
john John
mary Mary
demao Demo
james James
b. Click
=
=

Last Mame

Root
Anthony
Kelly
gtn

Anderson

Email
root@localhost
john@localhost
mary @ocalhost
demo@localhost

james @localhost

to select users in a specific group. The Group selector will appear

b=| Group selector

& organization
Select group

e

@ customers
Ell.ﬂ; organization
ﬁ management
I.E operations

- communication

(S o~ AT -

Select membership

m

member
editor
manager
redactor
validator

webdesigner

Action

Select a group from the left panel and a membership type in the right panel. The
membership and group selected will be displayed in the Moderator field. After adding
new categories, they will be added in the list of categories.

After creating a category, you can create new subscriptions or newsletters for this category.
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When clicking the Administration button, you see a drop-down menu consisting of all actions
on this category.

4.11.2.1.2. Edit a category

1. Select a category that you want to edit > Click Administration > Edit Category in the drop-
down menu to bring up the Category form.

Category form |E|

Name  Fashion 3
Tite  New Trend =

Description | New Trendl Fashion

Moderator manager:/organization *

"}
&
=

[ Save H Cancel

2. Change the values in the Title and Description fields as required. (Note: You cannot change
the name of the category).

3. Click Save to save all changes.

4.11.2.1.3. Delete a category

Procedure 4.107. Delete a category

1. Click Delete category in the menu. A confirmation will appear:

e Are you sure you want to delete this category 7

‘ & cancel ‘ | & OK
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2. Click OK to delete the category or Cancel to exit without deleting.
4.11.2.1.4. Manage Users

Administrators can manage users accounts and activity with edit, ban, remove ban or delete
actions.

Procedure 4.108.

1. Click Administration > Manage Users in the menu. The Manage Users form will appear:

Manager Users x
Email Banned
hoa. vu@exoplatfiorm.com false E B’
Close
Table 4.26.
Field Details
Email The email address of user who has

subscribed this subscription.

Banned This field has two values:
False
The user is allowed to get email.

True
The user isn't allowed to get email.

EI To ban this user from receiving email.
B' To remove a ban on a user.
To delete the user.

2. Click Close to close the form.
4.11.2.2. Subscriptions

An administrator can add more subscriptions to any category. There are two ways to do this:
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Procedure 4.109. Method One

1. Click New Subscriptions on the Action bar.

The Subscription form will appear:

Subscription form x
Calegony | Marketing - \
Name [ l Select
category
Title [ *
Crescription
Redactor +

B
&
El

| save || cancel

Table 4.27.

Field Details

Category The category that contains this subscription.

Name The name of the subscription. This field is
required.

Title The title of the subscription. This field is
required.

Description The brief description about the subscription.
This field is not required.

Redactor Select users/groups who have rights to
manage this subscription This fied is
required.

2. Click

and select the category from the drop-down menu.

3. Enter the rest of their values in the form.
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4. Click Save to create the new subscription or Cancel to quit without creating a new
subscription.

Procedure 4.110. Method Two

1. Click directly the category to which you want to create a new subscription:

eXo Newsletter > Marketing

@ revicon [ ewsmemn

Marketing Youwant to know where we are, where we go ?
Subscription Number of User Awaiting Letter O
The market 0 0 O

2. Click New Subscriptions on the Action bar.

The Subscription form pops up:

El Subs=cription form x

Category |

Mame |

Title |

Description

Redact . O —
ctor u;-

[ Save H Cancel

Do the same steps as Method One.
Administrators can create newsletters for each subscriptions.

These Newsletters can be opened, edited, deleted or converted to a template for reuse.
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i | shoes Fashion shoes
Letter Date Status D
Discount Sat Sep 12 09:53:50 ICT 2009 draft O
Advertising Tue Sep 15 10:20:29 ICT 2009 awaiting D
Sale off Thu Sep 10 10:24:39 ICT 2009 sent O
Table 4.28.
Element Details
Shoes The name of the subscription.
Fashion Shoes The brief description about the subscription.
Letter The list of all letters of this subscription.
Date The date and time when creating this letter.
Status There are three types of status: draft, awaiting
and sent.
Moderation This button allows you to take actions on a
newsletter that you select.

4.11.2.3. Open a Newsletter

Administrators can easily view the content of a newsletter.
Procedure 4.111.

1. Choose a category by left-clicking it or checking the box and then selecting Administration
> Open.

Newsletters

eXo Newsletter > Marketing

ﬁ New Letter | [ NewSubscription ||

5 Marketing You want to know where we are, where we go ? I Administration I
Subscription Number of User Awaiting Letter |
The market 0 0 E]

2. Select the newsletter that you want to open by left-clicking it, or selecting the checkbox.
Newsletters

eXo Newsletter > Marketing > The market

ﬁ. New Letier |

S Themarket Whats on the market today ?
Letter Date Status @
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4.

Moderation
Moderation
ET-.-
Z E
Il Delete
7] Convert As Template
Tij:ij:mr?zli:etter‘s Content form pops up: .

Click Close to exit.

Close
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4.11.2.4. Edit a newsletter

Do the following to edit a newsletter.

Procedure 4.112. Edit a newsletter

1. In a specific subscription, select the newsletter you want to edit by selecting the checkbox.

2. Click

Mader ation

, then select Edit in the menu.

Moderatio

........................... -

.

@ Convert As Template

The Newsletter entry form pops up:

Newsletter entry form

Template :

| Basic Template > |

Senddate: [12/17/2010 18:40:40 |
Category :
Subscription :

[ Update sending parameters

+ Main Content [_b lllustration "_b Advanced ]

Title [BasicTempIate ]"
Name |pasic-template <
Language | en ¢|
uah || B sowce B 5| 4 5o 0 domoE
comert B I U= E=== £E A" A & BE ]
Format v | Font v size ¥

3. Change the values in the fields that you want to edit: Template, Send date, Category,
Subscription.
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4. Click the Update a Newsletter's info button.
5. Change the values in the fields Title and Main content.

6. Click Save to save as draft, or click Send.
4.11.2.5. Delete a newsletter

Administrator can delete obsolete newsletters.
Procedure 4.113. Delete a newsletter

1. In a specific subscription, select the newsletter that you want to delete by selecting the

checkbox.
.............. ; E’EEFE
[= Open
/ Edit
N
EL] Convert As Template
2. Click

Moderation ]

, then click Delete in the menu.

The confirmation message will be displayed:

The page at http://localhost:8080 says: ﬁ

0 Are you sure you want to delete this newsletter?

QK | | Cancel

e

3. Click OK to accept deleting this newsletter, or Cancel to quit without deleting.

4.11.2.6. Convert as Template

The administrator can reuse the template of the frequently used newsletter template.
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Procedure 4.114. Convert to template

1. Select the newsletter that you want to create as a template.

2. Click

Moderation

, then select Convert as Template in the menu. The next time when you create a newsletter,
this template will be listed in the Template field in the Newsletter entry form.

4.11.2.7. Newsletters
Each subscription consists of many newsletters. eXo Content helps you easily create newsletters
by following these steps.

Procedure 4.115. Creating Newsletters

1. Goto Group > Newsletters on the administration bar. The eXo Newsletter appears.

2. Click

ﬁ Mew Letker

on the action bar. The Newsletter entry formappears:

| Newsletter entry form

x
Template : | Basic Template 2
Senddate: |12/17/2010 18:40:40 |
Category :
Subscription : A
[ Update sending parameters
~ Main Content [_> lllustration "_b Advanced ] |
Title [BasicTempIate ]“
Name | pasic-template *
Language |gn =
Main [ Source E Fa o B 1900
content o e —— -
B I U= EESE==E |/ A A @2 &8 e
Format * | F - -
r—1
Details:
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Table 4.29.
Template The template for your newsletter form. Basic
Template is set by default..
Send date The date and time to send the newsletter.
Category The category contains this newsletter.
Subscription The subscription contains this newsletter.
Update sending parameters This button allows you to update information
about this newsletter.
Click

to select the template for the newsletter.

Click the Send Date field. The calendar will appear to allow you to choose the date and time
when you want to send the newsletter.

1 4 - 2010 (.

s M T W T F 5§

1 2 3 4 5 | 6
S 8 9 10 11 12 13
14 15 16 17 18 19 20
21 22 23 24 25 26 27
28 29 30 31

16:32:53

Click
in the category field to select the category and the subscription in list.

Click the Update sending parameters button to update information about this newsletter. A
message pops up and informs you that you have updated information successfully.

213



Chapter 4. Basic Actions

7. Input a title of a newsletter into the Title field.
8. Create a content for a newsletter by inputting information into the Main content textbox.
9. Click Save to save this newsletter as draft, or click Send to send this newsletter.

10. Select Contact Us on the navigation bar, or go to Site > Acme > Contact Us.

>:) 7| Site Group ) Dashboard 7| Site Editor Mary Kelly | Published | & |

‘Welcome: root

M

DOCUMENTS B8

= Where we are
Larem ipsum dolor sit amet IB0AI2009
consectetuer adipiscing elit

Welcome to Acme Corp

Welcome to our site

4 conditions and Requirements
Lorem dolor sitipsum amet IRI0AI2009
consectetuer adipiscing elit

T How to join us

The Contact Us page appears:

C:,l Contact Us il

LEAYE YOUR MESSAGE
Select a recipient | |nfos g

‘four Mame

Your Address

‘our Email Address
Wour Phone Murmber

Your Message

Save

Dione

Table 4.30.

Field Details

Select a recipient The recipient who will receive a message

Your name The name of a person who leaves a
message

Your address The address of a person who leaves a
message
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Field Details

Your Email Address The email address of a person who leaves a
message

Your Phone Number The phone number of a person who leaves
a message

Your message Write a message that you want to leave

11. Select a recipient and enter values in this form.

12. Click Save to save a message.

4.12. Fast Content Creator

eXo Content provides users with the Fast Content Creator portlet that enables users to create
document content quickly. The Fast Content Creator portlet is applied in the Contact Us portlet
on the navigation bar:

Procedure 4.116.

1. Go to Contact Us on the Navigation bar or go to Site > Acme > Contact Us.

The Contact Us page will appear:

Welcome: root |
view News Events Newsletters m
LEAVE YOUR MESSAGE
Select a recipient | Infos e |
‘Your Name | |
Your Address | |
‘Your Email Address | |
‘Your Phone Number | |
Your Message
Save |
Table 4.31.
Details
Select a recipient To choose people who will receive the
message.
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Field Details

Your Name To type the name of person who leaves a
message.

Your Address To type the address of person who leaves a
message.

Your Email Address To enter the email address of person who

leaves a message.

Your Phone Number To enter the phone number of person who
leaves a message.

Your Message To write a message that you want to leave.

2. Select a recipient and complete the other values in the form.

3. Click Save to send a message.

4.12.1. Edit Mode

Users can edit templates, take actions, and save locations for the documents in the Contact Us
portlet.

Procedure 4.117.

1. Goto Contact Us on the Navigation bar or go to Site > Acme > Contact Us.
2. Click Site Editor > Edit Page on the administration bar. The Page Editor will be displayed.

3. Click the edit icon to open the Edit Mode tab in the Contact Us portlet.
# @ Contact Us ﬁo

+ Page Editor =]
Applications Containers

Administration
Contents
Dashboard

Forms

Gadgets

g| Calculator

H| This simple and useful
calculator lets you
perform most of the basic
arithmetic operations.

\ Calendar
What date is it? Use this
4 cool calendar to keep
track of the date in style.

You can switch easily between daily,

monthly or yearly view

i5h View Page properties
| Switch View mode

The Edit Mode tab appears:
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4.

~ Edit Mode |D Partlet Setting ||p Select lcon || + Decoration Themes ||p Access Permission

Save location

Location to save | sites content/ive/acme/documents

Template options

Select template [Cuntact Us
Custom save button [Eend

Custom save message [Your comment has been received. We
appreciate your feedback.

Redirect

Redirect path [Iecmdemnipuhlic:facme.l’onntactus.fonnfirrnatinr] —

Table 4.32.

a

Close

Field Details

Location to save

Select template

Select the location for saving documents or
messages.

Select a template for documents. There are
corresponding fields to each template.

Custom save button

Change the label for the save button.

Custom save message

Show a custom message that informs you
have just saved a document.

Redirect

Redirect path

Allow you to redirect the path in the Redirect
path field.

Show a path to which you will be
directed after clicking OK in the confirmation
message.

Click

&

the

to search for the location to save documents. The Select Location form appears:
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| Select location
&
Workspace | collaboration
Root path @
Py Mame Action
2 el Users @
- u -
e .| Groups ]
e _
o Groups | Digital Assets /]
{1 Digital Assets — .
i Documents @
il D ts .
_ oeHmen | Records Space @
@& Trash =
= ol sites content @
{1 Records Space
®-{_| sites content
5. Select the parent node on the left panel and click the
9
in the Action column to choose the child node on the right panel. After being selected, this
location will be displayed on the Location to save field. Created documents will be saved
in this location.
6. Select a template for documents .
7. Change the label for Custom save button, and the content for Custom save message.
8. Tick the Redirect checkbox if you want to redirect to the path in the Redirect path field after
clicking OK in the save message.
9. Click Save to commit all changes of ediingt properties for the documents that you will create

in the Contact Us Portlet.

4.13. Form Builder

The Form Builder portlet enables users to create and to edit template of document types.
Documents are stored in the so-called node; therefore, the term “node” and node types are often
applied.

Procedure 4.118.

1.

Go to Group > Form Builder on the administration bar. The Form Builder will appear:
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Content Explorer Newsletters _ Administration
e

Name [ vent J:|«— The name of the node

Description

El Source B I U ==

»” @ . Normal -vj Font = SJ'ze-vj_

The hotest events|

2. Enter the node name into the Name field. (* Required)
3. Enter a brief description about the node.

4. Click the Form Builder tab that allows you to set properties for a node. Available components
are displayed on the left pane.

General Form builder

N— Input field +% @2mW
& — Label 4% @2m
_ Textarea field Textarea value %+ L “?' m
= Text Area
= Editor
= Select Box
e} Radio
& " Upload fied | [(Bowse_ |2 4% @2m
) CheckBax

Reset

5. Click the desired components on the left pane. The selected components will be displayed
on the right pane.

6. Click the

]
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corresponding to the component to move this component up or the

4

to move the component down.

7. Click the
&

that corresponds to the component to edit properties of that component. The form to edit
properties appears like the illustration below:

Field Label | Titie] <«—— Enter the field label
Width Rules: || Reguired
Height
Default Value
Guidelines for
User
Table 4.33.
Field Label To enter the field label.
Width To enter the field width. If the checkbox in
Rules: || Required
is marked, the
*
will appear beside the text box, indicating
that values in this box are required.
Height To enter the field height.
Default Value To display the default value
Guidelines for User To display instructions about this
component.
To delete the component, click the

corresponding to the component.
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Click
&

again to hide the form to edit the properties.

After editing the properties of the components, the components look like the below illustration:

Title |
Place 'R
Summary Textares value| ¥
Upload field 4 49

2
2W
2W

2W

8. Click Save to accept creating a new node, or Reset to edit this node again before saving.

A message will inform that you created a node successfully.

4.14. Category Navigation

Category Navigation Portlet and Parameterized Content List Viewer portlet get rid of long URLs
when you view a content and enable users to see published documents or webcontents in specific
categories in one page. Thanks to the symbolic link, no matter where the object physically resides,
the database can retrieve it. In addition, the relations amongst shortcuts can be managed. Now,

you can view documents or web content in the Parameterized Content List Viewer easily.

Procedure 4.119. Access to Category Navigation Portlet

1. Goto News on the navigation bar:
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s Contact Us

CATEGORIES TOp News B
World ACME News 4
Busi Lorem ipsum dolor sit amet, ipisicing elit, sed do eil d tempor inc ut labore et
usiness dolore magna aligua.
Technology Aug 21, 2003 3:56:43 AN
Sports

ACME News 3
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna
aliqua.

.@_ 9 3:56:1

ACME News 2
Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna
aliqua.

The left panel lists all the categories containing documents or web contents.
The right panel displays the documents selected in the left pane.

2. Selecta category that you want to view on the left, it will be shown on the right (only documents
or web content published are shown).

W m Events Mewsletters Contact Us

CATEGORIES World

N
World

= Africa Lorem ipsum dolor sit amet, ipisicing elit, sed do e d tempor incidi ut labore et
dolore magna aliqua.

ACME News 1

¥ Americas
¥ Asia Pacific
»» Europe

s Middle East

Business
Technology
Sports

g
-l

4.14.1. The Edit Modes of Category Navigation Portlet

Administrators can edit the Category Navigation portlet with the following procedure:

Procedure 4.120.

1. Go to Group > Administration > Manage Pages on the administration bar. The Manage
Pages will appear:
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Administration +

| s |[owner tpe =] O

| Page Id Title | Access Permission Edit Permission Action
ey, “Ec Edior I = m
portal:eXo: Girls gamesgames [manager:/customers, memberdpart author:/platiorm = m@
group: :Si | Site Explorer I = m
group: W WCM = m
}nﬂ::acm::cmm Category navigation portiet [Everyone] “iplatformyadministrators = m
portal:acme:chy Content List Viewer Portiet [Everyone] *jplatformyadministrators = m@
group: :comi | Ci @ m
portal:acme::confirmation Contact Form Confirmation [Everyone] editor:/platform/web-contributors = m
portal:acme::contactus Contact Us [Everyone] =jplatformiweb-contributors = m
B e ) Ml [ " T bbb dn e b b =# =

2. Click

in the Manage Pages that corresponds with the Category navigation portlet to open the page
to edit this portlet.

@ Category navigation portiet J

“+ Page Editor

(B[]

T CatEgory Mavigaton

Calculator

This simple and useful calculator
lets you perform most of the basic
arithmetic operations.

Calendar

‘What date is it? Use this cool
calendar to keep track of the date
in style. You can switch easily
between daily, monthly or yearty

3. Click

7

to open a form with the Edit Mode to edit the portlet.
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~ Edit Mode [b Portlet Setting " » Select Icon H + Decoration Themes " » Access Permission ]

Repository [repository = l
Title [ l
Tree name [ e - l
Tree viewer template [ simpleVerticalHierachy.gtmpl = l
Show in Page |news |@
Close

4. Click

to select the repository for documents in the Repository field.
5. Input the name of a category in the Title field.
6. Select the tree name for a category.

7. Select the template for displaying categories.

8. Click the

L
&
icon to select the target path. The Page selector form will appear:

ADDVEDIT PAGE NODE

I + Page Node Setting ]I ~ Page Selector I” + lcon l

Selected Page Info

Enter the page name

Page Id: Jr
Name: I ”
Tm“ I'l-- Enter the titld of the page

I (2 Create Page || ) Search and Select Page |
-

N
Create a new page Select an existing page

Save Back

9. Click
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to select the navigation on the left pane. The corresponding pages will be displayed on the
left pane and the corresponding paths will be displayed on the right pane.

10. Click the

@
icon to select the path. This path will be displayed in the Show in page field.

11. Click Save to accept saving the configuration for the Category Navigation portlet.
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Advanced Actions

5.1. Manage Site Resources in one place

You can easily manage all the site resources in Content Explorer.
Chose

Sites Management

in General drive. All of your created sites and their resources will be listed in the left panel.

Content Explorer

| &« [[Q) =) rexo -
Publication Collaboration System
= s i
4 Add Folder ., Add Document il Upload
Sites Management — gam + Document title Created date Author Last User Status
o — = = ApplicationData 12/10/10 6:00 PM
] AppicationData B & categories 12/10/10 6:00 PM
. P | = ess 12/10/10 6:00 PM
i eeien = 12/10/10 6:00 PM
css -/ documents
P B s 12/10/10 6:00 PM
Q| lgg finks 12/10/10 6:00 PM
Lot & medios 12110010 6:00 PM
b g finks
[ web contents 12/10/10 6:00 PM
_1! medias r
hizweb contents b

All sites contain typical folders that are site resources:

s CSS 5/20/10 11:10 AM
" documents 5/20/10 11:10 AM
2% js 5/20/10 11:10 AM
&5 links 5/20/10 11:10 AM
L8 medias 5/20/10 11:10 AM
L2 web contents 520710 11:10 AM

5.1.1. CSS Folder

CSS is one of the default files of a site. This folder contains CSS data that is used to present data
in a site and increase that site's content accessibility.
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5.1.2. Document Folder

This folder contains all documents used in a site. When you want to add a new document for a
site, you can also put them in another folder, but it is recommended to use this one to manage
everything easily and conveniently.

L

Conditions and Reguirements

How to join us

g

& 5 E

Where we are

5.1.3. JS Folder

This is one of the default files of a site. This file contains Java Script data that is used to make
a site more animated and more dynamic.

5.1.4. Links Folder
This file contains all links used in a site.
5.1.5. Media Folder

This folder contains all documents related to videos, images and sounds. It is divided into three
sub folders:
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=, &? medias
~ audio
- | images
B o

audio:
This folder contains sound data used in a site.

images:
This folder contains images used in a site.

videos:
This folder contains videos used in a site.

5.1.6. Web Content Folders

This folder contains all web content used in sites. It is recommended to put all the web contents
files here, to manage them more easily, or in case you want to reuse them in another site.
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EI Siioyweb contents
IEI | 2010
IEI . Events
IEI . NewEvents
IEI . MNews

=™ site artifacts

|
1

Contact Form Confirmation

I

i
al

ACME Footer

ACME Introduce

ERERER R ERER

ACME Logo

ACME Navigation
Mewsletter Header

ACME Searchbox

ACME Signin
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Administration page

5.2. Administration page

This page is used to manage all workspaces, drives, node types, metadata, templates, queries,
etc. Only administrators can access the Administration page.

Click Group > Administration on the administration bar:
D T Site Group ©) Dashboard [F7 Site Editor Root Root
Content Explorer

Content Manager's pages Welcome: root | |
. Y
New tact Us
Newsletters

=] Form Builder DOCUMENTS E

[ | Where we are

Lorem ipsum dolor sit amet  2g,08/2009

piltrr Welcome to Acme Corp [Nt
- r ¥ | conditions and Requirements

Lorem dolor sit ipsum amet  25,08/2000

consectetuer adipiscing elit

Executive Board's pages site

Organization 3
T. How to join us
Users's pages Consectetuer adipiscing elit

lerem ipsum dolor sit amet
ﬂ" Lorem My Link *r  ftur adipisicing Lorem ipsum dolor sit amet, consectetur adipisicing
a - g -

27108

The Administration page will appear:

Manage the main ECM functions g
= Manage Categories

3% Categories & Tags 3

LR Name Workspace Home path Permissions Action
Content Presentation ' System dms-system lexo:ecm ..erty;__system remove r 4
— lexotaxonomyTrees
|+ Content Types ] Istorage /System
¢ Advanced Configuration b acme collaboration Isites content five /acme  ..erly,__system remove ’ 4

icategories lacme

classic collaboration Isites content flive /classic erty;__system remove F 4
Iicategories /classic
events collaboration Isites content five /acme  ...erty;_system remove ’ 4
levents
|| exo collaboration Isites content flive /exo .tors remove;any read r 4

Icategories fexo

Add Taxonomy Tree

This page enables you to access:

Categories and Tags to mange Categories and Tags.
Content Presentation to manage Template, Metadata, Views, Drive.
Content Types to manage Namespace Registry, Manage Node Type.

Advanced Configuration to mange Queries, Scripts and to create an Action Type.

5.2.1. Categories and Tags

5.2.1.1. Manage Tags

Manage Tags enables you to manage tag styles. The tag style will change depending on the
number of documents in a tag.
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Go to Administration > Categories and Tags > Manage Tags.

Manage the main ECM functions =
;§> Manage Tags

- Tagmanager || » Tag permission manager

Style name Document range Style of tag Action

[ §;~' Categories & Tags - l

§_| Manage Categories

|_§ I normal 0.2 font-size: 12px; font-weight: f
bold; color: #6b6b6h;

font-family: verdana;

[ 1 Content Presentation b l

— text-decoration:none;

[ B e - l interesting w2 font-size: 13px; font-weight: );9
[ﬁ}Mvanceannﬁguraﬁnn » l boid; color: #5a66ce;

font-family: verdana;

text-decoration:none;

4 attractive 5.7 font-size: 15px; font-weight: );"
bold; color: blue; font-family:
Avrial; text-decoration:none;

hot 7.10 font-size: 18px; font-weight: &
bold; color: #f3000; font-famity:
Avrial; text-decoration:none;

hottest 10.* font-size: 20px; font-weight: }
bold; color: red; T
font-famity:Arial; P
g edit and delete

text-decoration:none;

tag

ck to add tag style

5.2.1.1.1. Add a tag style

Furthermore, you can add a new tag style as follows:

Procedure 5.1. Add a Tag Style

1. Click the Add style button. The Add tag style configuration form will appear:

Edit tag style configuration

Style name *
Document range x
Html style

[ pdate ][ Cancel
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Details:

Style name
Give the tag name. You cannot edit it.

Document Range
Give the number of document assigned to a tag. (*Required).

Html style
Include font-size, font-weight, colour, font-family, text-decoration. (*Required).

Input values in the fields: Style name, Document range, HTML style, all of which are
required.

Click Update to accept adding a new tag style.

5.2.1.1.2. Edit

Tag manager tab enables you to edit the existing tags.

Do the following:

Procedure 5.2. Editing existing tabs

2.

3.

Click the pen icon corresponding to the tag name which you want to edit in the Action column
to edit the tag style configuration. The Edit tag style configuration form appears like the
form to add a tag style.

Change values in the fields Document range and Html style, except Style name.

Click Update to save new changes.

5.2.1.1.3. Delete a tag style

To delete one tag style, simply click the corresponding Delete icon and select OK in the
confirmation to accept your deletion.

233



Chapter 5. Advanced Actions

-

— ~
The page at http://localhost:8080 says=: u

-

9' Do you want to delete this style ?
-

| Cancel |

5.2.1.1.4. Tag Permission Manager

The Tag permission manager tab helps you set permissions regarding editing and deleting public
tags.

b Tag manager I + Tag permission manager

Memberships Action

* . /platform/administrators

Add a permission

Memberships: *

Save

g2

Procedure 5.3. Set Permission To Tag Management

1. Click the

-
.

icon to select memberships in order to add a permission for those memberships. The Select
membership form will appear:
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Select membership x

£ customers

Select group Select membership

‘ﬁ}" F member u
E‘I-Bi customers b author

ﬁ organization b editor

ﬁ platform ¥ manager

Iuﬁ partners b redactor 8

F walidator

[ gt

2. Select a group on the left and the corresponding membership on the right. The selected
membership will appear in the Memberships field:

b Tag manager [ + Tag permission manager

Memberships Action

*: /platform/administrators

Add a permission

Memberships: | manager:/customers *

P

3. Click Save to accept adding a permission for the membership to the Memberships column.

b Tag manager I + Tag permission manager

Memberships Action
* /platform/administrators
manager:/customers

Add a permission

Memberships: | manager:/customers *

N

g
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You can also delete memberships that have permissions by clicking the Delete icon relevant
to that membership, and then click OK in the confirmation message.

The page at http://localhost:8080 says: 0| x

Are you sure want to delete?

&3 Cancel | «/ OK |

5.2.1.2. Manage Categories

A category may be understood as a classification practice and science. It is used to sort
documents, aiming at facilitating searches. The category management includes adding, editing
and deleting a category tree.

Go to Administration > Categories and Tags > Manage Categories.

Administration
Manage the main ECM functions -
=) Manage Categories
t*,' Categories & Tags il Name Workspace Home path Permissions Action
§_| System dms-system lexoiecm ...erty;__system remove r4
2 lexotaxonomyTrees
%> Manage Tags Istorage /System
acme collaboration Isites content five facme | ...erty;__system remove j
i Content Presentation 3 Icategories /acme
(@ Content Types L classic colleboration Isites content five /classic | ...erty;__system remove f
Icategories /classic
Advanced Configuration 3 -
é} nfig events collaboration Isites content five /acme | ...erty;__sysiem remove ))’
levents
| | exo colleboration Isites content Jive Jexo ...tors remove;any read j
fcategories /fexo L
‘ edit and delete
click to add catego |
gory S categories

5.2.1.3. Add a Taxonomy Tree

Perform the steps in Add a Taxonomy Tree to add a taxonomy tree.

Procedure 5.4. Add a Taxonomy Tree

1. Clickthe Add Taxonomy Tree button to add a new taxonomy. The Add taxonomy tree form
will appear.
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Add taxonomy tree B3

Input taxonomy name, choose workspace and taxonomy home path
? ™ pae myemEPE  Enter Taxonomy Tree Name

Mame I Games I*
Work -~
kSPACE | gms-system Select Workspace
Home path @
Select Home path
Reset MNext

Movetonextstep

2. Enter the taxonomy tree name in the Name field. (*Required).
3. Select the workspace you want to work with.

4. Select the home path by clicking the plus item. The Select Home Path form will appear:

Select home path [x]

Exocecm <

Workspace | dms-zystem

Root path '@'

4 Mame Action

ua

Ll exo:taxonomyTrees '@' il
._1 exo:taxonomyTrees _ @

ol exoctaxonomies

H-| exo:taxonomies

.| exo:folksonomies '@'

._1 exo: folksonomies _ @

Ll exo:drives

H-| exo:drives

| :

. templates @ 7

5. Click the tick icon if you want to select the root path or click the arrow icon to go to the up
level path. Click the plus sign to expand the folder.
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6. Click the tick icon corresponding to the path that you want to select as a home path.

Click Reset if you want to reset values that have just been selected or Next to select
permissions for a taxonomy tree.

Add taxonomy tree User/Group with rights B3
Select permission for taxonomy tree node = T:':]XOFIOI"I"I}" tree Remque: kel
/ Permission =
User or Group Read Add Node Set Property Remove Action
* true false false false
-
john true true true true

Add a permission to that node . . .
Edit Permission

User or Group *

Read [ |
Select Permission

Add Node [
Set Property [ | je==FouUr rights on
Remove [ Taxonomy tree
[ Prewvious ” Save ” Reset ” MNext l
Close
7. Click the
&
icon to select a user or the
iy,
Ll
icon to select memerships or the

icon to select everyone in order to set permissions. The user or memership that you have just
selected will be displayed in the User or Group field.

Then, check at least one of these below options to set rights for the selected user to
membership:

Read Right
The option is to select the read right or not.

Add Note Right
The option is to select the Add Node right or not.
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Set Property Right
The option is to select the Set Property Right or not.

Remove Right
The option is to select the Remove right or not.

8. Click Save to save all values, or Reset to change values that have just been set. After clicking
Save, click Next to go to the next step.

Add taxonomy tree E]
Add an action to the taxonomy tree :
Id F i
Name *
Lifecycle  node added n
node_removed F o
property_added 3
property_removed [
property_changed ¥ [+ 3
Is deep [
ModeTypes [ ]® Q
Home path [dm}system:j‘exu:ecm."ﬁtud]r ]‘ Q m
L P W1 -
Target path [ ] Q 1
Affected ModeTypes [nhme ] i Q
[exu:article ] m
[exu:pu-dcast ] m B

9. Enter the name for an action of the taxonomy tree in the Name field. (*Required).

10. Select values for Lifecycle, NodeTypes, Target workspace, Target path, Affected Node
Types. (*Required).

11. Click Save to save all values and, click Next to go to the next step.
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5.2.1.4. Edit a Taxonomy Tree

Perform the following steps to edit a taxonomy tree.
Procedure 5.5. Edit a Taxonomy Tree

1. Click the edit
:,}

i

that corresponds to the taxonomy tree you want to edit.

= Edit taxonomy tree

Edit the taxonomy tree by adding, copying, cutting and selecting permissions.

MName

.

- System
-4 | System

Previous

2. Click the

-

to add more taxonomy trees. The Edit taxonomy tree will appear:

| Edit taxonomy tree

Parent fexo:ecm/exo:taxonomyTrees/storage/System

Taxonomy name

[ Save ][ Cancel

3. Enter a taxonomy name in the Taxonomy name field. (*Required).

4. Click Saveto save the taxonomy name.

5. Click Previous to return to the previous steps.

Action

icon

icon
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6. Click Save to save all changes and the Previous or Next if you want to edit more.

5.2.2. Content Presentation Manager

5.2.2.1. Manage a Template

When creating a node in eXo Content, you must set its properties. Thus, each node needs to
have a form to enter data for their properties (called the dialog template), and display the existing
values (called the view template). The template management allows users to view, delete and
modify the predefined templates or to add a new template.

Content Explorer  Newsletters  Form Builder

Manage the main ECM functions
Manage Templates

[ @cmeguries&ngs » l Template Name

exo:addMetadatafction

:

Eexo:article

exocomments edit and delete template

AR S R T T ¥
S= == == == = =

:
:

Totalpages: 3 &« < 1 2 3 » | =»

edit template «——| Add |

Figure 5.1. Manage Templates Form

Procedure 5.6. Add a New Template

1. Go to the Manage Templates form

Click Administration — Content Presentation — Manage Templates
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2. Open anew template form
Click the Add button in the Manage Templates form to open the Template form.
3. Select the template type
In the Name drop-down box, select the template type you require.
4. Label the template
Specify a name for the template in the Label field.
5. Specify whether the template is a document template

Click the Document Template check box if the template you are creating should be used
as a template for a document.

6. Open Permissions dialog.
Click the + icon next to the Permissions field to open the Select Permission dialog.
7. Assign memberships to the group

Select the group from the left panel and the membership from the right panel. Or you can set
permission for everyone by clicking the + icon next to Any Permission.

=| Select Permission

£ organization

Any Permission (<

Select group Select membership
& i b member
438 Customers ' author
E'ﬂ Organization b editor

I-fj- Management b manager

I-f_fl- Operations i b redactor

Iuﬂ_n Communication : validator

. w * o

Figure 5.2. Select Permissions Dialog
8. Add dialog content

Select the Dialog tab and enter the value in the Dialog content field.
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Template Form

» Template - Dialog r View || » CS5

Dialog content =% *
// Generate template for nodetype automatically ‘_‘
£
=div class="UIForm FormLayout"=

=% wiform.begini) %=
=div class="Horizontallayout"=

=<table class="UIFormGrid"=

=tr=

class="FigldComponent"=

[ Save ][ Refresh ][ Cancel

Figure 5.3. Manage Templates Dialog Tab
Add view content

Select the View tab and enter the value in the Dialog content field.
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10. Add CSS content

11. Save template

b=| Template Form

| » Tempiate | » Dialog | + view |» css

View content |=%

// Generate template for nodetype automatically |_]
%=
=style=
=%
Lo "§1xlg§HéE£VfTE ..... DL-getlenplatesian
=fstyle=
=%
def node = uicomponent.getModei):
def name = node.getNamel):
def wvalues;

[ Save H Refresh ][ Cancel

Figure 5.4. Manage Templates View Tab

Select the CSS tab and enter the value in the Dialog content field.

Click Save to create the template.

Procedure 5.7. Edit a Template

Go to the Manage Templates form

Click Administration - Content Presentation — Manage Templates
Open the View and Edit Template form

Click the Pencil icon in the Action column corresponding to the template you want to edit.
Edit the Template tab

In the Template tab, you can edit the Label of the Template.
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Add a dialog to the Dialog tab

To add a dialog, do the following:

a. Input content for this dialog in the ' Content ' field.

b. Input name for this dialog. (*Required).

c. Select permissions for a group that can use this dialog. (*Required).
Edit an existing dialog in the Dialog tab

To edit an existing dialog, do the following:

a. Click the Pencil icon in the dialog row you want to edit.
b. Edit the dialog properties.

c. Click Save to accept all changes in the Dialog tab.
Delete an existing dialog

To delete an existing dialog, do the following:

a. Click the Trash Can icon in the dialog row you want to edit.

b. Click OK to continue with deletion.

@ Note

You can not delete the default dialog. You must create a new one before you
can delete the current default dialog.
Add a View to the view tab

To add a view, do the following:

a. Click the View tab and enter content into the content field.
b. Input name for this view. (*Required).
c. Select permissions for a group that can use this view. (*Required).

Edit an existing view in the View tab
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a. Click the Pencil icon in the view row you want to edit.

b. Edit the view properties.

c. Click Save to accept all changes in the View tab.

9. Delete an existing dialog in the Dialog tab

To delete an existing dialog, do the following:

a. Click the Trash Can icon in the dialog row you want to edit.
b. Click OK to continue with deletion.

c. Click Save to accept all changes.
Procedure 5.8. Delete a Template

1. Click the

m

corresponding to the template that you want to discard.

2. Click OK on the confirmation message to delete the template or Cancel to abort the operation.

5.2.2.2. Metadata Management

Metadata in its simplest form is "data about data". Generally, it may be understood as information
that describes, or supplements the central data. The metadata management allows managing
nodes in the metadata format in the eXo Content system. The metadata may be considered as
information used to describe the data. When data are provided to the end users, the metadata
allow users to understand about information in more details. All metadata nodes can combine with
other nodes to create a new node (add mix).
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Procedure 5.9. View Metadata

1. Go tothe Manage Metadata form

Click Administration — Content Presentation — Manage Metadata
2. Open the Metadata Information form
Click the magnifying glass icon corresponding to the metadata you want to view.

The Metadata Information Form opens.

b=| Metadata information

[ Metadata information

Metadata Mame Is mixin types Orderable children
@ dc:elementSet v true X false
[ Elements
Element Mame Type Dﬁ:ription
i dc:coverage String Description
RT dc:resourceType String Description
R dc:creator String Description
0s dc:description String Description
LG dc:language String Description
P dc:publisher String Description
i dc:subject String Description
CE dc:contributor String Description
s dc:source String Description
i dc:rights String Description
Tl dc:title String Description

Figure 5.5. Metadata Form

Procedure 5.10. Edit Metadata

1. Open the Edit Metadata's Template form

Click the Pencil icon in the metadata row you want to edit.
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The Edit Metadata's Template form opens.
2. Change the properties

Change the required properties of the metadata.

@ Note

You cannot edit the metadata name.

3. Save changes

Click Apply to save all metadata changes.
Procedure 5.11. Delete Metadata

1. Click the Trash Can button
Click the Trash Can icon corresponding to the metadata you want to delete.
A confirmation message displays.

2. Confirm deletion

Click OK to delete the template, or Cancel to preserve the template.

5.2.2.3. Manage Views

The function Manage Vi ew is used to control view ways of a user. It has 3 tabs: View, ECM
Templates and BC Templates tabs.

To open the Manage View function, click Administration — Content Presentation - Manage
View. The Manage View form displays.
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b ECM Templates |

} BC Templates -

- Views
Marme Permissions Action Tab Base Version Action
taxonomy-ist = fplatformfusers [Info] [ Actions ] m y 4
admin-view * [platform [Admin] [Info] [ m y 4 ﬁ
fadministrators Actions ] [ Collaboration
]
taxonomy-icons * [platformfusers [ Actions ] m y 4 ﬁ
ANONYMOUS-ViEw . [ Actions ] E py 4 ﬁ
icon-view = fplatformfusers [ Actions ] [ m y 4 ﬁ
Collaboration ]
slide-show * [platformfusers [ Actions ] [ m y # ﬁ
Collaboration ]
simple-view * fplatformfusers [ Actions ] [ E y 4 ﬁ
Collaboration ]
system-view = fplatform [Infa] m y 4 ﬁ
Jadministrators
timeline-view = [platform [ Actions ] [ m y 4 ﬁ
fadministrators Collaboration ]
cover-flow * fplatform fusers [ Actions ] [ B py 4 il

Collaboration ]

Figure 5.6. Metadata Form

Views Tab. The procedures that describe how to Add, Edit, Delete, and Preview views.
Procedure 5.12. Add View

1. Open the Add View form
Click the Add View button located at the bottom of the Manage View form.
The Add View form opens.

2. Define View Name

In the Name field, specify the name of the view you are creating. The name must be unique,
and must only contain standard alphanumeric characters.

3. Assign memberships to the group

Select the group from the left panel and the membership from the right panel.
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Select Permission

]

s organization

Any Permission @

| Selectgroup
1.
E‘H Customers F
Em Organization 3
E‘i Management '
E‘i Operations '
E‘i Communication :

member
authar
editor
manager
redactor
validator

*

Figure 5.7. Select Permission Dialog

Select the Templates view

Click the Templates field and select the correct template for this view.

Save the View

Click Save to apply all settings and close the form.

Procedure 5.13. Edit a View

1.

2.

Click the Pencil icon in the view row you want to edit.

Edit the view properties.
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3. Click the Add Tab button to open the Tab Form tab to add more tabs.

a. Click the Add Tab button to add more tabs after the initial tab has been added.
b. Click the Reset button to apply changes.
c. Click the Back button to return to the View Form tab in the Edit View form.

4. Click Save to apply all changes in the View tab.
Procedure 5.14. Delete Views

1. Click the Trash Can button
Click the Trash Can icon corresponding to the view you want to delete.
A confirmation message is displayed.

2. Confirm deletion

Click OK to delete the view, or Cancel to preserve the view.

@ Note

You can not delete a view that is in use.

Procedure 5.15. Preview a View

1. Click the Magnifying Glass icon in the Action column of the view you want to preview.

The View form opens.
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View

- View Form

Mame | taxonomy-list
Permission | =./platformjusers

Tabs [ actions ]

[ Info ]
Templates

Enable Version

N

Figure 5.8. View Dialog

2. Click Close to exit the View Form.
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5.2.2.3.1. ECM Templates

| ¥ | Manage View

b Views | = ECMTemplates | » BC Templates

MName Value Base Version Action

CoverFlow fexorecmfviewstemplates y 4

Jecm-explorer [CoverFlow

IconView Jexaorecmfviews templates p 4
Jecm-explorer TconView

ListView Jexaorecmfviewstemplates p 4
Jecm-explorer [ListView

SlideshawView Jexoiecm/views,templates &
Jecm-explorer (SlideShowView

SystemView Jexoiecm/views,templates g

fecm-explorer [SystemView

ThumbnailsView Jexorecmfviews templates P

&,
&

Jecm-explorer [ThumbnailsView

TimelineView Jexoecmfviews templates

L
hl
&l

Jecm-explorer (TimelineView

Figure 5.9. ECM Templates

Procedure 5.16. Add a new ECM Template

1. Select the ECM Templates tab.

2. Click the Add button to open the Add ECM Template form.
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b=| Add ECM Template

Content

Mame *

Figure 5.10. The Add ECM Template form
3. Input the content of the template in the Content field.
4. Input a name for the template in the Name field.
5. Select a type for the template in the Template Type field.

6. Click Save to accept adding a new template, or click Reset to change values, or Cancel to
quit without any changes.

Procedure 5.17. Editing a Template

1. Click the Pencil icon next to the template you want to edit.

254




Content Presentation Manager

[ Edit ECM Template

uiWorkingArea.getCustomActioni |
def managersMultiltemContext =

def managersGroundContext =

wiworkingArea. getGroundActionsExtensionlist () ;

def action = :
def permLinkComponent = null:

UTRight ClickPopupMenu contextMenu =

def wviewComponentId = new Datel).getTimel): -
1 def renantevyt = rt¥ natBenuestCanteyt i |
*
Name | ContentvView |
Template Type [ ecm-explorer | V]

Enable Version |:|

[ Save ” Cancel ]

Figure 5.11. Editing an ECM Template Form

2. Change the current template's properties.

3. Click Save to accept all changes, or Cancel to quit without any changes.

Procedure 5.18. Delete a Template

1. Click the Trash icon corresponding with the template you want to edit. A confirmation
message will appear.
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2. Click Ok to accept deleting this template, or Cancel to discard this action.

5.2.2.3.2. BC Templates

[P Views H ¥ ECM Templates l » BC Templates

Name Value

DocumentView

PathList

QueryList

Scriptlist

TreeList

Jexorecm fviews ftemplates &
Jcontent-browser fdetail-

document/DocumentView

Jexo:ecm fviews templates ,?
Jcontent-browser fjpath/PathList

Jexorecm jviewsftemplates &
Jcontent-browser fquery

JQueryList

Jexoiecm fviews templates ,?
Jcontent-browser fscript

[ScriptList

Jexoiecm fviews templates "’
Jcontent-browser fjpath/Treelist

Figure 5.12. BC Templates form

Procedure 5.19. Adding a New Template

1. Click Add to open the Add BC Template form.
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5.

Add BC Template

Content

2R

Figure 5.13. The Add BC Template form
Input the content for the template in the Content textbox. (*Required).
Input the name for the template in the Name field. (*Required).

Select the template type from the dropdown box in the Template Type form.

query
sCript
detail-docurment

Figure 5.14. Dropdown Box

Click Save to complete adding a new template.
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Procedure 5.20. Edit a BC Template

1. Click the Pencil icon on a template that you want to edit.

Edit BC Template

Content

> |

=%

import

import

def su

bDocument

uicomponent .getCurrentlist(]

boolea

n hasMoDocument =

L

- ] Nt . P o

s

*

Name | QueryList

Figure 5.15. The Edit BC Template Form

2. Change the current template's properties.

3. Click Save to accept all changes, or Cancel to quit without any changes.
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Procedure 5.21. Delete a Template

1. Click the Trash icon corresponding with the template you want to edit. A confirmation
message will appear.

2. Click Ok to accept deleting the template, or Cancel to discard this action.

5.2.2.4. Drives Management

The function supports to manage drives in the File Explorer. It allows adding, editing and deleting
drives.

Go to Administration > Content Presentation > Manage Drives.

-| Manage Drives

Icon MName Workspace Home Path Permissions View Action
Trash collaboration [Trash = Jplatform icon-view, y 4
fadministrators simple-view,
cover-flow
Validation collaboration /Documents * /platformfusers  simple-view, p 4
Requests Malidation admin-view
Documents Center Requests

Totalpages: 4 % < 12 3 |4 > *

5.2.2.4.1. Add a new drive

1. Click the Add Drive button in the Manage Drives form to open the Add Drive form.
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~ Drive [r Apply Views ]

Mame [ ]t
workspace |system V]
Home path q
o d]
Workspace icon @
Permissions ]t % m
Show referenced documents |

Show "non document™ nodes
Show sidebar
Show hidden nodes

Allowance to create folder exo-jsFolder

Unstructured folder
exo:webFolder
exo:linkFolder
exo:cssFolder
Folder

Allowance nodetype on left [ ] ﬂ m

tree

|_Seve || Refresh || Cancel |

2. Input a name for the new drive in the Name field. (*Required).

3. Select a workspace for the drive. There are 4 available workspaces: system, collaboration,
backup, and dms-system.
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“E]rstem Vl‘

dms-system
portal-system
portal-work

wcom-system

4. Select the home path for the drive by clicking the

o1
'l

icon

Select root path @
'

| jersystem

Workspace [:.\:':.Lem | T]

Root path &2

Name |n:1m|

. |

& jcrnodetypes
{2 jerversionStorage

) @ jcrversionStorage
*-_| exonamespaces

: | EXONEmespaces

hj jcrnodetypes

(NN

.| EXOiecm

h] EXOECT

5. Click the

il
|

icon to select the home path.
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6. Select an icon for the workspace
L
7. Click
e"‘.
to select an icon file:
lbsl| Select icon
Workspace : collaboration -
Mame

k.
-] Users
[F-| Groups

[F-{_| Digital Assets
" Documents

- , Trash

™| Autumn Leaves.ipg

by clicking

Action

©

the

m

8. Select permissions for groups that have access rights to this drive by clicking the

-

icon.

9. Select or deselect the various checkboxes to hide or show the corresponding drive elements:

Show referenced document

Allows viewing preference documents.

Show non-document

Allows viewing non-documents.

Show sidebar

Allows showing the sidebar.

Show hidden node

Allows showing the hidden nodes.

10. Select the document type that will be created in this drive:

Folder

Only nt:folder folders can be created in this drive.
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Unstructured folder
Only nt:unstructured folders can be created in this drive.

11. Click

A~

to select a node type. The Select node types form will appear:

EI Select node types X

Node type name | |

Choose all node types |-

lcon MNode Type Mixin Type Select
= app:application X False
= app:applicationregistry X False
= app:category * False
= app:gadgetdata X False

Enter a node name to search for in the Node type name field and click the
Q

to begin searching.
All the node types matching the search string will appear in a list below.

Check the box corresponding to the desired node type in the Select column, or click the

4+

beside Choose all node types to select all results.

If you click the icon, the Allowance nodetype on the left tree becomes a required field
(indicated by an asterix '*")

Allowance nodetype on left | —
tree | @

Click the

if you want to remove the selected nodetype.
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12. Select the Apply Views tab and select the view type you want to be available in the drive:

El Add Drive

¢ Drive | + Apply Views

Taxonomy List
Admin View
Taxonomy lcons
Anonymous View
lcon View

Slide Show
Simple View
System View
Timeline View
Cover Flow
Category View

WCM content View

X

&

[ Save ][ Refresh ][ Cancel

13. Click Save to commit the details and create the new drive, Refresh to clear the form or Cancel

to abort the operation.

Procedure 5.22. Edit a drive

1. Click
:,}

i

the

icon that corresponds to the drive you want to edit. The Edit drive form will appear:

264



Content Presentation Manager

= Edit Drive [x]

Jv Drive " F Apply Views l

Name | customers | *
Workspace | collaboration v
Home path | jGroups/customers | o8
Workspace icon [ ] €3]
Permissions [ +/customers | » L

Show referenced ||
documents

Show "non document”
nodes

Show sidebar

Show hidden nodes

Allowance to create |exo:jsFolder -
folder |Unstructured folder

exo:webFolder
mwn-linkFoldar

2. Edit the properties as required.

3. Click Save to commit the changes.

Procedure 5.23. Delete a drive

1. Click the

m

that corresponds to the drive you want to delete.

2. Click OK on the confirmation message to delete the drive or click Cancel to abort the
operation.
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5.2.3. Content Types

5.2.3.1. The Namespace Registry

The namespace is a prefix in the node type name. It enables you to create node types without
fearing any conflict with existing node types. The registry helps you manage the namespaces

used in the system.

Go to Administration > Content Types > Namespace Registry to open the NamesPace

Registry form.

_H Namespace Registry

Prefix

app

dc

EXO

fn_old

Fwd

kfx

lan

Figure 5.16. Namespace Registry

Namespace Uri

http:/fwww.gatein.orgfjor fapplication-registry/1.0/

http:/fpurl.org/dcfelements/1. 1/

http:/fwww.exoplatform. com/fjcr fexof1.0
http: ffwww . w3.0rg/2005/xpath-functions
http:/fwww.w3.0rg/2004/10 fxpath-functions

http: / fwwew . exoplatform. comfjor fFwd/ 1. 1/

hittp: {fwww.jep.org fjer/1.0

http: /fwwew . exoplatform. com for flkfif1. 1/

http: ffwww .gatein. orgficr fautologing 1.0/

Total pages: 2

Procedure 5.24. Registering a Namespace

1. Click the Register button on the Namespace Registry form to register a new namespace.

EI Register new Mamespace

Mamespace Prefix

Uri

[ Save ][ Cancel

Figure 5.17. Namespace Registration Form

4

&

1

2

3

¥

B
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2. Enter the value for the Namespace Prefix field. (* Required).

3. Enter the value for the URI field. This field must be unique. (*Required).

Important

The namespace must not contain special characters like |, @,#,%$,%,&,%,(,).

5.2.3.2. Manage Node Types

This function is used to control all node types in eXo Content.

u} Manage Node Type
Mode type name oty

Orderable child

Icon Mode type Mixin type nodes Description Action
D app:content X false X falze nothing
D app:contentcategory X false ¥ true nothing
D app:contentregistry X faloe ¥ true nothing
D app:gadgetdata X false X false nothing
D app:gadgetdefinition X folse X falze nothing
D app.gadgetregistry X false X falge nothing
D app:localgadgetdata X falze X falze nothing
D app:remotegadaetda X falee X falge nothing
@’ dc:elementSet ¥ true X falge nothing
] exoiaccessControllab ¥ true X falze nothing

[=4]
st

Total pages: 18 (% < |/ 1234 |5 e

[ Add ][ Import ][ Export

Figure 5.18. The Manage Node Type Form

5.2.3.3. View Node Types

1. Clicktheiconthat corresponds to the node to be reviewed. The View Node Type Information
form will appear.
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| View Mode Type Information

~ Node type

MName space

Node type name application
Is mixin type
Orderable child nodes

Primary item name
Super types gtn:protectedresource, mix:referenceabl¢
Property definitions [jcr-primary Type |
[ app:creationdate ]
[ app:lastmodific ationdate ]
[ gtn:edit-permissions ]

[ gtn:description |

Figure 5.19. View Node Type Information Form

2. Click Close to exit this form.

Procedure 5.25. Add Node Type

1. Open the Add/Edit Node Type Definitions form by clicking the Add button on the Manage
Node Type Form.
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Add/Edit Node Type Definitions (x|

~ Node type I> Property " » Child node }
MName space T'

Mode type name [ ]
Is mixin type ..l v ]
Orderable child nodes -.I v ]

Primary item name [ ]

Super types [ ] .|.

Property definitions
Child node definitions

| save || savedratt || cancel |

Figure 5.20. Add Node Type Form

Select a namespace for the node.

Enter a name in the Node type name field. This field is mandatory and its value must be
unigue.

Important

The name must not contain special characters like !, @,#,%$,%,&,*,(,).

Select a value for the "Is mixin type" field.

 True: this node is mixin type.
 False: this node is not mixin type.

Select a value for the "Orderable child nodes" field:

¢ True: child nodes are ordered.
« False: child nodes are not ordered.
Enter a value for the Primary item name field.

Super Types: Click the + button to add more parent types.
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8. Property definitions: lists all definition names of Property tab.
9. Child node definitions: lists all definition names of Child node tab.

10. Click Save to accept adding a new node type, or Save draft to save this node type as a draft,
or Cancel to quit.

Procedure 5.26. Export Node Types

1. Open the Export Node Types form by clicking the Export button on the Manage Node Type
Form.

Hs| Export Node Types x

Mode name Action | |

nt:resource
exo:themeFolder
mop:customization
exo:owneable
exothumbnails
exo:folksonomyFolder
nt:versionHistory
mop:page
exo:addMetadataAction

mop: portalsites

exo:organizationGroups

Figure 5.21. Export Node Types Form

2. Click Uncheck all if you do not want to export all node types. After clicking Uncheck all, this
button becomes the Check all button.

3. Select nodes that you want to export by ticking the checkboxes.

4. Click the Export button in this form.
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5. Select the location in your computer to save the exported node.

Important

You must select at least 1 node type to be exported. If you do not want to
export the node, click Cancel to quit this pop-up.

Procedure 5.27. Import Node Types

1. Open the Import Node Type from XML file form by clicking the Import button on the Manage
Node Type Form.

Import NodeType from XML file [} x|

File name . Browse... |

Upload H Cancel ]

Figure 5.22. Import Node Type from XML file Form

2. Click the Browse button to upload a file.

Import ModeType from XML file |E|

Mode name Action

ntiresource

moprcustomization

Import H Fe Upload H Cancel

Figure 5.23. Browse for XML files containing Node Types
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Important

You must upload an XML file. This file is in the node type's format.

3. Click the Upload button.

@ Note

If you want to upload a different file, click the trash icon to delete the file which
has just been uploaded, then upload other files.

4. Tick the checkboxes corresponding to the nodes that you want to import.

5. Click the Import button to complete importing a node type.
5.2.4. Advanced Configuration

5.2.4.1. Manage Queries

The function enables you to manage queries. It allows adding, editing and deleting queries.

Go to Administration > Advanced Configuration > Manage Queries.

<?> Manage Queries

Mame Type Statement Permissions Actions
All Artides wpath flelement(* exoartice) * fplatform fusers y)"
order by
@exo:dateCreated
descending
Created Documents wpath fF[(@jer:primaryType = | = fplatform fusers y)"

'exo:artide’ or
@jcriprimaryType =
‘nt:file’) and
@exo:owner="8{Userld}s’
order by
@exo:dateCreated

descending

CreatedDocumentDayBefo  xpath flelement(* exo:artice) *: fplatform fusers /"
[@exo:dateCreated <
wz:dateTime(${Date}s]]
order by
@exo:dateCreated

descending
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Procedure 5.28. Add a new query

1. Show the Add Query form by clicking the Add Query button in the Manage Queries form.

b=| Add guery
Query name | *
Query type | ypath w
Statement |/jcr:root/Documents/Lives/elementi*, exp:article) *

Enable cache
results
2. Enter a query name for the Name field.

3. Select the query type.

« Xpath: (XML Path Language) is a language for selecting nodes. For example, /j cr: r oot /
Docunent s/ Li ve

e SQL: (Structured Query Language) is a database computer language.
4. Enter the statement for query. The name of node type must be unique.

5. Check or uncheck the 'Enable cache results' option. If you tick this checkbox, for the fist time
you use this query to search, the result will be cached. For the second time you search using
this query, it will show the cached results. After 45minutes, the cache will be removed.

For example: you have the query Test with statement//el enent (*, nt:file).Inthe File
Explorer, you have a nt: fi | e document named Fi | e1. When you execute the query Test,
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only document Fi | el will be shown. After that, create a nt: fil e document named Fi | e2
and execute query Test , only document Fi | e2 document will be listed. After 45 minutes, the
cache will be removed. When you execute the query Test , the documents Fi | el and Fi | e2
will be listed.

6. Select permissions for a group that can wuse this query by clicking

LH

o=| Select membership

P customers

Select group Select membership
ﬁ' * member B
E‘iﬂ; customers b authar
bﬁ organization b editor
i platform b manager
Lﬁ partners b redactor 4
b wvalidator
| L=
7. Click Save to finish adding a new query.
Procedure 5.29. Edit a query
1. Click the

:'}

i

icon corresponding to the query you want to edit. The Edit Query form will appear:
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bs=| Edit query
Query name | a|| Articles =
Query type | xpath o

Statement | //elementi*,exp:article) order by @exo:dateCreated *

descending

Enable cache @
results

2. Edit the properties of the selected query.

3. Click Save to accept all changes.
Procedure 5.30. Delete a query

1. Click
corresponding to the query you want to delete. A confirmation message will appear.

2. Click OK to accept deleting this query, or Cancel to discard this action.

5.2.4.2. Manage Scripts

The function enables users to manage all script codes in the eXo Content and Browser Content
system.

Go to Administration > Advanced Configuration > Manage Scripts.
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Manage Scripts

—

+ ECM Scripts b BC Scripts

Select category:  action -
MName Fath Base Version
AddMetadataScript.groovy ...ction/AddMetadatascript.ar

AddTaxonomyActionScript.gre | ... AddTaxonomyActionScript.
AutoVersioningScript.groovy | ...onfAutoVersioningScript.gre
EnableVersioningScript.groovy ... JEnableVersioningScript.gro

GetMailScript.aroovy ...Er faction
[GetMailScript. groowy

ProcessRecordsScript.groovy  ...on/ProcessRecordsScript.gr

PublishingRequestScript.grooy | .. PublishingReguestScript.gre

RSS5cript.groovy ...plorer faction
[RSS5cript.groovy
SendMailScript.groovy ...rfaction

fSendMailScript.groovy
TransformBinaryChildrenToTe: ...aryChildrenToTextScript.gn

Total pages: 2

Details:

» eXo Content Scripts: scripts are used in eXo Content
e BC Scripts: scripts are used in Content Browser.

The ECM Scripts tab:

Procedure 5.31. Add a new script in ECM

1. Select ECM Scripts tab in the Manage Script.

2. Click the Add button to open the Add/Edit script form:

X

Actions
}'h e
r [
}'h ="
F 1]
}} =
r [ 10
}'h ="
r 1]
}) ——
r (1]
}} =
r [
}'h ="
r [
}) =
r [
}'h e
F [
}'h ="
F 1]

1|(2

1

%

276



Advanced Configuration

b=| Add/Edit script

Script contents s

Script Name | | *

[ Save ][ Refresh ][ Cancel ]

3. Enter a value for the Script content field.

4. Enter a script name for the Script name field.

¢ The script name must be unique.
« The name must not contain special characters such as !, @,#,$,%,&,*,(,).

5. Click Save to accept adding the new script.

Procedure 5.32. Edit an ECM script

To edit an ECM script, do the following:

1. In the ECM Scripts tab, click the
:,}

i

icon that corresponds to the script that you want to edit. The Add/Edit script form will appear:
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b=| Add/Edit script

Script contents | # This program is free software; you can redistribute it

and/ar

* modify it under the terms of the GNU Affero General
Public License

*¥ as published by the Free Software Foundation; either
version 3

¥ of the License, or (at your option) any later version.

®

¥ This program is distributed in the hope that it will he
usetful,

* but WITHOUT ANY WARRAMTY; without even the implied
warranty of

¥ MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.
See the

¥ GNU General Public License for more details.

®

* You should have received a copy of the GNU General
Public License

¥ along with this program; if not, SEEdhttp:ffwww.gJEiorg
Jlicenses/=,

®f

is Enable Version

Script Name | addMetadataScript.groovy *

[ Save ][ Refresh ][ Cancel

2. Edit the properties in this form.

3. Click Save to save all changes.

Procedure 5.33. Delete an ECM script

To delete an ECM script, do the following:

1. In the ECM Scripts tab,

on the script that you want to delete. A confirmation message will appear.
2. Click OK to accept deleting this action, or Cancel to discard this action.

The BC Scripts tab:

-~

click
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4 Manage Scripts
b ECMScipts | + BC Scripts

Mame Path Base Version Actions

GetDouments. groovy Lt py 4

browser [GetDocuments. groowy

Procedure 5.34. Add a BC script

To add a BC script, do the following:

1. Inthe Manage Scripts, select the BC Scripts tab.

2. Click Add to open the Add/Edit script form:
| Add /Edit script

Script contents i

Script Mame x

[ Save ][ Refresh ][ Cancel

3. Input script content for the Script content field.
4. Input a script name into the Name field.

5. Click Save to finish adding the new script.

Procedure 5.35. Edit a BC script

To edit a BC script, do the following::
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1. In the BC Script tab, click
:'}

i

on a script that you want to edit.

The Add/Edit script form will appear:

| Add/Edit seript

Script contents repositoryService = repositoryService ; *

1

public woid execute (Object context) |
Datelransfer data = (Datalransfer) context ;

Session sessiocn = null ;
tryq

String workspace =

session =
repositoryService _getRepositoryirepository) .logini{workspace
i

CfueryManager gueryManager =
segssion_getWorkspace () _.getfueryManager () ;

Query query = gueryManager.createfuery("/jcr:iroot
ffelement (*, exczarticle)™, Query.XPATH);

CueryBesult gueryBesult = guery.executel();

NodeIterator iter = gueryBesult.getModes() ;

List nodelist = new RrraylListi) 7

m

data.setContentlist (nodelist)
session.lo cils -

iz Enable Version [

SoriptMName  GetDocuments groovy =

[ Save ][ Refresh ][ Cancel

2. Edit the properties that you want.

3. Click Save to accept all changes.

Procedure 5.36. Delete a BC script

To delete a BC script, do the following:

1. In the BC Scripts tab, click

on the script you want to delete. A confirmation message appears.

2. Click OK to accept deleting this script, or Cancel to discard this action.
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5.2.4.3. Manage Unlocks

All locked nodes are listed and managed by administrators in the Administration page. There
are two ways that help administrators unlock nodes: unlock nodes in the right-click the menu in
Content Explorer or unlock nodes in the Administration page.

Procedure 5.37. Unlock Nodes

1. Goto Administration on the navigation bar.

2. Select Advanced Configuration > Manage Unlocks on the Manage the main ECM
functions pane on the left. The locked nodes will be listed on the right panel.

Manage the main ECM functions r
Iil Manage UnLocks

E_"-J Categories & Tags » )
+ Locked Mode | » Manage Lock

| Content Presentation 3
— Node Path User Lock Action

E Content Types 3
=% Advanced Configuration -
’:> Manage Queries

4| Manage Scripts

ES Create an Action Type

@A)

3. In the Locked Node tab on the right panel, administrators can unlock nodes by clicking

ml}
L=

that corresponds to nodes which need to be unlocked. The unlocked nodes will disappear
from the locked node list.

Administrators can manage and add the unlock permission for another group and users in
the Manage Lock tab.

4. Select the group on the Select group panel and the corresponding membership
on the Select membershippanel. The selected group will be listed in
the Group and Users column. However, administrators can also click the

-

if they want to allow any users to unlock nodes.
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:."'|l
= Manage UnLocks

* Locked Mode | + Manage Lock

Groups Or Users Action
* fplatform/administrators
L3
Any Permission (4
Select group Select membership

.
:{F Customers
:{F Organization
@ Platform
‘{F Partners

5. In case, administrators want to remove the unlock permission of groups, click the
that corresponds to the group in order to remove them form the Unlock permission list except
the group *: / pl at f or nf admi ni strat or and r oot .

5.2.4.4. Create Action Types

This function allows managing of all action nodes in the eXo Content.
Procedure 5.38. Create an Action Type

1. Go to the SitesAdministration on the navigation bar.

2. Select Advanced Configuration > Create an Action Type.
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E’i Create an Action Type
Mame

exo:action
exo:addMetadataAction
exo:autoVersioning
exoireateRSSFeedAction
exo:enableVersioning
exo: folksonomyAction
exo:getMailAction
exo:processRecordAction
exo:sendMailction

exo:taxonomyAction

Extends Action Type

[nt:baze]

[exo:action] [exo:scriptAction] [nt:base]
[exa:action] [exo:scriptAction] [nt:base]
[exo:action] [exo:scriptAction] [nt:base]
[exo:action] [exo:scriptAction] [nt:base]
[exa:action] [exo:scriptAction] [nt:base]
[exo:action] [exo:scriptAction] [nt:base]
[exo:action] [exo:scriptAction] [nt:base]
[exa:action] [exo:scriptAction] [nt:base]
[exo:action] [exo:scriptAction] [nt:base]

Total pages: 2

3. Click the Add button to open the Action Type Form form:

b=| Action Type Form

Extends Action | exp:scriptiction
Type

Mame (starts with |

"exo:")

is Action Move

Execute | acm-explorer/action/RSSScript.groowvy ™

Variables

| &

[ Save H Cancel ]

4. Select the action type.

5. Input a name for the action.

&

6. Check/uncheck the "is Action Move" option: the action will have exo:move property or not.

7. Select an execute for the Execute field.
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ecm-explorerfaction/R555cript.g rnmrj e ]

ecm-explorerfaction/R555cript.groovy h
ecm-explorerfaction/SendMailScript.groovy
ecm-explorerfaction/TrashFolderScript.groowvy
ecm-explorerfaction/EnableVersioning5cript.groowy
ecm-explorerfactionfAutoVersioningscript.groowvy
ecm-explorerfactionfAddMetadataScript.groowy

| ecm-explorerfaction/TransformBinaryChildrenToTextScript.groovy
ecm-explorerfaction/GetMailscript.groovy
ecm-explorerfaction/ProcessRecordsScript.groovy
ecm-explorerfaction/PublishingRequestScript.groovy
ecm-explorerfaction/AddTaxonomyActionScript. groovy

8. The Variables field: allows creating multi-values for action.
If you want to add more values for action, click
Click

to delete a value.

9. Click Save to accept adding a new action type.
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Next Steps

This user guide has provided a thorough explanation of features and terminologies within eXo
Content. Now that you know how to create, manage and publish web content and administer
a website based on eXo Content, you may have more questions or want to get involved. The
following links can connect you with resources to learn more and contribute to the open source
development process.

* Learn more about eXo Platform 3.0 [http://www.exoplatform.com/company/public/website/
platform]

» Video demos, tutorial and more in the eXo Resource Center [http://www.exoplatform.com/
company/public/website/resource-center]

« Access another eXo documents in the eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/
Main/WebHome/]

» Ask question about eXo Content in the Forum [http://forums.exoplatform.org/portal/public/
classic/forum]
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Revision History
Revision 1-2.3 Wed Dec 15 2010

Exported conpany-specific content to separate files.

Revision 1-2.1.1 Fri Nov 19 2010
Updated docbook source to WCM 2.1.1
Revision 1-2.0 Mon Oct 25 2010

Completed docbook conversion.
Revision 1-0 Tue Sep 28 2010
Initial creation of book by publican
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